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About This Guide

The Novell Vibe 3.2 Installation Guide covers the installation and configuration of Novell Vibe. The
guide is divided into the following sections:

¢ Part I, “Product Overview,” on page 11

¢ Part II, “Basic Installation,” on page 23

*

Part III, “Advanced Installation and Reconfiguration,” on page 79

*

Part IV, “Multi-Server Configurations and Clustering,” on page 113
Part V, “Update,” on page 151

*

*

Part VI, “Appendixes,” on page 189

Audience

This guide is intended for Novell Vibe administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation.

Documentation Updates

For the most recent version of this manual, visit the Novell Vibe 3.2 Documentation Web site (http://
www.novell.com/documentation/vibe32).

Additional Documentation

You can find more information in the Novell Vibe documentation, which is accessible from the
Novell Vibe 3.2 Documentation Web site (http://www.novell.com/documentation/vibe32).

To access the Novell Vibe User Guide from within Vibe, click the Help icon (question mark).

About This Guide
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Product Overview

¢ Chapter 1, “What Is Novell Vibe?,” on page 13
¢ Chapter 2, “Vibe System Requirements,” on page 17

Product Overview 11
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What Is Novell Vibe?

Novell Vibe is an enterprise collaboration tool designed to increase individual productivity, team
effectiveness, and organizational success by providing the right set of tools to the right people.

¢ Section 1.1, “Vibe Capabilities,” on page 13

¢ Section 1.2, “Vibe Components,” on page 14

¢ Section 1.3, “Vibe Configurations,” on page 15

1.1 Vibe Capabilities

Novell Vibe users fall into three basic groups:

¢ Section 1.1.1, “Content Consumers,” on page 13
¢ Section 1.1.2, “Content Providers,” on page 13

¢ Section 1.1.3, “Administrators,” on page 14

1.1.1 Content Consumers

Content consumers use Novell Vibe to work with important information that pertains to them.
Content consumers:

¢ Maintain their personal workspaces, including setting up a personal Blog, Calendar, Files,
Guestbook, Photo Album, and Tasks folder

¢ Participate in team workspaces set up for content providers, in order to better collaborate with
colleagues and facilitate their work assignments

¢ Search the Vibe site for people, places, and other information that pertains to their personal
work assignments

¢ Identify subject-matter experts to assist them in their personal work assignments
The typical tasks performed by content consumers are covered in the Novell Vibe 3.2 User Guide.

In many cases, content consumers quickly become content providers.

1.1.2 Content Providers

Content providers use Novell Vibe to create and manage teams, customize the Vibe environment,
and import data into the Vibe site for use by other Vibe users. Content providers:

¢ Create and manage team workspaces and folders

¢ Control user access to their team workspaces

¢ Establish unique branding for workspaces and folders to clearly differentiate them from other
places on the Vibe site

What Is Novell Vibe? 13
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1.1.3

1.2

1.2.1

1.2.2

¢ Create landing pages for workspaces that consolidate the most necessary workspace
information into a single page

¢ Customize data entry forms for gathering information from users

¢ Create workflows to automate otherwise time-consuming manual processes

The typical tasks performed by content providers are covered in the Novell Vibe 3.2 User Guide.

Administrators

A Novell Vibe administrator is responsible for installing the Vibe software and setting up the Vibe
site. This Novell Vibe 3.2 Installation Guide provides instructions for Vibe software installation. After
installation, the Vibe site administrator can:

¢ Set up user access to the Vibe site

¢ Create initial workspaces and populate them with information that is of interest to Vibe users

¢ Control user access to workspaces and folders

¢ Configure e-mail integration, so that Vibe users can receive notifications of updated information
on the Vibe site and post to the Vibe site by using e-mail messages

¢ Set up mirrored folders to make large sets of data that are already available on disk more easily
available through the Vibe site

+ Set up software extensions (add-ons) that enhance the power and usefulness of the Vibe site

¢ Set up remote applications that deliver data from a remote location, such as a remote database,
for easy access on your Vibe site

¢ Manage users, workspaces, and folders as the Vibe site grows and evolves

¢ Perform regular backups to safeguard the data stored in the Vibe site

The typical tasks performed by Vibe site administrators are covered in the Novell Vibe 3.2
Administration Guide.

Vibe Components

A Novell Vibe site consists of four major components:

¢ Section 1.2.1, “Vibe Software,” on page 14
¢ Section 1.2.2, “Vibe Database,” on page 14
¢ Section 1.2.3, “Vibe File Repository,” on page 15

¢ Section 1.2.4, “Lucene Index,” on page 15

Vibe Software

The Vibe software is a customized version of Apache Tomcat. This software provides the Web-based
functionality you use as you access the Vibe site through your Web browser.

Vibe Database

The Vibe database is used for storing information about the Vibe site and its users:

¢ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

Novell Vibe 3.2 Installation Guide
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1.3

¢ Identification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

¢ User profile information (for example, full name, phone number, and e-mail address)

The Vibe database disk space requirements are relatively modest, because the database is not used

for storing files.

Vibe File Repository

The Vibe file repository holds all files that are imported into Vibe, information related to the
imported files, such as thumbnails and HTML renderings, and the search engine index.

The Vibe file repository disk space requirements depend on the size of the Vibe site. For a large Vibe
site, disk space requirements can be substantial.

Lucene Index

The Lucene Index Server is a high-performance Java search engine. The Lucene index contains
pointers to the actual data stored in the Vibe file repository. The index enables the Lucene search
engine to perform very fast searches through large quantities of Vibe data.

Vibe Configurations

You can configure Novell Vibe to run on a single server or multiple servers, depending on the size
and needs of your Vibe site.

Configuration

Description

Single Server

Remote Database
Server

Remote Lucene Index
Server

Multiple Vibe Servers

Multiple Remote
Lucene Servers

Multiple Remote
Database Servers

By default, the Vibe Installation program installs all Vibe components on the same
server.

For better performance and scalability, you can install the Vibe database on a remote
server.

For better performance and scalability, you can install the Lucene index on a remote
server.

By running Novell Vibe on multiple servers, you can achieve high availability, including
failover and load balancing, depending on how you configure your servers.

Your Novell Vibe site depends on the Lucene Index Server for full functionality.
Running multiple Lucene Index Servers provides high availability, so that if one Lucene
Index Server goes down, Vibe users can still access the Vibe site because other
Lucene Index Servers are still available.

Each of the three databases supported by Vibe each has its own approach to
clustering the database server. Information about clustering database servers is
available on the Internet.

For more information, see Part IV, “Multi-Server Configurations and Clustering,” on page 113.

What Is Novell Vibe? 15
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2.1

Vibe System Requirements

You, as a Novell Vibe site administrator, must ensure that your system meets Vibe system
requirements, so that your Vibe site can be set up successfully. After your Vibe site is set up, you must
ensure that users’ browsers and office applications meet Vibe user requirements, so that users can
access the Vibe site successfully.

¢ Section 2.1, “Vibe Server Requirements,” on page 17

¢ Section 2.2, “Vibe User Requirements,” on page 19

*

*

*

Section 2.3, “Mobile Device Requirements,” on page 19
Section 2.4, “Supported Environments,” on page 20

Section 2.5, “Recommended Hardware Configurations,” on page 21

For the latest system requirements details, see the Novell Vibe 3.2 Readme (http://www.novell.com/
documentation/vibe32/vibe32_readme_novell/data/vibe32_readme_novell.html).

Vibe Server Requirements

+ Hardware for the Novell Vibe server:

*

*

*

x86-32 processor or x86-64 processor

Minimum 2 GHz processor

Multi-CPU systems preferred

Minimum server memory:
¢ Atleast 3 GB RAM for an x86-32 processor
¢ Atleast 4 GB RAM for an x86-64 processor

See Section 2.5, “Recommended Hardware Configurations,” on page 21 and Section 3.2.3,
“Vibe Server Memory,” on page 27.

¢ Any of the following supported server operating systems for the Vibe server:

*

*

*

Novell Open Enterprise Server (OES) 2, plus the latest Support Pack
Novell Open Enterprise Server 11, plus the latest Support Pack
SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Support Pack

NOTE: On Linux, the X Window System is required by the GUI Vibe installation program.
It is not required to run Vibe after installation. It is not required for text-based installations
or silent installations.

Windows Server 2003 or Windows Server 2008, plus the latest Service Pack
Windows Server 2003R2 or Windows Server 2008R2, plus the latest Service Pack

Vibe System Requirements 17
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+ Database server:

+ Linux:

¢+ MySQL 5.0.26 or later server and client

NOTE: MySQL 5.0.26 is included with SLES 10 SP1 and OES 2 Linux. MySQL 5.0.67 is
included with SLES 11.

¢ Oracle 10g or Oracle 11g

+ Windows:

¢+ MySQL 5.0.26 or later server and tools
¢ Microsoft SQL Server 2005 or SQL Server 2008, plus the latest Service Pack
¢ Oracle 10g or Oracle 11g

More information about MySQL is available in Section A.2, “MySQL Database Server,” on
page 193.

+ Tomcat 6.0.18

NOTE: Tomcat 6.0.18 is included with Vibe on Linux and Windows.

¢ Java Developer Kit (JDK):
¢ Oracle JDK 6.0
+ IBMJDK 6.0

Java scripting must be enabled for proper Vibe site functionality.

More information about JDKs is available in “Java Development Kit” in Appendix A, “Vibe
System Requirements Assistance,” on page 191.

¢ Directory service:

¢ Linux: Novell eDirectory 8.8 or later, plus the latest Support Pack

For information about eDirectory, see the Novell eDirectory 8.8 Documentation Web site
(http://www.novell.com/documentation/edir88).

Windows: Microsoft Active Directory, plus the latest Service Pack, or Novell eDirectory 8.8
or later, plus the latest Support Pack

For information about Active Directory, see Windows Server 2003 Active Directory (http://
www.microsoft.com/windowsserver2003/technologies/directory/activedirectory) or
Windows Server 2008 Active Directory (http://www.microsoft.com/windowsserver2008/en/
us/active-directory.aspx).

¢ Adequate server disk space:

* Vibe software: At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has at least twice the
amount of disk space available as is in the following directory, plus an additional 500 MB:
Linux: /var/opt/novell/teaming

Windows: c¢:\Program Files\Novell\Teaming

Database server software: At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has at least twice the
amount of disk space available as is in the following directory, plus an additional 500 MB:
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Linux: /var/opt/novell/teaming

Windows: c:\Program Files\Novell\Teaming

+ Vibe file repository: Depends on the anticipated size of the Vibe site
¢ Database content: Substantially less than the Vibe file repository

See Section 3.6, “Planning the Vibe Database,” on page 34 to plan for the disk space needs of
your Vibe site.

¢ Truelype fonts

If you are installing Vibe in a non-GUI Linux environment, you might need to manually install
the TrueType fonts if they are not already installed. TrueType fonts enable Stellent converters to
function properly for document conversions. For more information, see “Understanding and
Configuring Document Conversions with Stellent” in the Nowvell Vibe 3.2 Administration Guide.

2.2 Vibe User Requirements

+ Web browser:
¢ Linux: Mozilla Firefox 3 or later; Google Chrome (latest version)

+ Windows: Microsoft Internet Explorer 6 or later (must not have the Google Chrome Frame
plug-in installed); Mozilla Firefox 3 or later; Google Chrome (latest version)

When you use Internet Explorer 6, some functionality might not be available.
* Mac: Safari 4 or later; Mozilla Firefox 3 or later
+ Office applications:
¢ Linux: OpenOffice.org/LibreOffice 3.1.1 or later
+ Windows: Microsoft Office 2007 or later; OpenOffice.org/LibreOffice 3.1.1 or later
¢ Mac: OpenOffice.org/LibreOffice 3.1.1 or later

NOTE: OpenOffice and LibreOffice are used synonymously throughout the Novell Vibe
documentation. Functionality and issues that apply to OpenOffice also apply to LibreOffice.

¢ Collaboration clients:
¢ Linux:
¢ GroupWise 8 with the latest Support Pack
¢ Windows:
¢ GroupWise 8 with the latest Support Pack
¢ Outlook 2007 with iCal support enabled
+ Notes 7 with iCal support enabled

2.3 Mobile Device Requirements

¢ Section 2.3.1, “Supported Mobile Devices,” on page 20

¢ Section 2.3.2, “Device Browser Requirements,” on page 20

Vibe System Requirements
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2.3.2

2.4

241

2.4.2

Supported Mobile Devices

The Novell Vibe mobile interface is supported on the following mobile devices:

¢ iPhone (native application is available in the iTunes Store)
¢ Android (native application is available in the Android Marketplace)

¢ BlackBerry

NOTE: The BlackBerry Curve has issues with JavaScript, so it does not work with the Vibe
mobile interface. For more information, see “Your BlackBerry Curve Does Not Work with the
Mobile Interface” in “Troubleshooting” in the Novell Vibe 3.2 User Guide.

¢ Any other mobile device that provides an HTTP/HTML-based interface

Ensure that your device’s browser meets the requirements that are discussed in Section 2.3.2, “Device
Browser Requirements,” on page 20.

Device Browser Requirements

To use Vibe from a mobile device, your device’s browser must support:

+ HTML 4

¢ JavaScript

Supported Environments

¢ Section 2.4.1, “File Viewer Support,” on page 20

¢ Section 2.4.2, “IPV6 Support,” on page 20

¢ Section 2.4.3, “Clustering Support,” on page 21

¢ Section 2.4.4, “Xen Virtualization Support,” on page 21
¢ Section 2.4.5, “VMware Support,” on page 21

¢ Section 2.4.6, “Single Sign-On Support,” on page 21

¢ Section 2.4.7, “Linux File System Support,” on page 21

File Viewer Support

In Novell Vibe, file viewing capabilities are provided by Oracle Outside In viewer technology. See
“Oracle Outside In Technology 8.3 Supported Formats” (http://www.oracle.com/technology/
products/content-management/oit/ds_oitFiles.pdf) for a list of the supported file formats. See “Oracle
Outside In Technology” (http://www.oracle.com/technologies/embedded/outside-in.html) for
background information about the Oracle viewer technology included in Vibe.

The file viewers also support data indexing by the Lucene Index Server.

IPV6 Support

Novell Vibe supports the IPV6 protocol when it is available on the server. If the protocol is available,
Vibe detects it and supports IPV6 by default, along with IPV4.
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2.4.3

244

2.4.5

2.4.6

2.4.7

2.5

Clustering Support

You can install Vibe components on multiple servers to provide failover support, as described in
Part IV, “Multi-Server Configurations and Clustering,” on page 113.

Xen Virtualization Support

You can install Vibe in virtual environments where a software program enables one physical server to
function as if it were two or more physical servers. Xen virtualization technology in Novell Open
Enterprise Server (Linux version) and SUSE Linux Enterprise Server is supported. For more
information, see:

¢ Open Enterprise Server 2 Virtualization Documentation Web site (http://www.novell.com/
documentation/oes2/virtualization.html#virtualization)

¢ SLES Virtualization Technology Documentation Web site (http://www.novell.com/
documentation/vmserver).

VMware Support

Vibe is supported on the following versions of VMware:

¢ VMware Server (formally GSX Server), an enterprise-class virtual infrastructure for x86-based
servers

¢+ VMware ESX Server, a data-center-class virtual infrastructure for mission-critical environments

For more information, see the VMWare Web site (http://www.vmware.com).

Single Sign-On Support
Novell Access Manager can be used to provide single sign-on capabilities for your Vibe site. For

setup instructions, see Section 9.8, “Configuring Single Sign-On with Novell Access Manager,” on
page 88.

Linux File System Support

For best Vibe performance on Linux, the ext3 file system is recommended. If you are running OES
Linux and need the feature-rich environment of the NSS file system, Vibe is also supported there. The
reiser3 file system is also supported.

Recommended Hardware Configurations

The hardware configuration that you set up for your Novell Vibe site should be based on the number
of active users that the Vibe site must support. Server machines can be physical or virtual.
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Active Java

Users Vibe Components CPU Memory Heap
10 1 dedicated Vibe server with: x86 2GB 1GB
+ Tomcat
¢ Lucene
¢ SQL
50 1 dedicated Vibe server with: x64 4 GB 2GB
dual core
+ Tomcat
* Lucene
¢ SQL
100 Multiple Vibe servers: x64 4GB 2GB
dual core
+ 1 dedicated Tomcat server
+ 1 dedicated Lucene server
+ 1 dedicated SQL server
500 Multiple Vibe servers: x64 8 GB 6 GB
quad core
+ 3 dedicated Tomcat servers with an L4 load balancer
+ 2 dedicated Lucene servers
+ 2 dedicated SQL servers
1000 Multiple Vibe servers: x64 8 GB 6 GB
quad core

+ 5 dedicated Tomcat servers with an L4 load balancer
+ 4 dedicated Lucene servers

+ 2 dedicated SQL servers

The Novell Vibe Installation program provides two installation types: Basic and Advanced. When
you perform a Basic installation, the result is a fully functional Vibe site with all required options
configured and with typical defaults in use for optional settings.

If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all
Vibe components installed on the same server, then add advanced configuration options to your Vibe
site after the Basic installation has been successfully tested. However, experienced Vibe
administrators can choose to perform an Advanced installation immediately, which includes all
installation and configuration options, as described in Part III, “Advanced Installation and
Reconfiguration,” on page 79.

You can perform a Basic installation to set up a single-server configuration, as described in Chapter 3,
“Planning a Basic Vibe Installation,” on page 25 and Chapter 4, “Installing and Setting Up a Basic
Vibe Site,” on page 49.

You can perform a Basic installation to set up a multiple-server configuration, but the remote
database must be created manually and in advance of performing the installation, as described in
Part IV, “Multi-Server Configurations and Clustering,” on page 113.
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I Basic Installation

¢ Chapter 3, “Planning a Basic Vibe Installation,” on page 25

¢ Chapter 4, “Installing and Setting Up a Basic Vibe Site,” on page 49
¢ Chapter 5, “Adding Users to Your Vibe Site,” on page 63

¢ Chapter 6, “Updating Your Vibe License,” on page 69

¢ Chapter 7, “Setting Up Vibe,” on page 71

¢ Chapter 8, “Basic Vibe Installation Summary Sheet,” on page 73
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3 Planning a Basic Vibe Installation

3.1

The installation program for Novell Vibe helps you install the Vibe software and file repository to the
appropriate locations.

¢ Section 3.1, “What Is a Basic Vibe Installation?,” on page 25

¢ Section 3.2, “Selecting the Operating Environment for Your Vibe Server,” on page 26

¢ Section 3.3, “Selecting a Java Development Kit,” on page 29

¢ Section 3.4, “Gathering Network Information for Your Vibe Site,” on page 29

¢ Section 3.5, “Planning the WebDAV Authentication Method,” on page 32

¢ Section 3.6, “Planning the Vibe Database,” on page 34

¢ Section 3.7, “Gathering Outbound E-Mail Information,” on page 37

¢ Section 3.8, “Enabling Inbound E-Mail,” on page 39

¢ Section 3.9, “Planning Site Security,” on page 41

¢ Section 3.10, “Gathering Directory Services Information,” on page 41

¢ Section 3.11, “Accommodating Multiple Languages,” on page 48

What Is a Basic Vibe Installation?

The Novell Vibe installation program provides two installation types: Basic and Advanced. When
you perform a Basic installation, the result is a fully functional Vibe site with all required options
configured and with typical defaults in use for optional settings.

If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all
Vibe components installed on the same server, then add advanced configuration options to your Vibe
site after the Basic installation has been successfully tested. However, experienced Vibe
administrators can choose to perform an Advanced installation immediately, which includes all
installation and configuration options, as described in Part III, “Advanced Installation and
Reconfiguration,” on page 79.

IMPORTANT: The following Vibe configurations require that you perform an Advanced installation
as your initial installation of the Vibe software:

+ Setting up the Vibe file repository so that some types of files are located outside the Vibe file
repository root directory. See Section 9.2, “Distributing Different Data Types to Different
Locations,” on page 82 for Advanced installation instructions. You cannot move subdirectories
within the Vibe file repository after they have been created.

¢ Installing the Vibe software on multiple servers to create a clustered environment. See
Chapter 15, “Running Vibe on Multiple Servers,” on page 125 for Advanced installation
instructions. The option to enable a clustered environment is available only during an Advanced
installation.
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If you want to implement an Advanced installation option, you should perform a Basic installation
first, in a test environment, before performing the Advanced installation to set up your permanent
Vibe site.

This section helps you make informed decisions about the required options for a Basic installation:

¢ Server platform (Linux or Windows)

¢ Server architecture (32-bit or 64-bit)

¢ Physical server memory requirements

¢ File locations (Vibe software and data)

¢ Java Development Kit (JDK) version (Sun or IBM)

¢ Database type (MySQL, Microsoft SQL Server, or Oracle)

¢ Database creation (during installation or before installation)

¢ Database authentication (username and password)

¢ Network information (Vibe server hostname or fully qualified domain name, and ports)

¢ Outbound e-mail configuration (SMTP vs. SMTPS, hostname, SMTP port, time zone,
authentication)

¢ Inbound e-mail configuration (SMTP address, SMTP port, and TLS support)

¢ User and group for running the Vibe software (Linux only)

Before performing a Basic installation, make sure all system requirements are met, as listed in
Chapter 2, “Vibe System Requirements,” on page 17.

As you proceed with planning, you can use the Basic Vibe Installation Summary Sheet to record your
decisions about the options you want to use.

3.2 Selecting the Operating Environment for Your Vibe Server

¢ Section 3.2.1, “Vibe Server Platform,” on page 26

*

Section 3.2.2, “Vibe Server Architecture,” on page 26

*

Section 3.2.3, “Vibe Server Memory,” on page 27

*

Section 3.2.4, “Vibe Installation Locations,” on page 28

*

Section 3.2.5, “TrueType Font Location (Linux Only),” on page 29

3.2.1 Vibe Server Platform

Novell Vibe can run on the versions of Linux and Windows listed in Section 2.1, “Vibe Server
Requirements,” on page 17.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Server Platform, mark your operating system of choice.

3.2.2 Vibe Server Architecture

Vibe can run on 32-bit or 64-bit processors. A 64-bit processor is recommended for a large Vibe site
where the processor load is heavy and data storage requires a large amount of disk space.
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3.2.3

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Processor Architecture, mark the processor capacity required for the size of Vibe site that you
want to set up.

Vibe Server Memory

If a 32-bit processor is sufficient for your Vibe server, the server needs at least 3 GB of memory. If you
plan to use a 64-bit processor in your Vibe server, the server needs more.

Vibe server memory usage is significantly affected by some factors and less affected by others:

¢ Number of users logged in: No significant effect.
¢ Number of concurrent active sessions: No significant effect.
¢ Database server caches: Significant memory usage.

When you follow the instructions for a Basic installation, the database is located on the same
server as the Vibe software. After you have successfully tested your Basic installation, you can
reconfigure Vibe to have its database on a remote server, so that the database uses separate
memory resources, as described in Chapter 13, “Creating the Vibe Database on a Remote
Server,” on page 115.

¢ Vibe internal data caches: Significant memory usage.

When you follow the instructions for a Basic installation, the Vibe internal data caches are
subdirectories of the teamingdata directory, described in Section 3.2.4, “Vibe Installation
Locations,” on page 28. The Vibe internal data caches are separate from any caching or memory
usage by the database server itself.

¢ Lucene index cache: Significant memory usage.

The Lucene Index Server is a high-performance Java search engine. Large file repositories
(particularly with large files or a large number of files) can create a very large data index. When
you perform a Basic installation, the Lucene index is created on the same server where the Vibe
software is installed. After you have successfully tested your Basic installation, you can
reconfigure Vibe to have its Lucene index on a remote server, so that it uses separate memory
resources, as described in “Installing the Lucene Index Server on a Remote Server” on page 121.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Memory Requirements, specify the amount of physical memory you plan to have for your Vibe
server.

When you perform a Basic installation, the default amount of memory allocated to the Java Virtual
Machine (JVM) where the Vibe software runs is 1 GB, which is adequate for a medium-sized Vibe site
running on a 32-bit server. This memory allocation, called the Java “heap size,” does not include
memory used by your database server or by the Lucene Index Server when these programs are
running on the same server as the Vibe software.

A general rule is that no more than 75% of the available physical memory should be allocated to the
JVM. Memory not allocated to the JVM must be sufficient to support the operating system, the
database server, and the Lucene Index Server if they are also running on the Vibe server, and any
other processes running on the Vibe server.
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3.24

IMPORTANT: A JVM on a 32-bit server should not be configured to take more than 1.5 G of memory.
However, large numbers of users and documents often need memory settings higher than 2 GB to
provide adequate performance. This type of Vibe system should be set up on 64-bit hardware.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location, specify the amount of memory to allocate to the JVM where Vibe runs.

Although it is possible to run Vibe with less than 1 GB of memory for the JVM, this applies only to
very small test configurations, and is not suitable for production systems. In a test configuration, 512
MB is the minimum amount of memory required to produce a functioning Vibe installation.

Vibe Installation Locations

The default file location for the Vibe software varies by platform:

Linux: /opt/novell/teaming

Windows: c:\Program Files\Novell\Teaming

Included under the main Vibe software directory are subdirectories for Tomcat and file viewer
software.

The default file location for the Vibe file repository also varies by platform:

Linux: /var/opt/novell/teaming

Windows: c:\Novell\Teaming

IMPORTANT: On Windows, the Vibe installation program displays the Windows pathname with
forward slashes (/) rather than the traditional backslashes (\). This syntax is necessary in the
installation program.

The Vibe file repository holds all files that are imported into Vibe, information related to the
imported files, such as thumbnails and HTML renderings, and the search engine index.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under File Locations, specify the directories where you want to install the Vibe software and data if you
prefer not to use the default locations.

A Basic installation allows you to change the root directory for the Vibe software and the Vibe file
repository.

IMPORTANT: If you want to organize the Vibe file repository so that some file types are not under
the Vibe file repository root directory, you must perform an Advanced installation as your initial Vibe
installation. You cannot move directories out of the Vibe file repository root directory after the initial
installation has been performed. To perform an Advanced installation in order to organize the Vibe
file repository to meet your needs, complete the planning steps for a Basic installation and complete
the Basic Vibe Installation Summary Sheet, then follow the additional instructions in Section 9.2,
“Distributing Different Data Types to Different Locations,” on page 82.
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3.3

3.4

TrueType Font Location (Linux Only)

The Oracle Outside In viewer technology used by Novell Vibe to render various file formats into
HTML for viewing requires access to TrueType fonts. Typical locations for these fonts are:

/usr/X11R6/1ib/X11/fonts/truetype
/usr/share/fonts/truetype

If the TrueType font location is not correct, thumbnails are not displayed correctly on the Vibe site.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under TrueType Font, specify the directory that contains the TrueType font location.

Selecting a Java Development Kit

As listed in Section 2.1, “Vibe Server Requirements,” on page 17, you need to install a Java
Development Kit (JDK) before you install Novell Vibe. You can use either the Sun JDK or the IBM
JDK for the platform where you are installing Vibe (Linux or Windows).

If you want to use an SSL connection between your Novell Vibe site and a WebDAV server, and if the
WebDAV server has a self-signed certificate rather than a certificate provided by a certificate
authority, you must use the Sun JDK. The existing Vibe functionality for handling self-signed
certificates is not compatible with the way the IBM JDK handles self-signed certificates.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java Development Kit, mark the JDK that you want to use with Vibe.

You must install the JDK on the Vibe server before you install the Vibe software. If you are not
familiar with installing a JDK, see “Java Development Kit” in Appendix A, “Vibe System
Requirements Assistance,” on page 191 for instructions.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java Development Kit, specify the directory where you have installed the JDK.

The Vibe Installation program uses this path as if you had set the JAVA_HOME environment
variable. The path is stored for future reference in the installer.xml file so that you need to specify
the path to the JDK only once.

Gathering Network Information for Your Vibe Site

When you perform a Basic installation, the Novell Vibe installation program needs hostname and
HTTP port information about the server where you are installing Vibe.

¢ Section 3.4.1, “Host Identification,” on page 30
¢ Section 3.4.2, “Port Numbers,” on page 30
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3.4.1

3.4.2

Host Identification

When you install Vibe, the Vibe installation program needs to know the name of the server where
you are installing the Vibe software. The default is localhost. Do not use the default.

For internal use, you can use the DNS hostname of the Vibe server. However, if you want your Vibe
site to be accessible from the Internet, you must specify the fully qualified domain name for the Vibe
server in order to allow external access.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the hostname or fully qualified domain name to use for the Vibe
server.

Port Numbers

When you install Vibe, Tomcat is installed along with the Vibe software. Vibe uses Tomcat as a
standalone Web server for delivering data to Vibe users in their Web browsers. For more information
about Tomcat, see the Apache Tomcat Web site (http://tomcat.apache.org).

IMPORTANT: If the server where you want to install Vibe already has a Web server running on it,
shut it down while you install and test Vibe. The instructions for a Basic Vibe installation assume that
no other Web server is running on the Vibe server. If you want to maintain another Web server on the
Vibe server, you are responsible for resolving any port conflicts that might arise.

On the command line, use the netstat command to see what ports are currently in use on the server
where you plan to install Vibe:

Linux: netstat -tan

Windows: netstat -a -n -p tcp

Make sure that the port numbers that you specify during Vibe installation do not conflict with ports
that are already in use on the server.

¢ “HTTP/HTTPS Ports” on page 30

¢ “HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe” on page 31
¢ “Shutdown Port” on page 32

¢ “AJP Port” on page 32

HTTP/HTTPS Ports

By default, standard Web servers such as Apache and Microsoft Internet Information Services (IIS)
use port 80 for non-secure HTTP (Hypertext Transfer Protocol) connections and port 443 for secure
HTTPS connections. HTTPS connections use SSL (Secure Sockets Layer) for added security. As a
result, Web browsers default to port 80 when no port is specified in a non-secure HTTP URL and to
port 443 when no port is specified in a secure HTTPS URL.

Tomcat defaults to port 8080 for non-secure HTTP connections and to port 8443 for secure HTTPS
connections, so that it does not conflict with the standard Web server port numbers. If you configure
Vibe with the Tomcat default port numbers, users must include the appropriate port number when
providing the Vibe site URL. Typically, users prefer not to do this.
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Unfortunately, the situation is not as simple as just configuring Vibe to use the default port numbers
of 80 and 443. On Linux, non-root processes are not allowed access to port numbers lower than 1024
and you are counseled against running Vibe as root in Section 3.9.2, “Linux User ID for Vibe,” on
page 41. Also on Linux and Windows, the default Tomcat installation expects ports 8080 and 8443.

For a Basic installation, you can use the default port numbers as presented by the Vibe Installation
program:

HTTP port: 80
Secure HTTP port: 443

Listen port: 8080
Secure listen port: 8443

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server 2, port 80 is already in use
by iManager. To have Vibe listen on port 80 (which is the standard port), you need to change
iManager to listen on a non-standard port, such as 81.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, the default port numbers have been provided for you. You need to specify
different port numbers only if you anticipate port conflicts with other software on the Vibe server.
Resolving port conflicts is beyond the scope of this Vibe documentation.

After you install Vibe on Linux, you need to complete the steps in “Setting Up Port Forwarding” on
page 54 so that users are not required to include the port number in the Vibe URL.

If you want to use secure HTTPS connections for your Vibe site, you must obtain signed certificate
files as described in “Preparing for Secure HTTP Connections” in “Site Security” in the Nowvell Vibe 3.2
Administration Guide either before or after you install Vibe.

HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe

If you are fronting Vibe with Novell Access Manager, ensure that you have configured the HTTP/
HTTPS ports as described in the following sections, depending on the operating system where Vibe
is running.

Configuring Vibe in this way configures Novell Access Manager to access Vibe over port 80, which is
the standard port.

¢+ “Windows Port Configuration” on page 31

¢ “Linux Port Configuration” on page 32

Windows Port Configuration

Use the following port configuration when Novell Access Manager is fronting your Vibe system on
Windows:

HTTP Port: 80
Secure HTTP Port: 443
Listen Port: 80

Secure Listen Port: 443
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3.5

Linux Port Configuration

Use the following port configuration when Novell Access Manager is fronting your Vibe system on
Linux:

HTTP Port: 80

Secure HTTP Port: 443
Listen Port: 8080
Secure Listen Port: 8443

With this suggested configuration on Linux, you also need to set up port forwarding, as described in
Section 4.1.6, “Setting Up Port Forwarding,” on page 54.

Shutdown Port

By default, Vibe uses 8005 as its shutdown port. For an explanation of the shutdown port, see Tomcat
- Shutdown Port (http://www.wellho.net/mouth/837_Tomcat-Shutdown-port.html).

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its shutdown port if the default of
8005 is already in use on the Vibe server.

AJP Port

By default, Vibe uses 8009 as its AJP port. For an explanation of the Apache JServ Protocol port, see
The AJP Connector (http://tomcat.apache.org/tomcat-6.0-doc/config/ajp.html).

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server 2, port 8009 is already in
use, so you need to select a different port, such as 8010.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its AJP port if the default of 8009 is
already in use on the Vibe server.

Planning the WebDAV Authentication Method

¢ Section 3.5.1, “Understanding WebDAYV,” on page 33
¢ Section 3.5.2, “Choosing the WebDAV Authentication Method,” on page 33
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3.5.2

Understanding WebDAV

WebDAV is a standard collaborative editing and file management protocol. Novell Vibe relies on the
WebDAYV protocol for two key features:

+ Edit-in-Place for using tools such as OpenOffice and Microsoft Office, as described in “Using
WebDAV to Edit Individual Files” in the Novell Vibe 3.2 Advanced User Guide.

¢ Mapping Vibe folders as a Web folder on the client computer, which allows access to Vibe files
from a WebDAV-compliant file navigation tool such as Windows Explorer or Nautilus, as
described in “Creating a Mapped Drive to the Vibe Folder” in the Nowvell Vibe 3.2 Advanced User
Guide.

IMPORTANT: When Vibe users are running Windows 7 as the client operating system, various
issues can be introduced because of WebDAYV limitations in Windows 7. If your Vibe users are using
the Windows 7 operating system, see “Configuring Vibe to Support WebDAV on Windows 7” in the
Nowell Vibe 3.2 Administration Guide.

Choosing the WebDAV Authentication Method

The WebDAYV authentication method determines how user credentials are passed from Vibe to the
WebDAV server. Vibe 3 and later supports three types of WebDAV authentication methods:

¢ “Choosing Basic Authentication” on page 33
¢ “Choosing Digest Authentication” on page 33

¢ “Choosing Windows Authentication” on page 34

Choosing Basic Authentication

Basic authentication encodes the username and password with the Base64 algorithm. The Base64-
encoded string is unsafe if transmitted over HTTP, and therefore should be combined with SSL/TLC
(HTTPS).

Select this type of authentication when you plan to use Novell Access Manager or Internet
Information Services (IIS) to authenticate users.

For more information about encryption algorithms, see Section 3.6.5, “Database Encryption
Algorithm,” on page 36.

Choosing Digest Authentication

Digest authentication applies MD5 cryptographic, one-way hashing with usage of nonce values to a
password before sending it over the network. This option is more safe than Basic Authentication
when used over HTTP.

Select this type of authentication when client users are using Windows 7 as their operating system
and Microsoft Office as their text editor.

For more information about encryption algorithms, see Section 3.6.5, “Database Encryption
Algorithm,” on page 36.
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3.6.1

Choosing Windows Authentication

Windows Authentication provides Windows users with a single sign-on experience, enabling users
to automatically authenticate to Vibe after they are logged in to their individual workstations.
Internet Information Services (IIS) provides this capability.

To configure Vibe to use Windows Authentication as the WebDAYV authentication method, select basic
in the WebDAV authentication method field during the Vibe installation program, then configure
Windows Authentication as described in Section 9.9, “Configuring Single Sign-On with Internet
Information Services for Windows,” on page 89.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under WebDAV authentication method, specify the authentication method you want Vibe to use when
authenticating to WebDAV.

Planning the Vibe Database

Novell Vibe database disk space requirements are relatively modest. Files that are imported into Vibe
are saved in the Vibe file repository, as described in Section 3.2.4, “Vibe Installation Locations,” on
page 28.

The Vibe database is primarily used for storing the following information:
¢ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

¢ Identification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

¢ User profile information (for example, full name, phone number, and e-mail address)
You or your database administrator must make the following decisions about the Vibe database:
¢ Section 3.6.1, “Database Type,” on page 34
¢ Section 3.6.2, “Database Setup Method,” on page 35
¢ Section 3.6.3, “Database Location,” on page 35

¢ Section 3.6.4, “Database Credentials,” on page 36
¢ Section 3.6.5, “Database Encryption Algorithm,” on page 36

Database Type

By default, Vibe uses open source MySQL as its database on Linux and on Windows. On Linux, Vibe
also supports Oracle. On Windows, Vibe also supports Microsoft SQL Server and Oracle.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Type, mark the type of database that you want to use with Vibe.

Make sure that a supported version of the database server, as listed in Section 2.1, “Vibe Server
Requirements,” on page 17, is installed and running before you install Vibe.
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3.6.2

3.6.3

Database Setup Method

If you plan to use a MySQL database, the Vibe installation program can automatically set up the
database for you. This is the easiest way to get started.

If you plan to use an Oracle database or a Microsoft SQL database, you must have your database
administrator set up the database for you. Instructions for your database administrator are provided
in Section 13.4, “Creating an Oracle Database,” on page 118 and Section 13.3, “Creating a Microsoft
SQL Database,” on page 117.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Setup Method, mark whether you want the Vibe Installation program to automatically
set up a MySQL database, or whether you need your database administrator to manually set up an
Oracle database or Microsoft SQL database before you install Vibe.

Database Location

When you have the Vibe Installation program create the database for you, the database is created on
the same server where you install the Vibe software. This is the preferable location for your Basic
installation. The default database name is sitescape, a reference to the company that previously
developed the Vibe software.

Database Default Linux Locatio Default Windows Location

Server n

MySQL /var/lib/mysql c:\Documents and Settings\All Users\
Application Data\MySQL\
MySQL Server version\Data

Microsoft SQL N/A N/A

Oracle N/A N/A

You can have your database administrator create a database on a remote server later, after you have
successfully tested your Basic installation. See Chapter 13, “Creating the Vibe Database on a Remote
Server,” on page 115.

If you need to have your database administrator create an Oracle or Microsoft SQL database, you
must decide before installation whether you want the database on the Vibe server or on a remote
server. See Section 13.4, “Creating an Oracle Database,” on page 118.

Vibe knows where to find its database from the JDBC (Java Database Connectivity) URL that you
provide during installation. For a database that is local to the Vibe software, the default JDBC URL
that provides localhost as the hostname of the Vibe server is appropriate. If the database is on a
remote server, the JDBC URL must provide the hostname of the remote database server.

The JDBC URL also includes the port number on which Vibe can communicate with the database
server. The default port number depends on the database server you are using:
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3.6.4

3.6.5

Database Server Default Port Number

MySQL 3306
Microsoft SQL 1433
Oracle 1521

Use this port number unless it is already in use by another process on the database server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under JDBC URL, specify the appropriate hostname for the database server (localhost or the
hostname of a remote server) and the port number it will use to communicate with Vibe.

Database Credentials

When you have the Vibe Installation program create the database for you, it defaults to the following
administrator usernames for the database server:

Database Default Administrative Username

MySQL root

IMPORTANT: The MySQL root username is not the same as the Linux root user on a
Linux server.

Microsoft SQL  (no default) For a Microsoft SQL database, your database administrator establishes the
administrator username and password for the database server.

Oracle (no default) For an Oracle database, your database administrator establishes the
administrator username and password for the database server.

For an Oracle database and Microsoft SQL database, your database administrator establishes the
administrator username and password for the database server.

Check with your database administrator to see if the default administrator username is still in use for
your database server, and obtain the administrator password for the database server before you run
the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials, specify the administrator username and password for the database server
so that Vibe can access its database.

Database Encryption Algorithm

Different encryption algorithms provide differing encryption strength. The supported algorithms for
encrypting the Vibe database password are listed below, in order from least strength to most
strength.

+ MD5

¢+ SHA
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3.7.1

This is the default option when you use Basic Authentication for WebDAYV authentication, as
described in Section 3.5, “Planning the WebDAV Authentication Method,” on page 32

¢+ SHA-256
¢ PBEWithMD5AndDES

This is the only available option when you select Digest Authentication for WebDAV
authentication, as described in Section 3.5, “Planning the WebDAV Authentication Method,” on
page 32

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Encryption Algorithm, mark the encryption algorithm you want to use for Vibe
passwords.

Gathering Outbound E-Mail Information

Your Novell Vibe site can be configured to send outbound e-mail through an existing e-mail system.
E-mail from the Vibe site is useful for the following activities:

¢ Vibe users can subscribe to e-mail notifications, so that they automatically receive a message
whenever content of interest changes. For more information, see “Subscribing to a Folder or
Entry” in “Getting Informed” in the Novell Vibe 3.2 User Guide.

¢ From the Vibe site, users can send e-mail messages to individual users or to teams. For more
information, see “Sending E-Mail from within Vibe” in “Connecting With Your Co-Workers” in
the Novell Vibe 3.2 User Guide.

¢ If your e-mail client is iCal-enabled, appointments created in a Vibe Calendar folder can be sent
to your e-mail client for posting in your e-mail client Calendar. For example, if you are using
GroupWise, see “Accepting or Declining Internet Items” in “Calendar” in the GroupWise 8
Windows Client User GuideGroupWise 8 Windows Client Help.

In order for your Vibe site to communicate with your e-mail system, you need to gather the following
information about your e-mail system.

¢ Section 3.7.1, “Outbound E-Mail Protocol,” on page 37

¢ Section 3.7.2, “Outbound E-Mail Host,” on page 38

¢ Section 3.7.3, “Outbound E-Mail Authentication,” on page 38

¢ Section 3.7.4, “Outbound E-Mail Send Restriction,” on page 39

After installation, outbound e-mail can be disabled and enabled again on the Vibe site, as described
in “Configuring E-Mail Integration” in “Site Setup” in the Novell Vibe 3.2 Administration Guide.
However, you must configure outbound e-mail in the Vibe installation program.

Outbound E-Mail Protocol

E-mail systems communicate by using SMTP (Simple Mail Transfer Protocol). You need to determine
whether the e-mail system that you want your Vibe site to communicate with is using SMTP or
SMTPS (secure SMTP).

For GroupWise, you can check how the Internet Agent is configured:

1 In ConsoleOne, browse to and right-click the Internet Agent object, then click Properties.
2 Click GroupWise > Network Address.
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3.7.2

3.7.3

In the SMTP field, if the SSL column displays Disabled, GroupWise is using SMTP. If the SSL
column displays Enabled, GroupWise is using SMTPS.

3 Click Cancel to close the Network Address page.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound E-Mail Protocol, mark SMTP or SMTPS to match the e-mail system that you want Vibe
to communicate with.

If the e-mail system requires SMTPS, see “Securing E-Mail Transfer” in “Site Security” in the Novell
Vibe 3.2 Administration Guide.

Outbound E-Mail Host

In order to send messages to your e-mail system, Vibe needs to know the hostname of your SMTP
mail server.

The default SMTP port of 25 is typically appropriate, unless the SMTP mail server requires port 465
or 587 for SMTPS connections.

For GroupWise, this is the hostname of a server where the Internet Agent is running. GroupWise
always uses port 25, even when SSL is enabled.

When the Vibe site sends e-mail notifications for scheduled events, the messages are time-stamped
according to the time zone you specify here during installation. This setting allows you to use a time
zone for e-mail notifications that is different from the time zone where the server is located. The time
zone list is grouped first by continent or region, optionally by country or state, and lastly by city.
Some common selections for United States time zones are:

Time Zone Continent/City
Pacific Time America/Los Angeles
Mountain Time America/Denver
Central Time America/Chicago
Eastern Time America/New York

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound E-Mail Host, specify the name of the mail host, the SMTP port number it uses, and the
time zone for the time stamp you want on scheduled event notifications.

Outbound E-Mail Authentication

Many SMTP mail hosts require a valid e-mail address before they establish the SMTP connection.
Some e-mail systems can construct a valid e-mail address if you specify only a valid username; other
e-mail systems require that you specify the full e-mail address for successful authentication. You
should provide a username (e-mail address) to ensure a successful connection. E-mail notifications
from the Vibe system are sent using this e-mail address in the From field.

Some e-mail systems also require a password. Some do not. If authentication is required, you should
also provide a password.
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3.8

3.8.1

By default, the GroupWise Internet Agent does not require authentication in order to receive
inbound messages. However, the /forceinboundauth startup switch is available for use in the Internet
Agent startup file (gwia.cfg) to configure the Internet Agent to refuse SMTP connections where a
valid e-mail username and password are not provided. The Internet Agent can accept just the
username or the full e-mail address.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound E-Mail Authentication, indicate whether or not authentication is required for the Vibe
site to communicate with your e-mail system. If it is, specify the username or e-mail address, and if
necessary, the password for the e-mail account.

Outbound E-Mail Send Restriction

By default, the Vibe site allows Vibe users to send messages to all Vibe users by using the All Users
group on the Vibe site. On a very large Vibe site, this generates a very large number of e-mail
messages. If desired, you can prevent messages from being sent to the All Users group.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Allow Sending E-Mail to All Users, mark whether or not you want users to be able to send messages to
the All Users group.

Enabling Inbound E-Mail

You can configure your Novell Vibe site so that users can post comments by e-mailing them to the
folder where they want to post the comment. In order to receive e-mail postings, folders must be
properly configured, as described in “Enabling Folders to Receive Entries through E-Mail” in “Using
Filters on Folders” in the Nowvell Vibe 3.2 Advanced User Guide. Also, users must know the e-mail
address of the folder where they want to post their comment.

¢ Section 3.8.1, “Internal Mail Host for Inbound E-Mail,” on page 39
¢ Section 3.8.2, “Inbound E-Mail Port Number,” on page 40

¢ Section 3.8.3, “Inbound E-Mail IP Address,” on page 40

¢ Section 3.8.4, “Inbound E-Mail Security,” on page 40

After installation, inbound e-mail can be disabled and enabled again on the Vibe site, as described in
“Disabling/Enabling Inbound E-Mail Postings” in “Site Setup” in the Nowvell Vibe 3.2 Administration
Guide. However, you must configure inbound e-mail in the Vibe installation program.

Internal Mail Host for Inbound E-Mail

Inbound e-mail is disabled by default. When you enable it, the Vibe site starts an internal SMTP mail
host to receive incoming messages and post them to the folders associated with the e-mail addresses
to which the messages are addressed. By default, the internal SMTP mail host uses port 2525, so that
it does not conflict with another mail host that might be running on the Vibe server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, mark whether or not you want users to be able to post to the Vibe site
from their e-mail clients.
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3.8.3

3.8.4

Inbound E-Mail Port Number

Selecting the port number for the Vibe internal SMTP mail host presents the same issue that needs to
be dealt with for the HTTP port numbers, as described in “HTTP/HTTPS Ports” on page 30. You
might want to configure the Vibe internal SMTP mail host to use the standard SMTP port of 25. How
you handle the issue depends on whether you are installing on Linux or on Windows.

Linux: Keep the default port number (2525) in the Vibe Installation program, then complete the steps in
Section 4.1.6, “Setting Up Port Forwarding,” on page 54 so that requests incoming on port 25 are
forwarded to port 2525.

Windows: Specify port 25 for incoming e-mail in the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, specify the port number for the Vibe internal SMTP host to listen on.

Inbound E-Mail IP Address

If you want to install Vibe on a server where an SMTP mail host is already running, you can do so if
the server has multiple IP addresses. The existing SMTP mail host can use port 25 on one IP address
and Vibe can use port 25 on another IP address. During installation, you need to specify an IP
address only if the server has multiple IP addresses and you want Vibe to bind to a specific IP
address rather than all of them.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, specify the IP address for the Vibe internal SMTP host to listen on, if you
are installing Vibe on a server with multiple IP addresses and you want Vibe to bind to just one of them.

Inbound E-Mail Security

You can choose whether the Vibe internal mail host uses TLS (Transport Layer Security) when it
communicates with other SMTP mail hosts. In order for TLS to function properly, you must have a
certificate on the Vibe server, as described in “Securing E-Mail Transfer” in “Site Security” in the
Nowell Vibe 3.2 Administration Guide. When an SMTP mail host queries the Vibe mail host, the Vibe
mail host communicates its ability or inability to handle TLS. The other SMTP mail host then
communicates appropriately, taking into account how the Vibe internal mail host is configured. The
default is to use TLS, because this provides more secure communication between mail hosts.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound E-Mail Configuration, mark whether or not you want the Vibe server to announce that it can use
TLS.

You can install Vibe with Announce TLS selected, and then set up the certificate afterwards. However,
if you select Announce TLS, inbound e-mail does not work until the certificate is available on the Vibe
server.
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3.9.1

3.9.2

3.10

Planning Site Security

¢ Section 3.9.1, “Vibe Site Administrator Password,” on page 41
¢ Section 3.9.2, “Linux User ID for Vibe,” on page 41

Vibe Site Administrator Password

When you first log in to the Novell Vibe site, you use admin as the Vibe administrator username and
admin as the password. You should immediately change the password to one of your own choosing.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Administrator Credentials, specify the password that you want to use whenever you log in as
the Vibe site administrator.

Linux User ID for Vibe

For optimum security, Vibe should not run as the Linux root user. For example, if an intruder
manages to assume the identity of the Vibe program, the intruder gains all the privileges of the
commandeered process. If the process is running with root user privileges, the intruder has root
access to your system. If the process is running as a user with minimal privileges, the intruder has
only restricted access to your system. Therefore, your system is more secure if the Vibe program does
not run as root. For example, you might want to create a user named vibeadmin for the Vibe
program to run as. Linux users require a full name and a password.

In addition to creating a Linux user for the Vibe program to run as, you can also create a Linux group
for that user to belong to. This enables the Vibe program to create directories and files with consistent
ownership and permissions. For example, you might want to create a group named vibeadmin for
the vibeadmin user to belong to. Groups do not require passwords.

As an alternative to creating a custom Linux username and group for Vibe, you can use the existing
wwwrun username and the www group. This account is typically used to start Web server processes.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Linux Username and Group, specify the non-root Linux username and group name to use for
running the Vibe program. If you are creating a new Linux user, specify its full name and password.

IMPORTANT: The non-root Linux username and group must exist before you start the Vibe
Installation program. Instructions for creating the username and group are provided in Section 4.1.1,
“Performing Pre-Installation Tasks on Linux,” on page 49.

Gathering Directory Services Information

Unless you are planning a very small Novell Vibe site, the most efficient way to create Vibe users is to
synchronize initial user information from your network directory service (Novell eDirectory,
Microsoft Active Directory, or other LDAP directory service) after you have installed the Vibe
software. Over time, you can continue to synchronize user information from the LDAP directory to
your Vibe site.
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3.10.2

IMPORTANT: The following limitations apply when synchronizing user information to Vibe from
an LDAP directory service:

¢ Vibe performs one-way synchronization from the LDAP directory to your Vibe site. If you
change user information on the Vibe site, the changes are not synchronized back to your LDAP
directory.

¢ Vibe does not support multi-value attributes. If your LDAP directory contains multi-value
attributes, Vibe recognizes only the first attribute. For example, if your LDAP directory contains
multiple e-mail addresses for a given user, only the first e-mail address is synchronized to Vibe.

¢ Section 3.10.1, “LDAP Directory Service,” on page 42
¢ Section 3.10.2, “LDAP Connections,” on page 42
¢ Section 3.10.3, “LDAP Synchronization Options,” on page 45

LDAP Directory Service

You can synchronize initial Vibe user information from any LDAP directory. This guide provides
instructions for synchronizing user information from eDirectory and Active Directory. If you are
using another LDAP directory, use the instructions as guidelines for the tasks you need to perform.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP Directory Service, mark the LDAP directory service from which you want to synchronize
Vibe user information.

LDAP Connections

You can configure one or more LDAP connections. Each connection requires the following
configuration information:

¢ “LDAP Server” on page 42

¢ “LDAP Attribute to Identify a User or Group” on page 43
¢ “LDAP Attribute for Vibe Name” on page 43

¢ “User and Group Object Locations” on page 44

LDAP Server

In order to synchronize initial user information, Vibe needs to access an LDAP server where your
directory service is running. You need to provide the hostname of the server, using a URL with the
following format:

ldap://hostname

If the LDAP server requires a secure SSL connection, use the following format:

ldaps://hostname

If the LDAP server is configured with a default port number (389 for non-secure connections or 636
for secure SSL connections), you do not need to include the port number in the URL. If the LDAP
server uses a different port number, use the following format for the LDAP URL:

ldap://hostname:port number
ldaps://hostname: port number
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In addition, Vibe needs the username and password of a user on the LDAP server who has sufficient
rights to access the user information stored there. You need to provide the username, along with its
context in your LDAP directory tree, in the format expected by your directory service.

Directory Service Format for the Username
eDirectory cn=username,ou=organizational unit,o=organization
Active Directory cn=username,ou=organizational unit,dc=domain component

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP Server URL, specify the LDAP URL of the server, a fully qualified username with sufficient
rights to read the user information, and the password for that user.

If the LDAP server requires a secure SSL connection, additional setup is required. You must complete
the steps in “Securing LDAP Synchronization” in “Site Security” in the Novell Vibe 3.2 Administration
Guide to import the root certificate for your LDAP directory into the Java keystore on the Vibe server
before you configure Vibe for LDAP synchronization.

LDAP Attribute to Identify a User or Group

The LDAP attribute that uniquely identifies a user or group helps facilitate renaming and moving
Vibe users and groups in the LDAP directory. If this attribute is not set, and you rename or move a
user in the LDAP directory, Vibe assumes that the new name (or the new location of the same name)
represents a new user, not a modified user, and creates a new Vibe user.

For example, suppose you have a Vibe user with a given name of William Jones. If William changes
his name to Bill, and you make that change in the LDAP directory, Vibe creates a new user named Bill
Jones.

To ensure that Vibe modifies the existing user instead of creating a new user when the user is
renamed or moved in the LDAP directory, map each user to a binary attribute, such as the GUID or
objectGUID attribute in the LDAP directory. This attribute always has a unique value that does not
change when you rename or move a user in the LDAP directory. If you want to map users to a
different attribute, you must ensure that the attribute that you use is a binary attribute. For example,
the cn attribute cannot be used because it is not a binary attribute.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP that uniquely identifies a user or group, mark GUID or objectGUID, depending on whether
your LDAP directory is eDirectory or Active Directory.

LDAP Attribute for Vibe Name

LDAP directories differ in the LDAP attribute used to identify a User object. eDirectory and Active
Directory both use the cn (common name) attribute. Other LDAP directories might use the uid
(unique ID) attribute. Vibe needs to know which attribute to look for in order to find User objects.
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP attribute used for Vibe name, mark cn or uid, based on the convention used by your LDAP
directory service for User objects. Ensure that users have a value for the attribute that you mark.

Vibe calls the User object attribute screenName, so when you configure LDAP synchronization, you
map screenName to either cn or uid.

As needed, other LDAP attributes can be used for logging in to the Vibe site, as long as the attribute is
unique for each User object. For example, the mail LDAP attribute on User objects could be used to
enable Vibe users to log in to the Vibe site by using their e-mail addresses.

NOTE: Because the login name becomes part of the user’s workspace URL, the at sign (@) in the e-
mail address is replaced with an underscore (_) in the workspace URL because @ is not a valid
character in a URL.

User and Group Object Locations

Vibe can find and synchronize initial user information from User objects located in one or more
containers in the LDAP directory tree. A container under which User objects are located is called a
base DN (distinguished name). The format you use to specify a base DN depends on your directory
service.

Directory Service Format for the User Container
eDirectory ou=organizational unit,o=organization
Active Directory ou=organizational unit,dc=domain component

To identify potential Vibe users, Vibe by default filters on the following LDAP directory object
attributes:

¢ Person

¢ orgPerson

¢ inetOrgPerson

If you want to create Vibe groups based on information in your LDAP directory, Vibe filters on the
following LDAP directory object attributes:

¢ group

¢ groupOfNames

¢ groupOfUniqueNames

You can add attributes to the user or group filter list if necessary. You can use the following operators
in the filter:

¢ | OR (the default)

* & AND

¢+ INOT

You can choose whether you want Vibe to search for users (and optionally, groups) in containers
underneath the base DN (that is, in subtrees).
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP User Context, specify a base DN, along with object attributes if any, and mark whether you
want subtrees searched for Vibe users.

Under LDAP Group Context, specify a base DN, along with object attributes if any, and mark whether you
want subtrees searched for Vibe groups.

You might find it convenient to create a group that consists of all the users that you want to set up in
Vibe, regardless of where they are located in your LDAP directory. After you create the group, you
can use the following filter to search for User objects that have the specified group membership
attribute:

(groupMembership=cn=group name,ou=organizational unit,o=organization)

IMPORTANT: Be sure to include the parentheses in your filter.

LDAP Synchronization Options

The following synchronization options apply to all LDAP configurations within the same Vibe zone:

¢ “Synchronization Schedule” on page 45
¢ “User Synchronization Options” on page 46

¢ “Group Synchronization Options” on page 47

NOTE: Because the synchronization options apply to all LDAP configurations within the same zone,
you cannot have customized synchronization settings for each LDAP configuration. However, the
Novell Vibe site can have multiple zones. For more information about zones, see “Setting Up Zones
(Virtual Vibe Sites)” in “Site Setup” in the Novell Vibe 3.2 Administration Guide.

Synchronization Schedule

When you enable LDAP synchronization, you can set up a schedule for when it is convenient for
synchronization to occur. In planning the schedule, take into account how often your LDAP directory
user (and, optionally, group) information changes and the server resources required to perform the
synchronization for the number of users (and, optionally, groups) that you have.

You can choose to have LDAP synchronization performed every day, or you can select specific days
of the week when you want it performed (for example, on Monday, Wednesday, and Friday). You can
choose to have it performed once a day at a specified time (for example, at 2:00 a.m.), or you can set a
time interval, so that it is performed multiple times each day (for example, every four hours). The
smallest time interval you can set is .25 hours (every 15 minutes).

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Synchronization Schedule, record the schedule for when you want LDAP synchronization to take
place.
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User Synchronization Options

The following options are available for enabling and configuring user synchronization from your
LDAP directory to your Vibe site:

¢ Synchronize User Profiles: Select this option to synchronize user information whenever the

LDAP directory information changes after initial Vibe site setup. The attributes that are
synchronized are the attributes that are found in the map box in the Users section on the
Configure LDAP Synchronization page.

Users

LDAP attribute used for Vibe name:  uid

In the box below, map the internal identifiers to the LDAP attribute names of the user record. Use
the following syntax: internallD=ldapAitlame

firsthlame=gn

emailAddress=mail

lasthame=sn

description=description

phone=telephoneMumber

lastMame=surname

firsthlame=givenMame

By default, Vibe synchronizes the following attributes from the LDAP directory:

¢ First name

¢ Lastname

¢ Phone number

¢ E-mail address

¢ Description
For information about how to add additional attributes to be automatically synchronized, see
“Synchronizing Additional LDAP Attributes” in the Nowvell Vibe 3.2 Administration Guide.

Register LDAP User Profiles Automatically: Select this option to automatically add LDAP
users to the Vibe site. However, workspaces are not created until users log in to the Vibe site for
the first time.

Delete Users That Are Not in LDAP: Select this option to delete users that exist on the Vibe site
but do not exist in your LDAP directory. If this option is not selected and you delete a user from
your LDAP directory, the user is automatically disabled in Vibe. For more information about
disabled users in Vibe, see “Disabling Vibe User Accounts” in the Novell Vibe 3.2 Administration
Guide.

Use this option under the following conditions:

¢ You have deleted users from your LDAP directory and you want the LDAP synchronization
process to delete them from Vibe as well.

¢ In addition to the users synchronized from LDAP, you create some Vibe users manually, as
described in Section 5.2, “Creating a User,” on page 65, and you want the LDAP
synchronization process to delete the manually created users.

When Deleting Users, Delete Associated User Workspaces and Content: Select this option to
remove obsolete information along with the user accounts.
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¢ Time Zone for New Users Select this option to set the time zone for user accounts that are
synchronized from the LDAP directory into your Vibe site. The time zone list is grouped first by
continent or region, optionally by country or state, and lastly by city. Some common selections
for United States time zones are:

Time Zone Continent/City
Pacific Time America/Los Angeles
Mountain Time America/Denver
Central Time America/Chicago
Eastern Time America/New York

¢ Locale for New Users: Select this option to set the locale for user accounts that are synchronized
from the LDAP directory into your Vibe site. The locale list is sorted alphabetically by language.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP User Options, mark the synchronization options you want to use.

Group Synchronization Options

The following options are available for enabling and configuring user and group synchronization
from your LDAP directory to your Vibe site:

¢ Synchronize Group Profiles: Select this option to synchronize group information, such as the
group description, to the Vibe site whenever this information changes in LDAP.

¢ Register LDAP Group Profiles Automatically: Select this option to automatically add LDAP
groups to the Vibe site.

¢ Synchronize Group Membership: Select this option so that the Vibe group includes the same
users (and possibly groups) as the group in your LDAP directory. If you do not select this option,
and you make changes to group membership in the LDAP directory, the changes are not
reflected on your Vibe site.

¢ Delete Local Groups That Are Not in LDAP: Select this option to delete groups that exist on
the Vibe site but do not exist in your LDAP directory. Use this option under the following
conditions:

¢ You have deleted groups from your LDAP directory and you want the LDAP
synchronization process to delete them from Vibe as well.

¢ Inaddition to the groups synchronized from LDAP, you create some Vibe groups manually,
as described in “Creating Groups of Users” in “Site Setup” in the Novell Vibe 3.2
Administration Guide, and you want the LDAP synchronization process to delete the
manually created groups.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under LDAP Group Options, mark the synchronization options you want to use.
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3.11 Accommodating Multiple Languages

48

The Novell Vibe installation program runs in English only. When you install the Vibe software, you
can choose to have the primary language of the Vibe site to be any of the following languages:

¢ Chinese-Simplified

¢ Chinese Traditional

¢ Danish

¢ Dutch

¢ English

¢ French

¢ German

¢ Hungarian

¢ [talian

¢ Japanese

¢ Polish

¢ Portuguese

¢ Russian

¢ Spanish

+ Swedish

Some languages have an additional distinction by locale (the country where the language is spoken).

The language you select during installation establishes the language of the global text that displays in
locations where all Vibe users see it, such as in the Workspace tree when you click the Workspace tree
icon & :

o

Horne Workspace Personal Workspace Guest (guest)

The language you select also establishes the default interface language and locale for creating new
workspaces.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Default Locale, mark the default language and specify the default country for your Vibe site.

Additional language customization can be done after installation, as described in “Managing a
Multiple-Language Vibe Site” in “Site Setup” in the Nowvell Vibe 3.2 Administration Guide.
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Installing and Setting Up a Basic Vibe
Site

Follow the setup instructions for the platform where you are installing Novell Vibe:

¢ Section 4.1, “Linux: Installing and Setting Up a Basic Vibe Site,” on page 49
¢ Section 4.2, “Windows: Installing and Setting Up a Basic Vibe Site,” on page 58

4.1 Linux: Installing and Setting Up a Basic Vibe Site

You should already have reviewed Chapter 3, “Planning a Basic Vibe Installation,” on page 25 and
filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the
process of installing and starting Novell Vibe on Linux.

¢ Section 4.1.1, “Performing Pre-Installation Tasks on Linux,” on page 49

¢ Section 4.1.2, “Running the Linux Vibe Installation Program,” on page 51

¢ Section 4.1.3, “Installing Missing Libraries,” on page 54

¢ Section 4.1.4, “Checking for Available Hot Patches,” on page 54

¢ Section 4.1.5, “Configuring Vibe to Start Automatically on Reboot,” on page 54

¢ Section 4.1.6, “Setting Up Port Forwarding,” on page 54

¢ Section 4.1.7, “Starting Vibe on Linux,” on page 56

¢ Section 4.1.8, “Checking the Status of the Vibe Server,” on page 57

¢ Section 4.1.9, “Restarting Vibe,” on page 57

¢ Section 4.1.10, “Stopping Vibe,” on page 57

¢ Section 4.1.11, “Uninstalling Vibe,” on page 57

4.1.1 Performing Pre-Installation Tasks on Linux

1 Make sure that the Linux server where you plan to install Vibe meets the system requirements
listed in Section 2.1, “Vibe Server Requirements,” on page 17.

2 In a terminal window, become root by entering su - and the root password.
3 Set the Linux open file limit to meet the needs of the Vibe software:
3a Open the /etc/security/limits.conf file in an ASCII text editor.
3b Add the following lines to the bottom of the list, following the format of the example lines:

* hard nofile 65535
* soft nofile 4096

3c Save the file, then exit the text editor.
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4 Perform the following conditional tasks if necessary:
¢ “Stopping and Disabling an Existing Web Server” on page 50
¢ “Creating a Vibe User and Group” on page 50

Stopping and Disabling an Existing Web Server

If a Web server is currently running on the Vibe server, stop it, and preferably disable it.
For example, to stop the Apache Web server and its associated instance of Tomcat:
1 Enter the following commands to stop Apache and Tomcat:

/etc/init.d/tomcat5 stop
/etc/init.d/apache2 stop

2 Enter the following commands to make sure that Apache and Tomcat do not start again when

you reboot the server:

chkconfig --del apache2
chkconfig --del tomcat5

Creating a Vibe User and Group

If the user and group that you want to use for Vibe, as described in Section 3.9.2, “Linux User ID for
Vibe,” on page 41 do not exist yet, create them. It is easier if you create the group first.
1 Create the Linux group that you want to own the Vibe software and data store directories:

la InYaST, click Security and Users > User and Group Management to display the User and Group
Administration page.

1b Click Groups, then click Add.
lc Specify the group name, then click Accept or OK.
The group does not need a password.
2 Create the Linux user that you want Vibe to run as:
2a Click Users, then click Add.

2b On the User Data tab, specify the user’s full name, username, and password, then select
Disable User Login.

Like any Linux system user, the Vibe Linux user does not need to manually log in. The Vibe
Linux user does not need a password, either, but YaST requires you to provide one.

2¢ Click the Details tab.

2d In the Login Shell drop-down list, select /bin/false, because this user does not need to
manually log in.

2e In the Default Group drop-down list, select the Linux group that you created in Step 1.
2f In the Groups list, select the Linux group that you created in Step 1.
2g Click Accept or OK.

3 Exit YaST.
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Running the Linux Vibe Installation Program

When you run the Vibe installation program for the first time, you typically want to use the GUI
interface. However, if you are installing Vibe on a server where the X Window System is not
available, a text-based installation program is also available. After you are familiar with the Vibe
installation process, you can use a silent installation to automate the process.

¢ “Using the GUI Installation Program” on page 51

¢ “Using the Text-Based Installation Program” on page 52

¢ “Performing a Silent Installation” on page 53

Using the GUI Installation Program

1 In a terminal window, enter su - to become the root user, then enter the root password.

You need root permissions in order to install the Vibe software, but you should not run the Vibe
software as root.

2 Change to the directory where you downloaded and extracted the Vibe software.

3 Make sure that you have a license-key.xnl file in the same directory with the Vibe installation
program.

more license-key.xml

The Vibe installation program does not start without a license file in the same directory. If you
have not already, rename the license file to be called 1icense-key.xml.

For more information about licensing, see Chapter 6, “Updating Your Vibe License,” on page 69.

4 Enter the following command to start the Vibe installation program:

./installer-teaming.linux

5 Accept the License Agreement, then click Next.

x| Novell Vibe 3 Installation Program = 3 |
Installation Options

Select the action you want to perform.

* New installation
" Update software and settings
" Reconfigure settings

6 Click Next to accept the default of New installation.

Novell Vibe 3/Installation Program

Choose Installation Type

Select the type of installation you want to perform

Select the Basic installation if you do not want to configure

Advanced any of the optional features.

7 Click Next to accept the default of Basic.
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8 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet to
provide the information that the Vibe installation program prompts you for:

Installation Locations
Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe
User ID for Novell Vibe
Network Information
WebDAV Authentication Method
Database Selection
Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm
Java JDK Location
Outbound E-Mail Configuration
Protocol
Host, Port, and Time Zone
Username, Password, and Authentication
Allow Sending E-Mail to All Users
Inbound E-Mail Configuration

The installation program stores the information it gathers in the installer.xml file in the same
directory where you started the installation program.

9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 When the installation is completed, click Finish to exit the Vibe installation program.

Information about the installation process is written to the installer.log file in the same
directory where you ran the Installation program. If a problem arises during the installation, the
installer.log file provides information that can help you resolve the problem.

11 Continue with Section 4.1.5, “Configuring Vibe to Start Automatically on Reboot,” on page 54.

Using the Text-Based Installation Program

If you try to start the GUI Vibe installation program in an environment where the X Windows System
is not running, the text-based Vibe Installation program starts.
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Checking license key...
License Summary

Product: Novell Vibe

Version: 3.0

UID: 1
Effective: 10/27/2010
Expires: never
Users: unlimited

Installing this software requires agreement to the
terms and conditions set forth in the:
Novell EULA and Export Compliance Notice

You can review this agreement again at the downlcad site or
type "REVIEW" below.

Note: You must answer "YES" to install the software.

Have you read and agree with the license? :

If you want to use the text-based installation program in an environment where the GUI starts by
default, use the following command in the directory where the installation program is located:

./installer-teaming.linux --text

IMPORTANT: The text-based Vibe installation program must be run in the same directory where the
Vibe license file is located. If the license file is not in the same directory, the text-based installation
program cannot find it.

The text-based installation program gathers the same configuration information as the GUI
installation program does. This information is stored in the installer.xml file in the directory
where you run the installation program.

The installation program does not write the information it gathers into the installer.xml file until
you exit the installation program, and you cannot go back when you use the text-based installation
program. Therefore, when you use the text-based installation program, you should plan your
installation carefully in advance, using the Basic Vibe Installation Summary Sheet or the Advanced
Vibe Installation Summary Sheet. If you make a mistake during the installation, continue to the end
of the installation process and exit the installation program normally, so that all information is saved.
Then run the text-based installation program again. Your previous information is supplied as
defaults and you can change the information as needed.

Performing a Silent Installation

If your Vibe system expands beyond one server, you might need to repeatedly install the same Vibe
components. A silent installation makes this an easy process. Edit an existing installer.xmnl file so
that it has the hostname of the server where you want to perform the silent installation and copy it to
that server. In the directory where the installation program is located, use the appropriate command
to run the Vibe installation program, depending on the action that you want the silent installation to
perform:

./installer-teaming.linux --silent --install
./installer-teaming.linux --silent --upgrade
./installer-teaming.linux --silent --reconfigure

The Installation program obtains all the information it needs from the installer.xml file and
completes the installation without user interaction. If you have manually modified index server
scripts, such as the indexserver-startup. sh file as described in Section 14.1, “Installing the Lucene
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4.1.3

4.1.4

4.1.5

4.1.6

Software,” on page 121, all modifications will be lost when you perform a silent upgrade. To retain
your modifications, you should upgrade with the GUI installation program, as described in “Using
the GUI Installation Program” on page 51.

Installing Missing Libraries

After you install Vibe on SLES, you should check for and install any missing libraries.
1 Change to the following directory:

/opt/novell/teaming/stellent-converter/linux/x86

2 Run the exporter program.

The errors about missing input and output files are expected, and you can safely ignore them.
3 Look for errors about missing libraries.
4 If there are library errors, install any libraries that are missing.

On 64-bit Linux systems, a common missing library is 1ibstdc++.

You can use the following command to install the missing libraries:

zypper in library file

Checking for Available Hot Patches

After you install Vibe, make sure that you check on the Vibe download site where you downloaded
the Vibe software for any hot patches that might be available.

Configuring Vibe to Start Automatically on Reboot

You can configure Vibe to start automatically each time you reboot the Linux server.
1 As the Linux root user, enter the following command:

chkconfig --add teaming

2 To verify that automatic startup is turned on, enter the following command:

chkconfig teaming

Setting Up Port Forwarding

In order to make Vibe available on the default HTTP/HTTPS ports of 80 and 443, you must set up
port forwarding in order to forward the browser default ports (80 and 443) to the Vibe server ports
(8080 and 8443). In addition, you must set up port forwarding if you want to forward the default
SMTP mail host port (25) to the default Vibe internal mail host port (2525).

You can set up port forwarding in one of two ways, depending on whether or not you are using the
Vibe server as a firewall.

¢ “Using the SuSEfirewall2 File” on page 55
¢ “Using iptables Commands” on page 55
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Using the SuSEfirewall2 File

To enable port forwarding on a SUSE Linux server that uses SusEfirewall2:

1 As the Linux root user, open the following file:
/etc/sysconfig/SuSEfirewall?

2 Find the following line:
FW_REDIRECT=""

3 Between the quotation marks, copy and insert the following string:

0/0,1ip address,tcp,80,8080 0/0,ip address,tcp,443,8443
0/0,ip address,tcp, 25,2525

4 Replace ip address with the IP address of the Vibe server.

5 Save the SuSEfirewall? file, then exit the text editor.

6 Use the following command to restart the firewall:
/sbin/SuSEfirewall2 start

7 Use the following command to verify that the default browser ports (80 and 443) have been
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port (25)
has been forwarded to the Vibe internal mail host:

iptables-save | grep REDIRECT

Now, users do not need to include a port number in the Vibe site URL.

Using iptables Commands

To use iptables commands to enable port forwarding on any type of Linux server:

1 As the Linux root user, change to the /etc/init.d directory.

2 In a text editor, create a new file for a set of iptables commands, for example:
gedit vibe-iptables

3 Copy and paste the following lines into the vibe-iptables file:
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iptables -t nat -A OUTPUT -d localhost -p tcp --dport 80
-j REDIRECT --to-ports 8080

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 80
-j REDIRECT --to-ports 8080

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 80
-j REDIRECT --to-ports 8080

iptables -t nat -A OUTPUT -d localhost -p tcp --dport 443
-j REDIRECT --to-ports 8443

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 443
-j REDIRECT --to-ports 8443

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 443
-j REDIRECT --to-ports 8443

iptables -t nat -A OUTPUT -d localhost -p tcp --dport 25
-j REDIRECT --to-ports 2525

iptables -t nat -A OUTPUT -d hostname -p tcp --dport 25
-j REDIRECT --to-ports 2525

iptables -t nat -A PREROUTING -d hostname -p tcp --dport 25
-j REDIRECT --to-ports 2525

In this example, the lines are wrapped for readability. When you paste them into the text editor,
if the lines are still wrapped, remove the hard returns so that you have six iptables commands,
each on its own line.

4 Replace hostname with the hostname or IP address of the Vibe server.

5 Save the vibe-iptables file, then exit the text editor.

6 Use the following command to make the file executable:
chmod +x vibe-iptables

7 Use the following command to immediately execute the commands in the vibe-iptables file:
chkconfig vibe-iptables on

8 Use the following command to add vibe-iptables to future server boot initialization:
chkconfig --add vibe-iptables

9 Use the following command to verify that the default browser ports (80 and 443) have been
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port (25)
has been forwarded to the Vibe internal mail host:

iptables-save | grep REDIRECT

Now, users do not need to include a port number in the Vibe site URL.

4.1.7  Starting Vibe on Linux

56

The Vibe Installation program created a teaming startup script in the /etc/init.d directory.

1 In a terminal window, become root by entering su - and the root password.
2 Enter the following command to start Vibe:
/etc/init.d/teaming start

You must execute the teaming script as root, but the script runs Vibe as the user you selected in
Section 3.9.2, “Linux User ID for Vibe,” on page 41 and specified during installation.

You should see output similar to the following example:
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4.1.8

4.1.9

4.1.10

4.1.11

Using CATALINA BASE: /opt/teaming/apache-tomcat

Using CATALINA HOME: /opt/teaming/apache-tomcat
Using CATALINA TEMPDIR: /opt/teaming/apache-tomcat/temp
Using JRE_HOME: /use/java/jdkl.6.0 02/jre

3 To make sure that Vibe is ready for work:
3a Change to the following directory:
/opt/novell/teaming/apache-tomcat/logs
3b Enter the following command to display the end of the Tomcat log;:
tail --f catalina.out

At the end of the log file listing, you should see:

INFO: Server startup in nnnn ms

4 Press Ctrl+C when you finish viewing the catalina.out file.

Checking the Status of the Vibe Server

You can see if Vibe is running by checking for its process ID (PID).

1 In a terminal window, enter the following command:
ps -eaf | grep teaming

You should see the Vibe PID number, along with a listing of configuration settings.

Restarting Vibe

You need to restart Vibe whenever you use the Vibe installation program to make configuration
changes, as described in Chapter 10, “Performing an Advanced Vibe Installation,” on page 105.

1 Asroot in a terminal window, enter the following command:
/etc/init.d/teaming restart

You should see the same output as when you originally started Vibe.

Stopping Vibe

1 Asroot in a terminal window, enter the following command:
/etc/init.d/teaming stop
You should see the same output as when you started Vibe.

2 To verify that Vibe has stopped, check for its PID number:
ps -eaf | grep teaming

The Vibe PID number, along with a listing of configuration settings, should no longer be
displayed.

Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server to
reclaim disk space. The default Vibe file locations are:

Vibe Software /opt/novell/teaming
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4.2

421

Vibe File Repository and /var/opt/novell/teaming
Lucene Index

MySQL Database /var/lib/mysql

For a complete list of your Vibe files, check the installer.xml file in the directory where you
originally ran the Vibe installation program.

Windows: Installing and Setting Up a Basic Vibe Site

You should already have reviewed Chapter 3, “Planning a Basic Vibe Installation,” on page 25 and
filled out the Basic Vibe Installation Summary Sheet. The following sections step you through the
process of installing and starting Novell Vibe on Windows.

¢ Section 4.2.1, “Performing Pre-Installation Tasks on Windows,” on page 58

¢ Section 4.2.2, “Running the Windows Vibe Installation Program,” on page 59

¢ Section 4.2.3, “Checking for Available Hot Patches,” on page 60

¢ Section 4.2.4, “Running Vibe as a Windows Service,” on page 61

¢ Section 4.2.5, “Running Vibe as a Windows Application,” on page 62

¢ Section 4.2.6, “Uninstalling Vibe,” on page 62

Performing Pre-Installation Tasks on Windows

+ “Verifying System Requirements” on page 58
¢ “Stopping an Existing Web Server” on page 58

¢ “Setting Environment Variables” on page 59

Verifying System Requirements

Make sure that the Windows server where you plan to install Vibe meets the system requirements
listed in Section 2.1, “Vibe Server Requirements,” on page 17.

Stopping an Existing Web Server

If a Web server is currently running on the Vibe server, stop it, and preferably disable it.
For example, to stop and disable the Internet Information Services (IIS) Web server:

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click World Wide Web Publishing Service, then click Properties.

3 In the Startup type drop-down list, select Disabled.

4 Click Stop, then click OK.
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Setting Environment Variables

Make sure that the JAVA_HOME environment variable is set to the path where you installed the JDK
and that the Windows PATH environment variable includes the path to your database server.
1 Right-click My Computer, then click Properties.
2 On the Advanced tab, click Environment Variables.
3 Set the JAVA_HOME environment variable:
3a In the System variables box, click New.
3b In the Variable name field, specify JAVA_HOME.
3c In the Variable value field, specify the path where you installed the JDK.

3d Click OK to add the JAVA_HOME environment variable to the list of system variables, then
click OK again to save the setting and return to the Advanced tab.

4 Check the PATH environment variable:
4a On the Advanced tab, click Environment Variables.
4b In the System variables list, locate the PATH environment variable.
4c If the path includes your database server software directory, click Cancel.
or

If the path does not include your database server software directory, add the directory, then
click OK.

4.2.2  Running the Windows Vibe Installation Program

1 Log in to the Windows server as a user with Administrator rights.

2 In Windows Explorer, browse to the directory where you downloaded and extracted the Vibe
software.

3 Make sure that there is a 1icense-key.xmnl file in the directory.

The Vibe installation program does not start without a license file, and it has a different name
when you download it.

For more information about licensing, see Chapter 6, “Updating Your Vibe License,” on page 69.
4 Double-click the installer-teaming.exe file to start the Vibe installation program.

5 Accept the License Agreement, then click Next.

Movell Vibe 3 Installation Program x|
Installation Options
Select the action you want to perform. N

& New installation
€ Update software and settings
" Reconfigure settings

6 Click Next to accept the default of New installation.

Installing and Setting Up a Basic Vibe Site 59



Novell Vibe 3 Installation Program x|

Choose Installation Type
Select the type of installation you want to perform N

Advanced

7 Click Next to accept the default of Basic.

Select the Basic installation if you do not want to configure any of the
optional features.

8 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet to
provide the information that the Vibe installation program prompts you for:

Installation Locations
Default Locale for Novell Vibe
Network Information
WebDAV Authentication Method
Database Selection
Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm
Java JDK Location
Outbound E-Mail Configuration
Protocol
Host, Port, and Time Zone
Username, Password, and Authentication
Allow Sending E-Mail to All Users
Inbound E-Mail Configuration

The installation program stores the information it gathers in the installer.xml file in the same
directory where you started the installation program.

9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 When the installation is completed, click Finish to exit the Vibe installation program.

Information about the installation process is written to the installer.log file in the same
directory where you ran the Installation program. If a problem arises during the installation, the
installer.log file provides information that can help you resolve the problem.

11 Continue with one of the following sections, depending on how you want to run the Vibe
software:

¢ Section 4.2.4, “Running Vibe as a Windows Service,” on page 61

¢ Section 4.2.5, “Running Vibe as a Windows Application,” on page 62

4.2.3  Checking for Available Hot Patches

After you install Vibe, make sure that you check on the Vibe download site where you downloaded
the Vibe software for any hot patches that might be available.
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4.2.4

Running Vibe as a Windows Service

¢ “Configuring Vibe as a Windows Service” on page 61

¢ “Starting Vibe as a Windows Service” on page 61

¢ “Configuring the Vibe Service to Start Automatically on Reboot” on page 61
¢ “Restarting the Vibe Service” on page 62

¢ “Stopping the Vibe Service” on page 62

Configuring Vibe as a Windows Service

The Vibe installation program created a service.bat file for configuring Vibe to run as a Windows
service.
1 In a Command Prompt window, change to the following directory:
c:\Program Files\Novell\Teaming\apache-tomcat\bin\windows
2 In the windows directory, copy the files from the appropriate subdirectory.
The following subdirectories exist: x86, x64, 1a64.

If you are unsure which subdirectory is appropriate for your server, use the readme. txt file
located in the c: \Program Files\Novell\Teaming\apache-tomcat\bin\windows directory as
a reference.

3 Paste the files into the c:\Program Files\Novell\Teaming\apache-tomcat\bin directory.

4 (Conditional) If Vibe is running on a supported 64-bit Windows operating system and you have
a 64-bit JDK, complete the following steps:

4a Change to the c¢:\Program Files\Novell\Teaming\apache-tomcat\bin\windows\x64
directory.

4b Copy any 64-bit . exe files and paste them into the c:\Program
Files\Novell\Teaming\apache-tomcat\bin directory, overwriting any existing files.

5 Use the following command to configure Vibe as a Windows service:
service.bat install Teaming

This creates a service named Apache Tomcat Teaming.

Starting Vibe as a Windows Service

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Start.

Configuring the Vibe Service to Start Automatically on Reboot

When you run Vibe as a Windows service, you can configure Vibe to start automatically each time
you reboot the Windows server.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Properties.
3 In the Startup type drop-down list, select Automatic, then click OK.
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4.2.5

4.2.6

Restarting the Vibe Service

You need to restart Vibe whenever you use the Vibe installation program to make configuration
changes, as described in Chapter 10, “Performing an Advanced Vibe Installation,” on page 105.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Restart.

3 Close the Services window.

Stopping the Vibe Service

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Stop.

3 Close the Services window.

Running Vibe as a Windows Application

¢ “Starting Vibe as an Application” on page 62
¢ “Stopping Vibe as an Application” on page 62

Starting Vibe as an Application

The Vibe installation program created a startup.bat file for starting Vibe.
1 In a Command Prompt window, change to the following directory:

c:\Program Files\Novell\Teaming\apache-tomcat\bin

2 Run the startup.bat file to start Vibe as an application.

Stopping Vibe as an Application

1 In a Command Prompt window, change to the following directory:

c:\Program Files\Novell\Teaming\apache-tomcat\bin

2 Run the shutdown.bat file to stop the Vibe application.

Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server to
reclaim disk space. The default Vibe file locations are:

Vibe Software c:\Program Files\Novell\Teaming

Vibe File Repository and c:\Novell\Teaming
Lucene Index

MS SQL Database c:\Program Files\Microsoft SQL Server\MSSQL\Data

For a complete list of your Vibe files, check the installer.xml file in the directory where you
originally ran the Vibe Installation program.
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Adding Users to Your Vibe Site

After you have installed Novell Vibe and made sure that Vibe starts successfully, you are ready to
access your Vibe site from your Web browser and add users.

¢ Section 5.1, “Accessing Your Basic Vibe Site as the Site Administrator,” on page 63

¢ Section 5.2, “Creating a User,” on page 65

¢ Section 5.3, “Adding Vibe Users from Your LDAP Directory,” on page 66

5.1 Accessing Your Basic Vibe Site as the Site Administrator

1 In your Web browser, specify one of the following URLs, depending on whether or not you are
using a secure SSL connection:

http://vibe server
https://vibe server

Replace vibe server with the DNS hostname or fully qualified domain name of the Novell
Vibe server. If you have configured the HTTP ports correctly, you do not need to include the port
number in the Vibe URL.

Novell. Vibe"

User ID-

Password:

o

2 Log in using admin as the login name and admin as the password.
3 Click My Workspace in the Action toolbar.

The Vibe administrator’s personal workspace is displayed.
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admin | LogOut | %

ﬂ] = E () My Workspace &3 Whats New MyFavorites ™ MyTeams ™ RecentPlaces ™ Workspace ™  View ¥ A Lﬁ‘
admin {admin 2 ey =
admin (admin) e
& Blog
D Galendr What are you working on? “
[LIFiles
B Guestbook
ETasks Accessory Panel v <
Trash
4
Tasks 000D
Task Name Priority Due Date Status Assigned to % Done Location
Guesthook (+ X+ No <
admin {admin) // Guestbook Sign the guestbook
Blog 0000~
admin {admin) / Blog
No results
Photo Album 00O —~

admin (admin) / Photo Album

Permalinks

admin (L] & & ¢ ?

- 1 T () My Workspace <3 What's New My Favorites ™ MyTeams % RecentPlaces ™ Workspace ™ View % ("% \.i:‘

= admin (admin} Profie

@ Blog
= Ywhat are you working on?

[ calendar
LIFiles
B2 Guestsook = L
thnmhum - asks and Calendars ] Mcro-Hogs and Shered tems [ Resiaaaaalty
Tasks E
Grraeh = Aocessory Panel w2
E Tasks + + BN
[Ho Entrizs]
Task Name Priarity Ous Date Status Assignedta 5 Done Location
Guesthook + + 5N =
admin {admin) if Guestbook Sign the guesthook
[Na Entries]
Blog + + 5 X<
admin (admin) if Blog
Ma results
Photo Album + + K<

admin {admin) & Photo Album

[No phatos]

Permalinks

4 Change the default administrator password to a secure password:
4a Click Profile, then in the upper right corner of the Profile page, click Edit.

4b Specify your own password for the Vibe administrator in the New Password and Confirm
New Password fields.

4c (Optional) Provide useful information in the additional fields of the Vibe administrator’s
profile.

4d Click OK to return to the administrator’s profile.
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5.2 Creating a User

For testing purposes or for a very small Novell Vibe site, you can create each Vibe user manually.

1 Log in as the Vibe administrator.

N

Click the Settings icon [E3l in the upper right corner of the page, then click the Administration
Console icon E

In the Management section, click User Accounts.

In the Add Account tab, provide the user’s information, then click OK.

Specify at least the user ID, password, first name, and last name.

(Optional) Provide useful information in the additional fields for the new user.

~N o o0 b~ W

Click OK, then click Close to return to the administrator’s workspace.

If you click the Workspace tree icon t , then expand Personal Workspaces, you see that the
workspace for the user you just created does not exist yet. Workspaces are not created for users
until the users log in for the first time.

8 Click the Settings icon [EM in the upper right corner of the page, then lick Log Out to log out as
the Vibe administrator.

9 On the login page, provide the username and password for the Vibe user you just created, then
click OK to log in to the Vibe site.

10 Click My Workspace in the Action toolbar to see the workspace for the new user.

Novell. Vibe Jade Sumi | LogOut | #§

+] & B ()Myworkspace  {3WhatsNew MyFavortes %  MyTeams % RecentPlaces ™ Workspace ®  View » gt
Jade Sumi (jsumi) ‘g .
i Jade Sumi (jsumi) Profie
[@ Blog
9 Calendar What are you working on? %
LI Files [
B8 Guesthook
[El Photo Album e e e ey Accessaries
?TESKS Accessory Panel v
| Trash -
Tasks 0000 -
Task Name Priority Due Date Status Assigned to % Done Location
Guestbook 000 —
admin (admin) / Guestbook Sian the guestbook
i 0000 -
admin (admin) // Blog
Mo resuits
Photo Album 0G0 -~

admin (admin) // Photo Album

Permalinks
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Jade Sumi & B \+ ?

Jade Sumi (jsumi) Profile

What are you working an?

@ Blog

A calendar
LIFiles

B8 Guesthook
[E]Phato Alburm
A Tasks

[ Trash

Accessories

Accessory Panel w2

Tasks + + el
(Mo Entries]
Task Name Friority Due Date Status fssigned to % Done Looation
Guestbook + + &N
Jade Sumi {jsumi) # Guestbook Sign the guestbook
[Ho Entiiss]
Blog + & & =
Jade Surni (jsumi) if Blog
Mo results
Photo Album + + B =3

Jade Surni {jsumi) /f Photo Album

[Ne photos]

Permalinks

As each new user logs into the Vibe site, a personal workspace is created.

11 Click Log Out to leave the new user’s personal workspace.

5.3 Adding Vibe Users from Your LDAP Directory

Unless you have a very small Novell Vibe site, you create Vibe users by synchronizing their user
information from an LDAP directory service such as Novell eDirectory or Microsoft Active Directory.

IMPORTANT: For a large Vibe site with thousands of users, the synchronization process can
consume substantial server resources and can take some time to complete. Perform the initial import
from the LDAP directory at a time when this processing does not conflict with other activities on the
server.

1 If the LDAP server requires a secure SSL connection in order to access the directory service,
create a public key certificate for the Vibe server.

For instructions, see “Securing LDAP Synchronization” in “Site Security” in the Novell Vibe 3.2
Administration Guide.

2 Log in to the Vibe site as the Vibe administrator.
3 Click the Settings icon [EJM in the upper right corner of the page, then click the Administration

Console icon E
4 Under System, click Configure LDAP, then click Add a New LDAP Connection.

5 Fill in the following fields based on the information you gathered on the Basic Vibe Installation
Summary Sheet:
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Configure LDAP Synchronization
Add a New LDAP Connection

New LDAP connection

oy
Configuration for New LDAP connection

The LDAP server URL format s, ldsp:/fhost-port  For example: ldap:/localhost 389
LDAP server URL

User DN

Password

For eDirectory use GUID. For Adtive Direclory use objectGUID:
LDAP attribute that uniquely identifies a user or group:

Users

LDAP atfribute used for Vibe name: | uid

In the box below, map the internal identifiers to the LDAP attribute names ofthe user record. Use the following syntax:
internallD=ldapAttame

emailAddress=mail
firstName=gn
firstame=giveniame
lastName=zsn
lastName=surname
phone=telephoneNumber
description=description

Base DN |

({objectClass=Person)(objectClass=orgPerson){objectClass=inett

Filter
< m | -
Search Subtree
Delete

LDAP Server URL

User DN

Password

LDAP attribute that uniquely identifies a user or group
LDAP attribute used for Vibe name

Base DN

Set the following synchronization options based on the information you gathered on the Basic

Vibe Installation Summary Sheet:
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Enable Schedule
O Run immediately
Schedule
@ Every Day

@ Weekly (on selected days)

i ]
sun Mon Tue Wed Thu Fri Sat

@ atTime 20[x] :| 15[=] mDT
) Repeat Every UZSIE‘ Hours
Users
[ synchronize User Profiles
[ Register LDAP User Profiles Automatically

D Delete Users That are notin LDAP

[F1 when Deleting Users, Delete Associated User Workspaces and Content

Use the following time zone when creating new users.
(GMT -7:00) Mountain Standard Time (Boise) E

Use the following locale when creating new users.

English (United States) [English (United States)] Iz‘

Groups

Synchronize Group Profiles

O Rregister LDAP Group Profiles Automatically
O synchronize Group Membership

[ Delete Local Groups That Are Notin LDAP

Local user accounts

Allow Login for Local User Accounts, (i.6., user accounts notin LDAP)

[ <oy ] cose ]

Enable Schedule
Synchronize User Profiles
Register LDAP User Profiles Automatically

7 Click Apply to save the information and settings.
8 Select Run Immediately, then click Apply to test LDAP synchronization.

A status box displays the users and groups that have been added, modified, or deleted on the
Vibe site.

IMPORTANT: If you used an LDAP user attribute of uid and some users were not
synchronized from the LDAP directory to Vibe, repeat the procedure and use cn instead of uid.

The usernames admin and guest are reserved for use by Vibe. If your LDAP directory includes
users with these names, LDAP information for these reserved usernames is not imported into
the Vibe site.

9 Click Close to close the status box, then click Close to close the Configure LDAP Synchronization
page.
Vibe performs one-way synchronization from the LDAP directory to your Vibe site. If you
change user information on the Vibe site, the changes are not synchronized back to your LDAP
directory.

IMPORTANT: At this point, users could log into the Vibe site by using their eDirectory or Active
Directory usernames and passwords. However, you should not invite users to visit the Vibe site until
after you have finished setting up the Vibe site, as described in “Site Setup” in the Nowvell Vibe 3.2
Administration Guide.
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6 Updating Your Vibe License

Several different Vibe licenses are available:
¢ Evaluation License: Available from Novell Downloads (http://download.novell.com).

You receive your 60-day evaluation license when you download the evaluation version of Vibe.

¢ Starter Pack License: Available from Novell Downloads (http://download.novell.com) and from
the Novell Vibe Starter Pack Web page (http://www.novell.com/products/teaming/
starterpack.html).

You receive your 10-user starter pack license when you download the 10-user starter pack.
¢ Standard Vibe License: Purchased through a Novell sales representative or Novell partner.

The Standard Vibe License gives full Vibe functionality on a per-user basis. It includes Guest
user functionality for Vibe users who are covered by a Standard Vibe License. However, if non-
licensed Vibe users are accessing the Vibe site through the Guest user functionality (as an
anonymous user), then you must purchase a Guest Access Instance License in addition to the
Standard Vibe License for each Vibe instance.

After you purchase the Standard Vibe License, you can access your license key or view your
purchase history in the Novell Customer Center (http://www.novell.com/customercenter).

¢ Guest Access Instance License: Purchased through a Novell sales representative or Novell
partner.

This license must be purchased in addition to the Standard Vibe License. If you purchase 500 or
more Standard Vibe Licenses, the Guest Access Instance License is included for free.

The Guest Access Instance License allows you to provide Guest user access to your Vibe site for
non-licensed Vibe users. If you are using Guest user access for licensed Vibe users only, you do
not need to purchase this license.

The Guest Access Instance License is a paper license and does not require a new license-
key.xml file.

The Guest Access Instance License can provide added benefit to your site at a manageable cost.
For example, suppose that your company employs 500 people. Only 200 are company
knowledge-workers whom you expect to actively participate in the Vibe site; the other 300
employees simply need to access information that is already posted on the Vibe site, such as
files, news, or other company information. In this case, you would purchase 200 Standard Vibe
Licenses. For the remaining 300 employees, who will simply be accessing the site to obtain
information, you would purchase a single Guest Access Instance License.

You must purchase one Guest Access Instance License for each Vibe instance that you are
running.

For more information about the added functionality provided by this license, see “Allowing
Guest Access to Your Vibe Site” and “Allowing Web Crawler Access to Your Vibe Site” in “Site
Setup” in the Nowvell Vibe 3.2 Administration Guide.
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If you originally installed Vibe with an Evaluation License or a Starter Pack License, it is easy to
update your Vibe site with a new license file.

1

a A~ W N

10

11

Copy the new license file that you downloaded from one of the sources listed above into the
directory where you originally ran the Vibe installation program.

Rename the existing 1icense-key.xml file to a different name.
Rename the new license file to 1icense-key.xml.
Stop Vibe.

Run the Vibe Installation program, select the Reconfigure Settings option, then select the Basic
Installation option.

Click Next through all the installation program pages, then click Install to update your Vibe
license.

Start Vibe.

Log in to the Vibe site as the Vibe administrator.

Click the Settings icon [EMM in the upper right corner of the page, then click the Administration
Console icon E

Under Management, click License.

You should see the contents of the new license file.
Click Close.

At any time, you can generate a report of license usage, as described in “License Report” in “Site
Maintenance” in the Novell Vibe 3.2 Administration Guide.
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Setting Up Vibe

After you have installed and started Novell Vibe, there are still administrative tasks to perform before
your Vibe site is ready for users to log in and use Vibe efficiently. Refer to the following sections of
the Novell Vibe 3.2 Administration Guide as you finish setting up your Vibe site.

¢ “Setting Up Initial Workspaces”

¢ “Planning and Controlling User Access to Workspaces and Folders”

+ “Setting Up User Access to the Vibe Site”

¢ “Setting Up Site-Wide Customizations”

¢ “Configuring Vibe to Support WebDAV on Windows 7”

¢ “Configuring E-Mail Integration”

¢ “Configuring Weekends and Holidays”

¢ “Configuring Real-Time Communication Tools”

¢ “Enabling Custom JSPs to Be Used on Your Vibe Site”

¢ “Enabling Custom JAR Files to Be Used on Your Vibe Site”

¢ “Setting Up Mirrored Folders”

¢ “Setting Up Zones (Virtual Vibe Sites)”

¢ “Adding Software Extensions to Your Vibe Site”

¢ “Using Remote Applications on Your Vibe Site”

¢ “Managing a Multiple-Language Vibe Site”
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Basic Vibe Installation Summary Sheet

Installation Program Field

Value for Your Vibe Site

Explanation

Vibe Server Platform:

+ Windows

¢ Linux

See Section 3.2.1, “Vibe Server
Platform,” on page 26.

Vibe Server Architecture:

+ 32-bit
* 64-bit

See Section 3.2.2, “Vibe Server
Architecture,” on page 26.

Vibe Server Memory:

¢+ 4GB
¢+ 8GB

¢ More

See Section 3.2.3, “Vibe Server
Memory,” on page 27.

Java Development Kit (JDK):

¢ Sun JDK
¢ |IBM JDK

See Section 3.3, “Selecting a
Java Development Kit,” on
page 29.

Vibe Installation Locations:
+ Software
Linux default:
/opt/novell/teaming
Windows default:

c:\Program
Files\Novell\Teaming
+ File repository

Linux default:

/var/opt/novell/teaming

Windows default:

c¢:\Novell\Teaming

See Section 3.2.4, “Vibe
Installation Locations,” on
page 28.
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Installation Program Field

Value for Your Vibe Site

Explanation

TrueType Font Location:

Default:

/usr/X11R6/1ib/X11/fonts/
truetype

See Section 3.2.5, “TrueType
Font Location (Linux Only),” on
page 29.

Vibe Site Locale:

Language:

*

*

Chinese-Simplified
Chinese Traditional
Danish

Dutch

English

French

German
Hungarian
Japanese

Polish

Portuguese
Russian

Spanish

Swedish

Country:

See Section 3.11,
“Accommodating Multiple
Languages,” on page 48.

User ID for Novell Vibe (Linux only):

*

*

User ID:
Full name:

Password:

Group ID:

See Section 3.9.2, “Linux User ID
for Vibe,” on page 41.

Network Information:

*

Host:

HTTP port: 80

Secure HTTP port: 443
Listen port: 8080
Secure listen port: 8443
Shutdown port:

AJP port:

See Section 3.4, “Gathering
Network Information for Your Vibe
Site,” on page 29.
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Installation Program Field

Value for Your Vibe Site

Explanation

WebDAV Authenticaiton Method:

See Section 3.5, “Planning the
WebDAV Authentication Method,”

¢ basic on page 32.
+ digest
Database Type: See Section 3.6.1, “Database
Type,” on page 34.
* MySQL
* Microsoft SQL
* Oracle
JDBC URL: See Section 3.6.3, “Database
Location,” on page 35.
+ Hostname:

* Port number:

Database Credentials:

¢ Username:

+ Password:

See Section 3.6.4, “Database
Credentials,” on page 36.

Database Setup Method:

* During installation (automatically by

the Vibe Installation program)

+ Before installation (manually by

your database administrator)

See Section 3.6.2, “Database
Setup Method,” on page 35.

Database Encryption Algorithm:

¢ SHA

¢ SHA-256

* MD5

¢+ PBEWIithMD5AndDES

See Section 3.6.5, “Database
Encryption Algorithm,” on
page 36.

Java JDK Location:

+ Java home:

* JVM heap size:

See Section 3.3, “Selecting a
Java Development Kit,” on
page 29.

Outbound E-Mail Protocol:

¢ SMTP
¢ SMTPS

See Section 3.7.1, “Outbound E-
Mail Protocol,” on page 37.

Basic Vibe Installation Summary Sheet

75



76

Installation Program Field Value for Your Vibe Site

Explanation

Outbound E-Mail Host:

+ Hostname:
¢ SMTP port:
Default: 25
¢ Time zone
+ Continent/region:
+ Country/state:

+ City:

See Section 3.7.2, “Outbound E-
Mail Host,” on page 38.

Outbound E-Mail Authentication:

¢ Username:
* Password:

+ Authentication required? No / Yes

See Section 3.7.3, “Outbound E-
Mail Authentication,” on page 38.

Allow Sending E-Mail to All Users

Yes / No

See Section 3.7.4, “Outbound E-
Mail Send Restriction,” on
page 39.

Inbound E-Mail Configuration

* Enable: No/ Yes
¢ SMTP bind address:
¢ SMTP port:

¢ Announce TLS: Yes / No

See Section 3.8, “Enabling
Inbound E-Mail,” on page 39.

Vibe Site Password:

¢ Administrator username: admin
+ Default password: admin

* Your password:

See Section 3.9.1, “Vibe Site
Administrator Password,” on
page 41.

LDAP Directory Service:

* Novell eDirectory
* Microsoft Active Directory
¢ Other LDAP directory

See Section 3.10, “Gathering
Directory Services Information,”
on page 41.

LDAP Server:

¢ LDAP server URL:
¢ User DN:

+ Password:

See “LDAP Server” on page 42.
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Installation Program Field Value for Your Vibe Site

Explanation

LDAP Attribute to Identify User:
¢ GUID

screenName=GUID
* object GUID

screenName=0bjectGUID

See “LDAP Attribute to Identify a
User or Group” on page 43.

LDAP Attribute for Vibe Name:
¢ Cn

screenName=cn
¢ uid

screenName=uid

See “LDAP Attribute for Vibe
Name” on page 43.

LDAP User Search Context:

¢ Base DNs:
+ Additional filter attributes:

+ Search subtree: Yes / No

See “User and Group Object
Locations” on page 44.

LDAP Group Search Context:

¢ Base DNs:
+ Additional filter attributes:

+ Search Subtree: Yes / No

See “User and Group Object
Locations” on page 44.

LDAP Synchronization Schedule:

¢ Days
+ Every day
+ Weekly
Sun Mon Tue Wed Thu Fri Sat

¢ Hours:
* Attime:

¢ Repeat every nn hours

See “Synchronization Schedule”
on page 45.

LDAP User Options:

+ Synchronize user profiles

* Register LDAP user profiles
automatically

+ Delete users that are not in LDAP

+ When deleting a user, delete
associated user workspaces and
content

+ Time zone for new users

See “User Synchronization
Options” on page 46.
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Installation Program Field Value for Your Vibe Site

Explanation

LDAP Group Options:

*

*

Synchronize group profiles

Register LDAP group profiles
automatically

Synchronize group membership

Delete local groups that are not in
LDAP

See “User Synchronization
Options” on page 46.
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I I Advanced Installation and
Reconfiguration

*

Chapter 9, “Planning an Advanced Vibe Installation,” on page 81

*

Chapter 10, “Performing an Advanced Vibe Installation,” on page 105

*

Chapter 11, “Setting Configuration Options after Installation,” on page 107

*

Chapter 12, “Advanced Vibe Installation Summary Sheet,” on page 109
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9 Planning an Advanced Vibe Installation

9.1

The Advanced installation provides additional options for you to customize Novell Vibe.

*

*

*

*

*

Section 9.1, “What Is an Advanced Installation?,” on page 81

Section 9.2, “Distributing Different Data Types to Different Locations,” on page 82
Section 9.3, “Using Advanced Network Information Settings,” on page 83

Section 9.4, “Configuring Web Services,” on page 84

Section 9.5, “Changing Your Lucene Index Server Configuration,” on page 85
Section 9.6, “Managing RSS Feeds,” on page 86

Section 9.7, “Configuring Presence,” on page 87

Section 9.8, “Configuring Single Sign-On with Novell Access Manager,” on page 88

Section 9.9, “Configuring Single Sign-On with Internet Information Services for Windows,” on
page 89

Section 9.10, “Configuring Mirrored Folder Resource Drivers,” on page 102

Section 9.11, “Installing the Vibe Software in a Clustered Environment,” on page 103

As you proceed with planning, you can use the Advanced Vibe Installation Summary Sheet to record
your decisions about the options you want to use.

What Is an Advanced Installation?

In addition to the Basic installation options described in Section 3.1, “What Is a Basic Vibe
Installation?,” on page 25, the installation program for Vibe provides several advanced installation
and configuration alternatives. You can implement the advanced options after performing a Basic
installation, or you can have the installation program present all the options together.

Compared to a Basic installation, an Advanced installation offers the following additional options:

*

*

*

Changing the session timeout

Specifying a keystore file

Specifying different directories for different types of data

Disabling and enabling four different Web services

Changing the configuration of the Lucene Index Server

Configuring a remote Lucene Index Server or a group of high-availability Lucene nodes
Reconfiguring how RSS feeds are retained or disabling them entirely

Enabling presence in conjunction with Novell Messenger

Configuring a reverse proxy to accommodate single sign-on

Configuring Windows Authentication
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9.2

¢ Configuring mirrored folders

¢+ Installing Vibe in a clustered environment

IMPORTANT: The following Vibe configurations require that you perform an Advanced installation
as your initial installation of the Vibe software:

¢ Setting up the Vibe file repository so that some types of files are located outside the Vibe file
repository root directory. See Section 9.2, “Distributing Different Data Types to Different
Locations,” on page 82 for Advanced installation instructions. You cannot move subdirectories
within the Vibe file repository after they have been created.

¢ Installing the Vibe software on multiple servers to create a clustered environment. See
Chapter 15, “Running Vibe on Multiple Servers,” on page 125 for Advanced installation
instructions. The option to enable a clustered environment is available only during an Advanced
installation.

If you want to implement an Advanced installation option, you should perform a Basic installation
first, in a test environment, before performing the Advanced installation to set up your permanent
Vibe site.

Distributing Different Data Types to Different Locations

The default location for the Novell Vibe file repository varies by platform:

Linux: /var/opt/novell/teaming

Windows: c:\Novell\Teaming

Under the main Vibe file repository root directory are subdirectories for various kinds of data files
that are not stored in the Vibe database (MySQL, Microsoft SQL Server, or Oracle). You can use an
Advanced installation to store Vibe data files in various locations.

The data files not stored in the Vibe database are divided into several functional areas:
¢ Simple file repository: A large consumer of disk space.

All attachment files are stored in the file repository. All versions of files are also stored here.

¢ Jackrabbit repository: (Optional) Takes only a fraction of the space consumed by the file
repository.
By default, Vibe stores all data files individually on disk, in the file repository. If you prefer to
store data files in the database itself, you can use Apache Jackrabbit with Vibe. See the Apache
Jackrabbit Web site (http://jackrabbit.apache.org) for setup instructions.

¢ Extensions repository: Disk space consumption depends on the number of extensions you add
to your Vibe site.

An extension is a software program that you can incorporate into your Vibe site in order to
enhance (extend) Vibe capabilities. Adblock Plus is an example of a Firefox browser extension
that filters out advertisements. You or a Java developer can create custom extensions for your
Vibe site. For more information about creating and using Vibe extensions, see the Novell Vibe 3.2
Developer Guide.

¢ Archive store: A large consumer of disk space.
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9.3

9.3.1

When entries are deleted, files that were attached to the deleted entries are retained in the
archive store in order to meet compliance and archival goals. Previous versions of documents
are also retained in the archive store. After files have been archived, they are inaccessible from
the Vibe site. Files that accumulate in the archive store must be manually deleted as needed to
manage the disk space occupied by the archive store.

¢ Cache store: Consumes less disk space than the file repository.

Information derived from the attachments, such as thumbnails, HTML renderings, scaled
images, and word lists for indexing are stored in the cache store.

¢ Lucene index: Takes only a fraction of the space consumed by the file repository.

The Lucene index contains only pointers to the actual data stored in the file repository. The index
enables the Lucene search engine to perform very fast searches through large quantities of data.

The directories for the various types of data can be on the Vibe server or on a remote server. Data
access is fastest if the data is local, but depending on the size of your Vibe site and the types of data
you store, the Vibe server might not be the best place to store all the Vibe data. If you want to store
any of the data types on a remote server, you must ensure that the remote location of the data appears
local to the Vibe server and that it is always available with read/write access.

Linux: Mount the file repository to the Vibe server.
Windows: Map a drive from the Vibe server to the file repository.

Linux and Place the file repository on a SAN (storage area network) with read/write access. This alternative

Windows provides the most reliable remote location for the Vibe file repository. This is required for a
clustered environment, as described in Chapter 15, “Running Vibe on Multiple Servers,” on
page 125.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Data Locations, specify the directories where you want to store the various types of Vibe data.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe
Installation,” on page 105.

Using Advanced Network Information Settings

¢ Section 9.3.1, “Changing the Vibe Session Timeout,” on page 83

¢ Section 9.3.2, “Providing a Secure Keystore File,” on page 84

Changing the Vibe Session Timeout

By default, if a user’s Novell Vibe session is idle for four hours (240 minutes), Vibe logs the idle user
out. For increased convenience to Vibe users, you can make the session timeout interval longer. For
increased security for your Vibe site, you can make the session timeout shorter.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the session timeout interval (in minutes) for your Vibe site.
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Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe
Installation,” on page 105.

9.3.2 Providing a Secure Keystore File

For your convenience, the Vibe software includes a self-signed public certificate that enables you to
specify secure HTTP and listen ports during installation. This certificate is stored in the .keystore
file in the following directory:

Linux: /opt/novell/teaming/apache-tomcat/conf

Windows: c:\Program Files\Novell\Teaming\apache-tomcat\conf

To ensure secure SSL connections for your Vibe site, you should replace the self-signed public
certificate with a public certificate issued by a valid certificate authority.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the name and location of the public certificate.

If you do not already have a permanent public certificate for your Vibe server, see “Securing HTTP
Browser Connections” in “Site Security” in the Novell Vibe 3.2 Administration Guide.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe
Installation,” on page 105.

9.4 Configuring Web Services

When you install and set up your Novell Vibe site, three Web services are enabled by default. A
fourth is available for selection. These Web services enable programs to access information on your
Vibe site just as users would. Allowing programmatic access to your Vibe site can be useful or can be
viewed as a security risk.

¢+ WSS authentication: Uses OASIS Web Services Security (WSS) (http://www.oasis-open.org).

¢ HTTP Basic authentication: Uses HTTP Basic Access authentication (http://tools.ietf.org/html/
rfc2617).

¢ Token-based authentication: Uses custom Vibe tokens to communicate with Vibe remote
applications. For more information, see “Using Remote Applications on Your Vibe Site” in “Site
Setup” in the Novell Vibe 3.2 Administration Guide.

¢ Anonymous access: Allows access to your Vibe site without authentication. It is similar to the
Guest access provided for users, as described in “Allowing Guest Access to Your Vibe Site” in
“Site Setup” in the Nowvell Vibe 3.2 Administration Guide.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Web Services, mark which Web services you want enabled for your Vibe site. The first three are
enabled by default. The fourth is disabled by default.
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9.5

95.1

9.5.2

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe
Installation,” on page 105.

Changing Your Lucene Index Server Configuration

The default Lucene Index Server configuration is appropriate for a medium-sized Novell Vibe site. If
you have a larger Vibe site, you can change its Lucene Index Server configuration.

¢ Section 9.5.1, “Understanding Indexing,” on page 85

¢ Section 9.5.2, “Changing Lucene Configuration Settings,” on page 85

¢ Section 9.5.3, “Running the Lucene Index Server in Its Own JVM,” on page 86

¢ Section 9.5.4, “Running the Lucene Index Server on a Remote Server,” on page 86

¢ Section 9.5.5, “Running Multiple Lucene Index Servers,” on page 86

After planning your Lucene configuration, complete the planning process for additional Advanced
installation features as needed, then perform the Advanced installation as described in Chapter 10,
“Performing an Advanced Vibe Installation,” on page 105.

Understanding Indexing

The Lucene Index Server is responsible for indexing all data on the Vibe site so that Vibe users can
easily use the Find and Search features to retrieve the information that they need. Text posted in
folder entries is easy to index, because the formatting is simple. However, text in attached files arrives
in many different file formats, many of which require conversion before the text in the files can be
indexed. Therefore, the Lucene Index Server is dependent on the available file conversion technology
in order to perform its indexing function. For information about the file viewers that Vibe uses, see
Section 2.4.1, “File Viewer Support,” on page 20.

The Lucene Index Server provides additional services on your Vibe site in addition to indexing. In
fact, you cannot access your Vibe site if the Lucene Index Server is not running. For this reason,
Novell Vibe provides multi-server Lucene configuration options that are not available in Kablink
Vibe.

Changing Lucene Configuration Settings

If you have an extremely large Vibe site and you need to reindex the Vibe data, you might see
improved performance by increasing these settings.

+ Max booleans: The default is 10000. This means that 10,000 Boolean clauses are allowed in a
query. You need to increase this only if your Vibe site includes more than 10,000 users, groups, or
teams.

¢+ RAM in MB that may be used for buffering: The default is 256 MB for remote and high
availability Lucene configurations and 32 MB for local Lucene configurations. This is the amount
of RAM that is allocated for buffering documents and deletions before they are flushed to the
directory. (This setting can be changed only in the Lucene installer; it is not available in the Vibe
installer.)

¢ Merge factor: The default is 10. This sets the number of index segments that are created on disk.
When additional index segments are needed, existing segments are merged to keep the merge
factor constant.
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9.5.3

9.54

9.5.5

9.6

¢ Network interface for RMI service: (Optional) Specify the IP address or hostname for the
network interface for the RMI (Remote Method Invocation (http://java.sun.com/javase/
technologies/core/basic/rmi/index.jsp)) service.

This is the hostname of the server where the Lucene Index is installed.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify any Lucene configuration settings that you want to change.

Running the Lucene Index Server in Its Own JVM

By default, the Lucene Index Server runs in the same Java Virtual Machine (JVM) as the Vibe
software. To leave more memory available for the Novell Vibe software, you can configure the
Lucene Index Server to run in a separate JVM. In this configuration, it communicates with the Vibe
software using the RMI (Remote Method Invocation (http://java.sun.com/javase/technologies/core/
basic/rmi/index.jsp)) port, which by default is 1199.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify a hostname of localhost. Use the default RMI port number
unless it is already in use on the server.

To change from running the Lucene Index Server in the same JVM with Vibe to running it in its own
JVM, you must complete the same steps that you use for setting up the Lucene Index Server on a
remote server. This includes manually installing the Lucene Index Server software on the Vibe server,
as described in Chapter 14, “Installing the Lucene Index Server on a Remote Server,” on page 121.

Running the Lucene Index Server on a Remote Server

If the Lucene Index Server requires more memory, disk space, or CPU resources than are available on
the Novell Vibe server, you can move it to a remote server. This requires installing the Lucene Index
Server software on that server. For instructions, see Chapter 14, “Installing the Lucene Index Server
on a Remote Server,” on page 121.

Running Multiple Lucene Index Servers

Because the availability of the index is critical to the functioning of the Novell Vibe site, you can
install multiple Lucene Index Servers on multiple remote servers to provide high availability. For
instructions, see Chapter 16, “Running Multiple Lucene Index Servers,” on page 131.

Managing RSS Feeds

By default, Novell Vibe users can set up RSS feeds in folders on the Vibe site, as described in
“Viewing Folders as RSS or Atom Feeds” in “Getting Informed” in the Novell Vibe 3.2 User Guide.

¢ Section 9.6.1, “Configuring RSS Feeds,” on page 87

¢ Section 9.6.2, “Disabling RSS Feeds,” on page 87
After planning the RSS settings, complete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 10, “Performing
an Advanced Vibe Installation,” on page 105.
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9.6.1

9.6.2

9.7

Configuring RSS Feeds

The following aspects of RSS functionality on your Vibe site are configurable:

¢ Max elapsed days: By default, items from RSS feeds are retained on the Vibe site for 31 days.
You can decrease the number of days to reduce the amount of disk space occupied by the RSS
files.

¢ Max inactive days: By default, if no one on the Vibe site accesses an RSS feed for 7 days, the feed
is no longer updated. Increase or decrease the retention time for inactive feeds to meet the needs
of Vibe users and disk space considerations.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, specify the number of days that meet the needs of your Vibe site.

Disabling RSS Feeds

Some administrators consider RSS feeds to be a security risk because the RSS feed URL includes
username and password information. If you do not want Vibe site users to be able to subscribe to RSS
feeds from the Vibe site, you can disable this feature.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, mark No.

Configuring Presence

If you are using Novell Messenger as your instant messaging solution, you can configure Novell Vibe
to display a user’s Messenger presence information. For information about where presence
information is displayed in Vibe, see “Sending an Instant Message from within Vibe” in the Novell
Vibe 3.2 User Guide.

When you click a user’s presence icon, the Profile Quick View is displayed, which enables you to
send an instant message to the user, view the user’s personal workspace, follow the user, and more.

In order to configure Messenger presence to be displayed in Vibe, you need the following
information about the Messenger system during the Vibe installation:

¢ Server address: Specify the IP address or DNS hostname of the messaging agent for your
Messenger system.
¢ Port: Specify the port number.

¢ Server user: Specify the fully typed, comma-delimited context username of the Allowed Service
User that you want to log in to the Messenger system and retrieve presence information.

For example, cn=vibesvc, o=acme

For more information about the Allowed Service User, see “Integrating Novell Vibe OnPrem
with Novell Messenger” in the Novell Messenger 2.2 Administration Guide.

¢ Password: Specify the password for the Allowed Service User that you want to log in to the
Messenger system and retrieve presence information.

For more information about the Allowed Service User, see “Integrating Novell Vibe OnPrem
with Novell Messenger” in the Novell Messenger 2.2 Administration Guide.
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9.8

¢ Server Certificate: Browse to and select the Messaging Agent’s SSL certificate. Vibe uses this
certificate to identify the Messenger server.

If Messenger is installed on a separate server, copy the certificate from the Messenger server and
place it in a location on the Vibe server that can be reached from the Vibe installation program.

The certificate is located in the following directory on the Messenger server:

Linux: /opt/novell/messenger/certs

Windows: c:\Novell\Messenger\certs

To remove the certificate after you have already selected it, click Browse > Cancel.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Presence Configuration, select Enable Novell Messenger Presence, then list the information that
the Vibe site needs to know in order to communicate with the Messenger system.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe
Installation,” on page 105.

IMPORTANT: For Messenger presence to display in Vibe when using LDAP, you need to map
presencelD to your authentication attribute in the Vibe LDAP configuration page. For example,
presenceID=cn. For more information, see “Configuring Presence” in the Novell Vibe 3.2
Administration Guide

Configuring Single Sign-On with Novell Access Manager

Novell Access Manager provides secure single sign-on access to your Novell Vibe site by functioning
as a reverse proxy server. Access Manager 3.1 SP1 IR1 is required for use with Novell Vibe. You can
download the required version of Access Manager from Novell Downloads (http://
download.novell.com).

For background information about setting up Novell Access Manager 3.1, see the Access Manager 3.1
Documentation Web site (http://www.novell.com/documentation/novellaccessmanager31). For
instructions specific to Vibe, see “Configuring a Protected Resource for a Novell Teaming 2.x Server”
(http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/
b3nqgsg.html#blpk97e). These instructions are based on the Linux text-based Vibe installation
program, as described in “Using the Text-Based Installation Program” on page 52. They can easily be
adapted for running the Linux GUI Vibe installation program, as described in “Using the GUI
Installation Program” on page 51, or when installing on Windows, as described in Section 4.2.2,
“Running the Windows Vibe Installation Program,” on page 59.

After you have configured Novell Access Manager, you must configure your Vibe site with the IP
address of one or more Access Gateway servers and with the logout URL. When you configure the
Vibe site to use the Access Gateway, the IP addresses that you specify are the only locations from
which the Vibe site accepts logins. The logout URL is the location where users find themselves when
they log out of the Vibe site.

When you enable the Access Gateway for use with your Vibe site, all Vibe users must log in through
the Access Gateway. It is not possible to set up the Vibe site so that some users log in through the
Access Gateway and some do not.

Novell Vibe 3.2 Installation Guide


http://download.novell.com
http://www.novell.com/documentation/novellaccessmanager31
http://www.novell.com/documentation/novellaccessmanager31
http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/b3nqgsg.html#blpk97e
http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/b3nqgsg.html#blpk97e
http://www.novell.com/documentation/novellaccessmanager31/accessgateway/data/b3nqgsg.html#blpk97e

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Reverse Proxy Configuration, list one or more IP addresses of Access Gateway servers that have
been configured for use by Vibe. List the logout URL, and if necessary, the Access Gateway hostname
for WebDAV connections.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe
Installation,” on page 105.

9.9 Configuring Single Sign-On with Internet Information
Services for Windows

Like Novell Access Manager, Windows Authentication provides Windows users with a single sign-
on experience, enabling users to automatically authenticate to Novell Vibe after they log in to their
individual workstations. Internet Information Services (IIS) provides this capability.

Before you implement Windows Authentication, consider the following limitations:
¢ IISis best suited for an intranet environment. Because NTLM is a connection-based protoco], it
does not work well with HTTP proxy servers.

¢ IS does not support Guest Access.

After you configure the Vibe server to support Windows Authentication, complete the planning
process for additional Advanced installation features as needed, then perform the Advanced
installation as described in Chapter 10, “Performing an Advanced Vibe Installation,” on page 105.
¢ Section 9.9.1, “System Requirements,” on page 89
¢ Section 9.9.2, “Planning Your IIS Installation and Configuration,” on page 90
¢ Section 9.9.3, “Configuring the Vibe Server to Support Windows Authentication,” on page 92
¢ Section 9.9.4, “Running the Vibe Installation Program,” on page 98
¢ Section 9.9.5, “Configuring Your Browser to Allow Access to the Vibe Site,” on page 98

¢ Section 9.9.6, “Bypassing Windows Authentication to Configure LDAP and Perform Other
Tasks,” on page 99

¢ Section 9.9.7, “Logging In to the Vibe Site through Windows Authentication,” on page 99
¢ Section 9.9.8, “Editing Files through WebDAV with Windows Authentication,” on page 100

¢ Section 9.9.9, “Configuring IIS to Load Balance in a Clustered Environment,” on page 101

9.9.1 System Requirements

Windows Authentication with IIS can be enabled for Vibe only in the following environments:

Server

+ Windows 2008 Server
+ Windows 2008 R2 Server
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IS

¢ IIS 7 with IIS Manager with CGI and ISAPI components
¢ IIS 7.5 with IIS Manager with CGI and ISAPI components

Authentication Protocol

One of the following authentication protocols:

+ NTLM
¢ Kerberos v5
¢ Negotiate/SPNEGO (wrapper for NTLM and Kerberos v5)

Domain Controller

¢ Active Directory Service

Vibe needs to be configured and synchronized with your Active Directory directory service. For
more information about configuring LDAP synchronization within Vibe, see Section 3.10,
“Gathering Directory Services Information,” on page 41 and “Synchronizing Users and Groups
from an LDAP Directory” in the Nowvell Vibe 3.2 Administration Guide.

If you are using Kerberos as your authentication protocol, then Key Distribution Services is also
required.

For more information about installing and configuring the domain controller and other domain
services to support Windows Authentication, refer to the appropriate Microsoft documentation.

Client

One of the following clients:

+ Windows 7
+ Windows XP

Browser

One of the following browsers, configured to support Windows Authentication:

¢ Internet Explorer

+ Firefox

For information on how to configure your browser to support Windows Authentication, see
Section 9.9.5, “Configuring Your Browser to Allow Access to the Vibe Site,” on page 98.

9.9.2 Planning Your IIS Installation and Configuration

Use the information in the following table as you consider your IIS installation.
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Directory: The default installation directory for the IIS plug-in is C: \Program Files\Novell.
This is the recommended directory. If for some reason you choose to install the 1IS plug-in in a
directory other than the C:\Program Files\Novell directory, then you need to modify the
isapi redirect.properties files, as described in “Installing the Vibe 1IS Plug-In” on page 92.

External or Local Server: You can install the 1IS plug-in on the same server where you are running
Vibe, or you can install it on an external server. Installing IS on an external server can have several
benefits, such as:

+ Performance improvement
+ Ability to integrate with several Vibe servers in a clustered environment

+ Ability to run Vibe from a non-Windows server

If you are running 1IS from an external server, then you need to edit the C: \Program
Files\Novell\Vibe IIS Plugin\conf\workers.properties file, as described in
“Installing the Vibe IIS Plug-In” on page 92.

64-bit/32-bit: You can install the 1IS plug-in on a 64-bit or 32-bit operating system. However, Vibe
should run on a 64-bit operating system, so if you install IS on a 32-bit operating system, you
should use an external server.

HTTP Ports: Regardless of whether 1IS and Vibe are located on the same server or separate
servers, the HTTP port and secure HTTP port for Vibe should always be 80 and 443. This ensures
that when links are generated, they contain the correct hostname and port number.

These are the ports that Vibe uses to refer to the browser. In a very basic Vibe system (single server
without Windows Authentication), the HTTP ports can be the same as the listen ports. However, in
a Vibe system with Windows Authentication enabled, the HTTP ports correspond with the ports that
the IS server is configured to use.

Listen Ports: If you plan to run IIS on the same server as the Vibe server, you need to set the listen
port and secure listen port for Vibe to something other than 80 and 443.

By default, Vibe listens on ports 80 and 443. Because IIS also uses these ports to listen on, you
must reconfigure the Vibe listen ports to ports that are not currently in use, such as 8080 for the
listen port and 8443 for the secure listen port.

You configure Vibe ports during the Vibe installation, as described in Chapter 10, “Performing an
Advanced Vibe Installation,” on page 105.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the HTTP ports and listen ports.

Under Integration with IS for Windows Authentication, select Enable Integration with IS for Windows
Authentication, then list the logout URL.
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9.9.3

Configuring the Vibe Server to Support Windows Authentication

To configure the Vibe server to support Windows Authentication, you must first configure IIS. You
can set up IIS on the same server where Vibe is running, or on a separate server. See Section 9.9.2,
“Planning Your IIS Installation and Configuration,” on page 90 for more information.

Complete the following sections to ensure that IIS is configured correctly to work with Vibe.

*

*

*

*

“Installing the Vibe IIS Plug-In" on page 92
“Installing IIS Manager” on page 93
“Installing Windows Authentication Role Service” on page 93

“Creating and Managing Vibe Resources with IIS Manager” on page 94

Installing the Vibe IIS Plug-In

1 Locate the teaming-version-iis-plugin.zip file from the Vibe distribution, then unzip it into

4

the C:\Program Files\Novell directory.
This creates a directory called Vibe IIS Plugin.

If in Step 1 you chose to unzip the teaming-version-iis-plugin.zip file into the C: \Program
Files\Novell directory, continue with Step 3.

or

If in Step 1 you chose to unzip the teaming-version-iis-plugin.zip file into a location other
than C:\Program Files\Novell, you must complete the following steps:

2a Locate the isapi_redirect.properties file in each of the following directories:
¢ Vibe IIS Plugin\resourcesl\bin
¢ Vibe IIS Plugin\resources2\bin
2b In each of the directories, open the isapi_ redirect.properties file in a text editor.

2c Adjust the values of the 1og_file, worker_file, and worker mount_file properties to
reflect the directory where you chose to unzip the teaming-version-iis-plugin.zip file.

2d Save your changes and close both of the isapi_redirect.properties files.
If IIS and the Vibe server are located on the same server, continue with Step 4.
or
If IIS and the Vibe server are located on separate servers, complete the following steps:

3a Locate the C:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties
file.

3b Open the workers.properties file in a text editor.

3c Adjust the value of the worker.workerl.host property from localhost to the hostname
or IP address of the Vibe server.

3d Save your changes and close the editor.
(Conditional) If you are running IIS on a 64-bit server, complete the following steps:
4a Locate the C:\Program Files\Novell\Vibe IIS Plugin\library\winé4 directory.

4b Copy the appropriate version of the .d11 library and paste it into each of the following
directories:

¢ C:\Program Files\Novell\Vibe IIS Plugin\resourcesl\bin

¢ C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin
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4c

4d

Ensure that you copy the correct version of the .d11 library. If you copy the incorrect
version, you receive a 500 error when you try to access the Vibe site.

Delete the existing isapi redirect.dll files from the C:\Program Files\Novell\Vibe
IIS Plugin\resourcesl\bin directory, as well as from the C:\Program
Files\Novell\Vibe IIS Plugin\resources2\bin directory.

Rename the .d11 library files that you copied in Step 4b to isapi redirect.dll.

For example, if Vibe is running on an AMD64/EM64T platform, copy C:\Program
Files\Novell\Vibe IIS Plugin\library\winé4\amdé4\isapi redirect-
version.dll into the C:\Program Files\Novell\Vibe IIS Plugin\resourcesl\bin
and C:\Program Files\Novell\Vibe IIS Plugin\resources2\bin directories, then
delete the original isapi_redirect.dll file and rename isapi_redirect-version.dll
to isapi redirect.dll.

Installing 1IS Manager

If Internet Information Services (IIS) Manager is not already installed on your server, you need to
download and install it. You also need to install the CGI and ISAPI components.

1 Install the IIS 7 Administration Pack:

la
1b
lc
1d

le

1f

Navigate to Microsoft IIS Download Site (http://www.iis.net/download/Manage).
Click the Manage tab.
Under Administration Pack, click Install.

(Conditional) If you have not yet installed the Microsoft Web Platform, click Get the
Microsoft Web Platform to download the . exe file, install the Microsoft Web Platform, then
click Finish your installation.

The Launch Application dialog box is displayed.
Select Web Platform Installer, then click OK.
The Web Platform Installer 2.0 dialog box is displayed.

Click Install to install the Administration Pack, then accept the terms of the license
agreement.

2 Install the ISAPI and CGI components:

2a
2b
2c
2d
2e

2f

Launch the Web Platform Installer.

From the Web Platform Installer, select Web Platform.

Under Web Server, click Customize.

In the Application Development section, select CGI, ISAPI Extensions, and ISAPI Filters.
Click Install, then accept the terms of the license agreement.

Click Finish after the components have been installed successfully.

Installing Windows Authentication Role Service

If the Windows Authentication Role Service is not already installed, you need to install it.

1 On the Windows 2008 server, click Start > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (IIS).
3 Click Add Role Services.

The Add Role Services window is displayed.
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4 Scroll to the Security section, then select Windows Authentication.

5 Click Next, then complete the installation.

Creating and Managing Vibe Resources with IIS Manager

1 Click Start > Administrative Tools > Internet Information Services (IIS) Manager.
2 In the Connections pane on the left side of the window, expand your server, then expand Sites.
3 Right-click Default Web Site, then click Add Virtual Directory.

The Add Virtual Directory dialog box is displayed.

Site name;  Default Web Site
Path: /

Aligs:

Example: images

Physical path:

| e

Pazs-through authentication

Connect as... Test Settings... |

Ok I Cancel

4 In the dialog box, specify the following information:
Alias: VibeResourcesl.
Physical path: C: \Program Files\Novell\Vibe IIS Plugin\resourcesl\bin.
5 Click OK.
6 Repeat Step 3 through Step 5 to add another virtual directory.
This time, specify the following information in the Add Virtual Directory dialog box:
Alias: VibeResources?2

Physical path: ¢:\Program Files\Novell\Vibe IIS Plugin\resources2\bin
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7 In the Connections panel, select VibeResources1, then double-click Handler Mappings.

& Internet Information Services (IIS) Manager [ 73]
@_@.) [LJ } PEN b Sites b DefaultWebSite P VibeResourcesi P | e @ -
Fle View Help
~| Handler Mappings ————
@-H|E e L PRing Add Menaged Hander...
&5 Start Page Add Script Map...
P N | Use this feature to specify the resources, such as DLLs and managed code,
=95 PE:';'-""F*‘:““E @Cl‘m'”'s"am“ that hande responses for specific request types, Add Wildcard Script Map...
[k “ppication Fools Add Module Mapping...
B-[8] sites Group by: State =
- Default web Site e = [ Patn [ state Edit Feature Permissions. .
E-fpel MESRESR e Disablad Revert To Inherited
(g | VibeResources2
CGI-exe ®.exe Disabled View OrderedList...
15APL-dl =dl Disabled © Hep
Online Help
Enabled
OPTIONSVerbHandler Enabled
TRACEVerbHandler Enabled
StaticFile Enabled
| i

Configuration: 'Default Web Site VibeResources ' web.canfig

9

8 In the Actions pane, click Edit Feature Permissions.

The Edit Feature Permissions dialog box is displayed.

Edit Feature Permissions

Permissions:

2|

v Read
¥ script

i Execute

x|

Cancel

9 Select Execute, then click OK.

10 Repeat Step 7 through Step 9 for the VibeResources2 virtual directory.
11 In the Connections pane, select Default Web Site, then double-click ISAPI Filters.

12 In the Actions panel, click Add.
The Add ISAPI Filter dialog box is displayed.
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Add ISAPI Filter e |
Filter name:

Executable:

| ]

Ok I Cancel

13 In the dialog box, specify the following information:
Filter name: VibeResourcesl.
You must name the filter VibeResourcesl for Windows Authentication to work successfully.

Executable: C:\Program Files\Novell\Vibe IIS
Plugin\resourcesl\bin\isapi redirect.dll.

14 Click OK.
15 Repeat Step 12 through Step 14 to add another ISAPI filter.
This time, specify the following information in the Add ISAPI Filter dialog box:
Filter name: VibeResources2.
You must name the filter VibeResources2 for Windows Authentication to work successfully.

Executable: C: \Program Files\Novell\Vibe IIS
Plugin\resources2\bin\isapi redirect.dll.

16 In the Connections pane, select the server, then double-click ISAPI and CGI Restrictions.
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1!E Internet Information Services (IIS) Manager

—loj x|

€3] EEEEE

[ - B e~

File  view Help

€-iH|7 8

& Start Page

Eiij PEN (LPTEAMING \administrator)
|2} Application Poals

Sites

B4 Default Web Site

] VibeResources1

[ VibeResources2

G;l ISAPI and CGI Restrictions
L

Use this feature to specify the ISAPI and CGI extensions that can run on the
Web server,

Group by: Mo Grouping <

Description =+ I Restriction I Path

TeamingResourc... Allowed C:'\Program Files\Novell\Teamir

TeamingResourc... Allowed C:'\Program Files\Movell\Teamir
l | 2

] | »

Configuration: localhost’ applicationHost. config

17 In the Actions pane, click Add.

The Add ISAPI or CGI Restriction dialog box is displayed.

Add ISAPI or CGI Restriction

ISAPI or CGI path:

2 x

Description:

L

|_ Allow extension path to execute

o ]

Cancel

18 In the dialog box, specify the following information:

ISAPI or CGI path: Specify C:\Program Files\Novell\Vibe IIS
Plugin\resourcesl\bin\isapi redirect.dll.

Description: VibeResourcesl.

Add...

Edit Feature Settings...

@ Help

Online Help

ia51.:5

Allow extension path to execute: Select this option to allow the path to execute.

19 In the Actions pane, click Add.

The Add ISAPI or CGI Restriction dialog box is displayed.
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9.9.4

9.9.5

ISAPI or CGI path:

|| ]

Description:

[T allow extension path to execute

oK I Cancel

20 In the dialog box, specify the following information:

ISAPI or CGI path: Specify C:\Program Files\Novell\Vibe IIS
Plugin\resources2\bin\isapi redirect.dll.

Description: VibeResources?2.

Allow extension path to execute: Select this option to allow the path to execute.
21 In the Connections pane, select VibeResources1, then double-click Authentication.
22 Select Anonymous Authentication, then click Disable in the Actions panel.
23 Select Windows Authentication, then click Enable in the Actions panel.
24 Exit the Internet Information Services Manager.

25 Perform the Advanced installation as described in Chapter 10, “Performing an Advanced Vibe
Installation,” on page 105.

Running the Vibe Installation Program

See “Choosing Windows Authentication” on page 34 for information about how to configure the
Vibe installation program to support Windows Authentication, then follow the instructions for the
advanced installation as described in Chapter 10, “Performing an Advanced Vibe Installation,” on
page 105. Return here and continue with additional configuration steps.

Configuring Your Browser to Allow Access to the Vibe Site

After Windows Authentication has been enabled on the server, you need to configure the client
browser to allow access to the Vibe site.
¢ “Internet Explorer” on page 98

¢ “Firefox” on page 99

Internet Explorer

1 In an Internet Explorer window;, click Tools > Internet Options.
The Internet Options dialog box is displayed.

2 Click the Security tab, select Local intranet, then click Sites.
The Local Intranet dialog box is displayed.

3 Click Advanced.
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4 In the Add this website to the zone field, specify the Vibe Web site.
5 Click Add > Close.

Firefox

1 In Firefox, specify about : config in the URL field.

2 Specify nt1lmin the Filter window, then locate and select the network.automatic-ntlm-auth.trusted-
uris entry.

The Enter String Value dialog box is displayed.
3 Specify the DNS name of your Vibe site, then click OK.
For example, vibe.mycompany . com.

4 Repeat Step 2 through Step 3 for network.negotiate-auth.trusted-uris and network.negotiate-
auth.delegation-uris.

9.9.6 Bypassing Windows Authentication to Configure LDAP and Perform
Other Tasks

After Windows Authentication is working on your Vibe server, you can bypass the Windows
Authentication functionality by including the Vibe listening port in the Vibe URL.

You need to do this in order to configure your LDAP directory.

1 In a Web browser, specify your Vibe URL with the Vibe listening port.
For example, http://vibe:8080.
The Vibe login page is displayed.

Novell. Vibe

User ID:

Password:

2 Log in to the Vibe site as the Vibe administrator.

3 Configure LDAP, as described in Section 5.3, “Adding Vibe Users from Your LDAP Directory,”
on page 66.

You might also need to bypass Windows Authentication to access Vibe for the following reasons:

¢ To access a specific Vibe node in a clustered environment.

¢ To troubleshoot the Vibe system.

9.9.7 Logging In to the Vibe Site through Windows Authentication

After you have performed the configuration steps described in Section 9.9.3, “Configuring the Vibe
Server to Support Windows Authentication,” on page 92 through Section 9.9.5, “Configuring Your
Browser to Allow Access to the Vibe Site,” on page 98, users can access the Vibe site through
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9.9.8

Windows Authentication. Users who have been configured through LDAP and are already logged in
to their individual workstations do not need to log in again to access the Vibe site. Users who are not
already logged in before they access Vibe see the following dialog box:

5I

0 Enter username and password for http://13.6.7.31

User Name: I

Password: I LTIy

Ok I Cancel |

Editing Files through WebDAV with Windows Authentication

¢ “Achieving Single Sign-On When Editing Files through WebDAV” on page 100
¢ “Enabling Basic Authentication for WebDAV” on page 100

Achieving Single Sign-On When Editing Files through WebDAV

By default, when you edit a file in Vibe through WebDAYV, you are prompted for your system login
credentials before you can edit the file. However, when Windows Authentication is enabled on your
Vibe server, you are no longer prompted for your system login credentials before you edit a file
through WebDAV.

This functionality is supported only when you use Microsoft Office as your default document editor.
When you use OpenOffice 3.1 or later as your default document editor, Vibe allows you to edit files
through WebDAYV, but it still requires you to enter your system login credentials. The single sign-on
experience is only available when you use Microsoft Office.

Enabling Basic Authentication for WebDAV

If you are using OpenOffice 3.0 or earlier, or any other document editor that requires basic
authentication (it does not support Windows Authentication), you need to configure your IIS server
to support basic authentication. Supporting basic authentication enables Vibe users to edit files
through WebDAV when using a document editor other than Microsoft Office or OpenOffice 3.1 or
later.

NOTE: If you enable basic authentication on your IIS server, all users who access the Vibe site
through Firefox are prompted for their login credentials. Single sign-on to the Vibe server no longer
functions. However, users who access the Vibe site using Internet Explorer retain the single sign-on
experience.

To enable basic authentication on your IIS server, you need to install the Basic Authentication Role
Service.
1 On the Windows 2008 server, click Start > Administrative Tools > Server Manager.
2 Expand Roles, then right-click Web Server (I1S).
3 Click Add Role Services.
The Add Role Services window is displayed.
4 Scroll to the Security section, then select Basic Authentication.

5 Click Next, then complete the installation.
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6 Click Start > Administrative Tools > Internet Information Services (11S) Manager.

7 In the Connections pane on the left side of the window, expand your server, expand Sites, then
expand Default Web Site.

8 Select VibeResources1, then double-click Authentication.
9 Select Basic Authentication, then click Enable in the Actions panel.

10 Close the Internet Information Services (IIS) Manager.

9.9.9 Configuring lIS to Load Balance in a Clustered Environment

If you have Vibe installed in a clustered environment where there are multiple Vibe nodes, you can
configure IIS to balance the load of user requests from the multiple Vibe nodes, while still supporting
Windows Authentication.

1 On the IIS server, locate the C: \Program Files\Novell\Vibe IIS
Plugin\conf\workers.properties.clustered.template file, then open the file in a text
editor.

2 Copy the contents of the file.

3 Locate the C:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties file,
then open the file in a text editor.

4 Paste the contents of the C:\Program Files\Novell\Vibe IIS
Plugin\conf\workers.properties.clustered. template that you copied in Step 2 and into
the C:\Program Files\Novell\Vibe IIS Plugin\conf\workers.properties file,
overwriting the content that was previously there.

5 Replace the value of worker.worker1.host from first_hostname_or_ip with the hostname or IP
address of your first Vibe node.

6 Repeat Step 5 for each additional Vibe node that is running in your environment. If you have
more than two Vibe nodes, you should add an additional section to the workers.properties
file for each additional node.

The values that you specify in the workers.properties file (for example, workerl, worker2,
etc.) must exactly match the values that you specify as the JVM Route setting during the Vibe
installation, as described in Section 15.2, “Installing the Vibe Software on Multiple Servers,” on
page 126.

7 Locate the C:\Program Files\Novell\Vibe IIS
Plugin\resourcesl\conf\uriworkermap.properties file, then open the file in a text editor.

8 Replace all instances of workerl with balancer.
9 Repeat Step 7 and Step 8 for each Vibe node.

10 Locate the C:\Program Files\Novell\Vibe IIS
Plugin\resources2\conf\uriworkermap.properties file, then open the file in a text editor.

11 Replace all instances of worker1l with balancer.
12 Repeat Step 10 and Step 11 for each Vibe node.
13 Restart each Vibe node.
14 Restart the IIS server:
14a Click Start > Administrative Tools > Internet Information Services (IIS) Manager.

14b Select your server in the Connections panel, then click Restart in the Actions panel.
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9.10

9.10.1

9.10.2

Configuring Mirrored Folder Resource Drivers

A mirrored folder is a directory, either local or shared on a SAN (storage area network), that is
directly accessible from the Novell Vibe site. The files on the file system are accessed by the Novell
Vibe program through a resource driver, not directly by individual Vibe users. A resource driver
defines how the Vibe program accesses the file system.

During installation, you define the users and groups that can access the mirrored folder resource
drivers. After installation, from the Vibe site, you associate resource drivers with specific Vibe folders
and use folder access controls to govern which users and groups can access the data in the mirrored
folder. As a result, you can set up a small number of users who can create mirrored folders, and allow
a larger number of users to access the mirrored folders.

Vibe attempts to keep the metadata about each mirrored folder synchronized with the contents of the
actual file system. Therefore, mirrored folders are most appropriate for large sets of relatively static
data. Mirrored folders are also useful for making extremely large files available from your Vibe site
without including them in the Vibe file repository.

Although the installation program allows you to set up three mirrored folder resource drivers during
installation, you can set up and test just one to start with, then set up additional resource drivers later.
¢ Section 9.10.1, “File System Type,” on page 102
¢ Section 9.10.2, “File System Directory,” on page 102
¢ Section 9.10.3, “File System Access,” on page 103
¢ Section 9.10.4, “Mirrored Folder Setup,” on page 103
After planning mirrored folders, complete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 10, “Performing
an Advanced Vibe Installation,” on page 105.

File System Type

Vibe provides resource drivers for two different types of file systems:

+ file: A directory in a regular file system on a Linux or Windows server.

+ webdav: A directory on a Web server that supports WebDAV (Web-based Distributed
Authoring and Versioning). The WebDAV server must support HTTP Basic Authentication
(http://en.wikipedia.org/wiki/Basic_access_authentication) so that Vibe can provide a username
and a password when making a request from the WebDAV server.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, mark the type of directory that you want to mirror
in your Vibe site.

File System Directory

The file system that a Vibe mirrored folder uses can be on Linux, NetWare, or Windows, as long as
the following conditions are met:

¢ The file system is accessible from the Vibe server by using a directory path specification that the
Vibe server operating system understands.

¢ The file system is accessible through the standard java.io package interface.
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9.10.3

9.10.4

9.11

IMPORTANT: On Windows, you must use forward slashes (/) in the pathname, not the typical
Windows backslashes (\). For example, use c: /Documents rather than c: \Documents.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, specify the full path for the directory that you want
to mirror in your Vibe site. Also, provide a title for the mirrored folder resource driver that indicates what

directory or data is being mirrored. For WebDAV mirrored folders, you must also specify the URL of the

WebDAV host where the data is located.

If you need to eventually set up more than three directories as mirrored folders in your Vibe site, you
can edit the installer.xml file in the directory where you run the Installation program.

File System Access

Vibe offers several security options for controlling access to the data that resides on the file system.
¢ You can restrict the Vibe program to read-only access to the mirrored data, or you can allow full
read/write access.

¢ You can list specific Vibe users who are allowed to access the mirrored folder resource drivers
and thereby create mirrored folders.

* You can list specific Vibe groups whose members are allowed to access the mirrored folder
resource drivers and thereby create mirrored folders.

¢ For WebDAYV mirrored folder resource drivers, you must also specify a username and password
that the Vibe program can use to access the WebDAYV server.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, list the file access (read/write or read-only) for the
mirrored data, along with users and groups that you want to have access to the resource driver. For a
WebDAV mirrored folder, list a username and password that provides access to the WebDAV server.

Mirrored Folder Setup
After you run the Vibe Installation program to configure the Vibe site for mirrored folder resource

drivers, additional folder setup is required. Follow the instructions in “Setting Up Mirrored Folders”
in “Site Setup” in the Novell Vibe 3.2 Administration Guide.

Installing the Vibe Software in a Clustered Environment

You must use an Advanced installation in order to install the Novell Vibe software on multiple
servers and set up a clustered environment. Setting up multiple Vibe servers, along with other
clustering options, are described in Chapter 15, “Running Vibe on Multiple Servers,” on page 125.
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Performing an Advanced Vibe
Installation

You should already have reviewed Chapter 3, “Planning a Basic Vibe Installation,” on page 25 and
filled out the Basic Vibe Installation Summary Sheet. You should also have reviewed Chapter 9,
“Planning an Advanced Vibe Installation,” on page 81 and filled out the Advanced Vibe Installation
Summary Sheet for those aspects of an Advanced installation that you want to implement for your
Novell Vibe site.

1 Follow the Basic installation instructions provided in Chapter 4, “Installing and Setting Up a
Basic Vibe Site,” on page 49 for the platform where you are installing Vibe.

2 When you run the installation program, select Advanced on the Choose Installation Type page.

3 Use the information that you have gathered on the Basic Vibe Installation Summary Sheet and
the Advanced Vibe Installation Summary Sheet to provide the information that the Vibe
Installation program prompts you for:

Novell Vibe 3 Installation Program

Choose Installation Type

Select the type of installation you want to perform

Basic Select the Advanced installation if you want to cenfigure any

of the opticnal features.

Basic Installation Pages:

Installation Locations

Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe

User ID for Novell Vibe (Linux only)

Network Information

WebDAV Authentication Method

Database Selection

Java JDK Location

Outbound E-Mail Configuration

Inbound E-Mail Configuration

Some Basic installation pages have additional options available when you perform an Advanced
installation.

Advanced Installation Pages:

Web Services
Lucene Configuration
RSS Configuration
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Presence Configuration

Reverse Proxy Configuration

Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

The Installation program stores the information it gathers in the installer.xml file in the same
directory where you started the Installation program.

4 After you have provided all the requested information, click Install to begin the Advanced
installation.

5 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the installer.log file in the same
directory where you ran the Installation program. If a problem arises during the installation, the
installer.log file provides information that can help you resolve the problem.

6 After you complete the Advanced installation, continue setting up your Vibe site, as described in
Chapter 5, “Adding Users to Your Vibe Site,” on page 63.
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Setting Configuration Options after
Installation

After you install Novell Vibe, following the instructions in Part II, “Basic Installation,” on page 23 or
Part III, “Advanced Installation and Reconfiguration,” on page 79, you can rerun the Vibe installation
program to change configuration options or add new functionality to your Vibe site.

1 Stop Vibe.

2 Start the Vibe installation program as described in Section 4.1.2, “Running the Linux Vibe
Installation Program,” on page 51 and Section 4.2.2, “Running the Windows Vibe Installation
Program,” on page 59.

x| Novell Vibe 3 Installation Program - X |

Installation Options

Select the action you want to perform.

" New installation
" Update software and settings
« Reconfigure settings

Because the Installation program finds an existing installer.xml file, it defaults to Reconfigure
settings.

3 Click Next.
The Vibe Installation program asks you to verify that you have stopped Vibe.
4 Click Yes.

Novell'Vibe 3 Installation Program

Choose Installation Type

Select the type of installation you want to perform

Basic Select the Advanced installation if you want to configure any

of the optional features.

5 Select Basic or Advanced, depending on the configuration settings that you want to change, then
click Next.

6 Click Next until you reach an installation page where you want to reconfigure settings.
Basic Installation Pages:
Installation Locations

Location of TrueType Fonts for Stellent Converters
Default Locale for Novell Vibe
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User ID for Novell Vibe (Linux only)
Network Information

WebDAV Authentication Method
Database Selection

Java JDK Location

Outbound E-Mail Configuration
Inbound E-Mail Configuration

Advanced Installation Pages:

Web Services

Lucene Configuration

RSS Configuration

Presence Configuration

Reverse Proxy Configuration

Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

7 When you reach the Ready to Install page, click Install to implement the reconfigured settings.
8 Start Vibe.
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Advanced Vibe Installation Summary

Sheet

Installation Program Field Value for Your Vibe Site

Explanation

Data Locations:
Linux default:
/var/opt/novell/teaming
Windows default:
c:\Novell\Teaming

+ Simple file repository

¢ Jackrabbit repository

+ Extensions repository

* Cache store

¢ Lucene index

See Section 9.2, “Distributing
Different Data Types to Different
Locations,” on page 82.

Network Information:
+ Enable Web services:

No / Yes

¢ Session timeout
Default: 240 minutes

+ Enable Tomcat access log:
No / Yes

+ Keystore file:

See Section 9.3, “Using Advanced
Network Information Settings,” on
page 83.

WebDAV Authentication Method

* basic

+ digest

See Section 3.5, “Planning the
WebDAV Authentication Method,”
on page 32.

Web Services:

+ Enable WSS authentication
+ Enable Basic authentication

+ Enable token-based
authentication

+ Enable anonymous access

See Section 9.4, “Configuring Web
Services,” on page 84.
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Installation Program Field Value for Your Vibe Site

Explanation

Lucene Configuration:
Configuration type: all
¢ Max booleans:

Default: 20000
+ Merge factor:
10

See Section 9.5.2, “Changing
Lucene Configuration Settings,” on
page 85.

Server Lucene Configuration:
Configuration type: server only

¢ Host:
+ RMI port:
Default: 1199

See Section 9.5.3, “Running the
Lucene Index Server in Its Own
JVM,” on page 86.

High Availability Lucene
Configuration:

Configuration type: high availability
only

Number of high availability search
nodes:

¢ Service name:
* Service title:
¢ Host:

+ RMI port:

* Service name:
* Service title:
¢ Host:

* RMI port:

See Chapter 16, “Running Multiple
Lucene Index Servers,” on
page 131.

RSS Configuration:

Enable RSS: No / Yes

+ Max elapsed days:

* Max inactive days:

See Section 9.6, “Managing RSS
Feeds,” on page 86.

Presence Configuration:
Enable presence: No / Yes

+ Server address:
+ Port:

* Server user:

+ Password:

+ Server Certificate:

See Section 9.7, “Configuring
Presence,” on page 87.
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Installation Program Field Value for Your Vibe Site

Explanation

Conferencing Configuration:

Enable Conferencing: No / Yes

¢ Conferencing URL:

See Section 9.7, “Configuring
Presence,” on page 87.

Reverse Proxy Configuration:
Enable Access Gateway: No / Yes

* Access Gateway address(es):
¢ Logout URL:

+ Use Access Gateway for
WebDav connections: No / Yes

* WebDAV Access Gateway
address:

See Section 9.8, “Configuring
Single Sign-On with Novell Access
Manager,” on page 88.

Integration with IIS for Windows
Authentication:

Enable Integration with 1IS for
Windows Authentication: No / Yes

+ |IS address(es):

* Logout URL:

See Section 9.9, “Configuring
Single Sign-On with Internet
Information Services for Windows,”
on page 89.

Mirrored Folder Resource Driver
Configuration:

Enable file share: No / Yes

¢ Share type
+ File
+ WebDav
+ Read only: No / Yes
+ Title
+ Root path
+ Allowed users
+ Allowed groups
¢ User
¢ Password

¢ Host URL

See Section 9.10, “Configuring
Mirrored Folder Resource Drivers,”
on page 102.
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I Multi-Server Configurations and
Clustering

¢ Chapter 13, “Creating the Vibe Database on a Remote Server,” on page 115

¢ Chapter 14, “Installing the Lucene Index Server on a Remote Server,” on page 121
¢ Chapter 15, “Running Vibe on Multiple Servers,” on page 125

¢ Chapter 16, “Running Multiple Lucene Index Servers,” on page 131

¢ Chapter 17, “Running Multiple Database Servers,” on page 149
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13.1

Creating the Vibe Database on a Remote
Server

The default database location for Novell Vibe is on the same server with the Vibe software, as
described in Section 3.6.3, “Database Location,” on page 35. However, for better performance and
scalability, you can install the database server (MySQL, Microsoft SQL, or Oracle) on a remote server,
then use the scripts that are included with the Vibe software to manually create the Vibe database in
any location that you prefer.

¢ Section 13.1, “Preparing to Manually Create a Database,” on page 115

¢ Section 13.2, “Creating a MySQL Database,” on page 116

¢ Section 13.3, “Creating a Microsoft SQL Database,” on page 117

¢ Section 13.4, “Creating an Oracle Database,” on page 118

¢ Section 13.5, “Installing Vibe with a Remote Database,” on page 119

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part II, “Basic Installation,” on
page 23 before attempting a more complex Vibe configuration.

Preparing to Manually Create a Database

Novell Vibe includes scripts for creating the Vibe database on a remote server.
1 Copy the teaming-3.1.n-sql.zip file from the Vibe server where the Vibe installation
program is located and copy it to the database server.
or
Download and unzip the Vibe software onto the database server.

2 In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the teaming-3.1.n-sql.zip file, unzip the teaming-3.1.n-
sql.zip file.

This creates two new subdirectories, the create subdirectory for database creation scripts and
the update-3.0.n-3.1.ndirectory for database update scripts.

3 Change to the create subdirectory.

4 Copy all the scripts for your database type to a convenient temporary location on the server
where you want to create the database, and make sure that your database management utility is
on your path so that you can run it from that directory
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13.2

116

5

Database Database Script Database Management Utility

MySQL *mysqgl.sqgl mysqgl
Microsoft SQL *sglserver.sql osqgl
Oracle *oracle.sql sglplus

Continue with the instructions for the type of database that you want to create:
¢ Section 13.2, “Creating a MySQL Database,” on page 116
¢ Section 13.3, “Creating a Microsoft SQL Database,” on page 117
¢ Section 13.4, “Creating an Oracle Database,” on page 118

Creating a MySQL Database

Before you begin, you should be familiar with standard database maintenance procedures.

For more information about MySQL, see the following references:

¢ MySQL 5.0 Reference Manual (http://dev.mysql.com/doc/refman/5.0/en)
¢ MySQL 5.1 Reference Manual (http://dev.mysql.com/doc/refman/5.1/en)

The following database tools can be helpful:

*
*

*

1

MySQL GUI Tools (http://dev.mysql.com/downloads/gui-tools)
SQLyog (http://www.webyog.com)
Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

Review the MySQL requirements listed in Section 2.1, “Vibe Server Requirements,” on page 17.

Make sure that the MySQL database server and client have been installed and configured, as
described in Section A.2, “MySQL Database Server,” on page 193.

Make sure that the MySQL database client is also installed on the Vibe server.

The Vibe installation program needs the MySQL client in order to communicate with the remote
MySQL database server.

Make sure that you know the password for the MySQL root administrator user.

5 Make sure that innodb support is enabled.

It is enabled by default. To verify that innodb support is enabled:

5a Enter the following command to access the MySQL monitor:
mysgl -u root -p

For information on how to set a password for your MySQL database if you have not already
done so, see “Configuring MySQL” on page 194.

5b Specify your password.

5¢ From the MySQL prompt, enter the following command to display status information
about the server’s storage engines:

SHOW ENGINES\G

5d Locate the InnoDB engine, and ensure that innodb support is enabled.
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13.3

6 Update the MySQL configuration file:
6a Locate the MySQL configuration file and open it in a text editor.

Linux: /etc/my.cnf

Windows: c¢:\Program Files\MySQL\MySQL Server version\my.ini

6b Under the [client] section, add the following line:

default character set = utfs

6c Under the [mysgld] section, add the following line:

character set server = utf8

Setting the character set to UTF-8 ensures that extended characters are handled correctly in

the database.

6d (Conditional) For a system with multiple network interfaces, in the [mysgld] section, add

the following line:

bind-address = mysgl server address

Replace mysql server address with the IP address that you want MySQL to bind to an
to listen on.

6e Save the updated configuration file, then exit the text editor.

7 In the directory where you copied the database scripts (Step 4 in Section 13.1, “Preparing to
Manually Create a Database,” on page 115), enter the following command to run the MySQL
database creation script:
mysql -uuser -ppassword < create-database-mysqgl.sql

8 Configure MySQL to allow access from a remote server:
mysqgl -uuser -ppassword
mysqgl> grant all privileges on *.*

-> to 'username'@'$%'
-> identified by 'password'
-> with grant option

-> ;

9 Skip to Section 13.5, “Installing Vibe with a Remote Database,” on page 119.

Creating a Microsoft SQL Database

Before you begin, you should be familiar with standard database maintenance procedures.
For more information about Microsoft SQL, see the following references:

¢ Microsoft SQL Server 2008 Learning Resources (http://www.microsoft.com/sqlserver/2008/en/
us/learning.aspx)

¢ Microsoft SQL Server 2005 Learning Resources (http://www.microsoft.com/sqlserver/2005/en/
us/learning-resources.aspx)

The following database tool can be helpful:

¢ Squirrel SQL Client (http://squirrel-sql.sourceforge.net)
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13.4

To create a Microsoft SQL database:
1 Review the Microsoft SQL requirements listed in Section 2.1, “Vibe Server Requirements,” on
page 17.
2 Make sure that the Microsoft SQL Server and Client have been installed and configured
properly.

IMPORTANT: Make sure that TCP/IP is enabled for the Microsoft SQL Server.

For more information, see “Microsoft SQL Server” (http://msdn.microsoft.com/en-us/library/
bb545450.aspx).

3 Make sure that the Microsoft SQL database client is also installed on the Vibe server.

The Vibe installation program needs the Microsoft SQL client in order to communicate with the
remote Microsoft SQL database server.

4 When you install Microsoft SQL Server, select SQL Server and Windows for authentication.
The default is Windows Only, which is not appropriate for Vibe.

5 Immediately establish the database administrator username and password for the SQL database
server.

6 Change to the directory where you copied the database scripts in Step 4 in Section 13.1,
“Preparing to Manually Create a Database,” on page 115.

7 Enter the following command to run the Microsoft SQL database creation script:

osgl -Uuser -Ppassword -i create-database-sglserver.sql

8 Skip to Section 13.5, “Installing Vibe with a Remote Database,” on page 119.

Creating an Oracle Database

When you use an Oracle database, your database administrator must create it for you. The Novell
Vibe installation program cannot create an Oracle database.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Creation, make sure you have marked that you want your database administrator to
manually create the Oracle database before installation.

Before you begin, you should be familiar with standard database maintenance procedures.
For more information about your Oracle database, see the following references:

¢ Oracle Product Documentation (http://www.oracle.com/technetwork/indexes/documentation/)

¢ Oracle SQL Plus Documentation (http://download.oracle.com/docs/cd/B19306_01/server.102/
b14357/toc.htm)

The following database tool can be helpful:
¢ Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

1 Review the Oracle database requirements listed in Section 2.1, “Vibe Server Requirements,” on
page 17.
2 Make sure that the Oracle database server software has been installed and configured properly.

For more information, see Oracle Database (http://www.oracle.com/database).
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3 Set up the Oracle database character set to support Unicode character encodings.

Vibe requires either the UTF-8 or AL32UTE8 character set for proper operation. Oracle
recommends AL32UTFS, because it has increased support for certain Asian languages. For more
information, see “Choosing a Character Set” (http://download.oracle.com/docs/cd/B19306_01/
server.102/b14225/ch2charset.htm) in the Oracle Database Globalization Support Guide.

4 Change to the directory where you copied the Oracle database scripts in Step 4 in Section 13.1,
“Preparing to Manually Create a Database,” on page 115.

5 Edit the create-database-oracle.sql script with your Oracle database password.
Original:
drop user sitescape cascade;
create user sitescape identified by sitescape;

grant connect, resource to sitescape;
connect sitescape/sitescape;

SiteScape is the name of the company that previously owned the Vibe software.
Updated:

drop user sitescape cascade;

create user sitescape identified by your oracle password;
grant connect, resource to sitescape;

connect sitescape/your oracle password;

IMPORTANT: Unless you are very familiar with editing scripts, change only the password. Do
not attempt to change the name of the database from the legacy default of sitescape.

6 Enter the following commands to run the database creation script:

sglplus "/ as sysdba"

SQL> spool create-database-oracle.out;
SQL> @create-database-oracle;

SQL> quit

7 Check the resulting create-database-oracle.out file for errors and resolve them.

8 If you created the Oracle database on the Vibe server, skip to Chapter 4, “Installing and Setting
Up a Basic Vibe Site,” on page 49 or Chapter 10, “Performing an Advanced Vibe Installation,” on
page 105.

IMPORTANT: On the Database Selection page in the Installation program, be sure to select
Database already exists or has already been created.

or

If you created the Oracle database on a remote server, continue with Installing Vibe with a
Remote Database.

13.5 Installing Vibe with a Remote Database

1 Run the Novell Vibe installation program, as described in Chapter 4, “Installing and Setting Up
a Basic Vibe Site,” on page 49 or Chapter 10, “Performing an Advanced Vibe Installation,” on
page 105.

2 Fill in the fields on the Database Selection page:
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Novell'Vibe 3 Installation Program

Database Selection

Select your database and set the database options.

The database server you select must already be installed.

Database type: |MySql j
JDBC URL: |jdbe:mysq://localhost:3306/sitescape?uselnicode=trusdcharacterEnc o

- Credentials

Usemame: |root

Password:

~Setup
" Create the database during installation
‘= Database already exists or has already been created

~Encryption algorithm

User passwords are encrypted using the selected algorithm:

Bl

Database type: Select the type of database that you just created.

JDBC URL: Replace localhost, with the hostname of the server where you created the Vibe
database. If needed, replace the port number with the port that Vibe uses to communicate with
the database, and replace the database name with the name of your database.

Credentials: Specify the password for the database administrator user.

Setup: Select Database already exists or has already been created so that the installation program
does not create one for you.

Encryption algorithm: Set the encryption appropriate for the security needs of the Vibe site. For
more information, see Section 3.6.5, “Database Encryption Algorithm,” on page 36.

3 Click Next.

The Vibe installation program tries to connect to the database. If it connects successfully, you can
continue with the installation. If the Vibe installation program cannot connect to the database,
you must resolve the problem with the database before you can continue with the Vibe
installation.

4 When the Vibe installation program can successfully connect to the remote database, continue as

usual with the installation.
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Installing the Lucene Index Server on a
Remote Server

You can install the Lucene Index Server on a different server from where Novell Vibe is running. If
the Lucene Index Server is already running on the same server as Vibe, you can move the Lucene
Index Server to a different server.

Running the Lucene Index Server on a remote server allows both the Lucene Index Server and the
Vibe server to have access to more server memory, disk space, and CPU resources.

Complete the following sections whether you are installing the Lucene Index Server on a remote
server, or moving the Lucene Index Server to a remote server.

IMPORTANT: The Vibe server and the Lucene Index Server must not have a firewall between them.
The RMI protocol used for the Lucene Index Server port works only within a trusted local area
network (LAN).

¢ Section 14.1, “Installing the Lucene Software,” on page 121
¢ Section 14.2, “Updating Your Vibe Site,” on page 123

¢ Section 14.3, “Managing a Remote Lucene Index Server,” on page 123

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part II, “Basic Installation,” on
page 23 before attempting a more complex Vibe configuration.

14.1 Installing the Lucene Software

1 Make sure that the Java Developer Kit (JDK) is installed on the remote server where you want to
install the Lucene Index Server.

You must use the same JDK that is being used on the server where Vibe is running. For example,
if you are using the IBM JDK on the server where Vibe is running, you must use the IBM JDK on
the remote Lucene Index Server.

For instructions, see Appendix A, “Vibe System Requirements Assistance,” on page 191.
2 Make sure that there is no firewall between the Vibe server and the Lucene Index Server.

3 Copy the Lucene installation program from its original location in the same directory with the
Vibe installation program to a convenient temporary directory on the remote server.

The filename for the Lucene Installation program varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe
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Change to the directory where you copied the Lucene installation program, then start it.
Accept the License Agreement, then click Next.
Select New installation, then click Next.

Browse to and select the directory where you want to install the Lucene Index Server, then click
Next.

The default location varies by platform:

Linux: /opt/novell/teaming/luceneserver

Windows: c:\Program Files\Novell\Teaming\luceneserver

Browse to and select the directory where you installed the JDK, then click Next.

Adjust the configuration of the Lucene Index Server, as described in Section 9.5, “Changing Your
Lucene Index Server Configuration,” on page 85, then click Next.

Click Install to install the Lucene software.
(Conditional) On Linux, deselect Start Lucene server.

You must edit the Lucene Index Server startup script before you start the Lucene Index Server.
Instructions are provided later in this procedure.

(Conditional) On Windows, if you do not want to start the Lucene Index Server immediately,
deselect Start Lucene server.

For instructions for starting and stopping the Lucene Index Server manually, see Section 14.3,
“Managing a Remote Lucene Index Server,” on page 123.

Click Finish.
(Conditional) On Linux:

14a Change to the following directory:

/opt/novell/teaming/luceneserver/indexserver/bin

14b Open the indexserver-startup.sh file in a text editor.

14c Add the following switch to the java launch command at the end of the script:

-Djava.rmi.server.hostname=ip address

Rename ip address with the IP address of the server where you installed the Lucene Index
Server.

14d Save the indexserver-startup.sh file, then exit the text editor.
14e Start the Lucene Index Server.

For instructions for starting and stopping the Lucene Index Server manually, see
Section 14.3, “Managing a Remote Lucene Index Server,” on page 123.

Moving the Lucene Index Server from the Vibe server to a remote server increases the scalability of
your Vibe system because the workload is distributed between two different physical servers.
However, in this configuration, the Lucene Index Server still runs on a single server. Your Vibe site
depends on the Lucene Index Server for full functionality. If that server goes down for some reason,
the Vibe site becomes inaccessible until access to the Lucene Index Server is restored. You can further
expand your Vibe system by setting up multiple Lucene Index Servers to provide high availability, as
described in Chapter 16, “Running Multiple Lucene Index Servers,” on page 131.

Novell Vibe 3.2 Installation Guide



14.2  Updating Your Vibe Site

14.3

14.3.1

Complete this section only if you are moving the Lucene Index Server. If you are performing a fresh
Lucene Index Server installation, disregard this section.

1 Stop Novell Vibe.
2 Start the Vibe installation program to reconfigure the Lucene Index Server settings.

For information on how to start the installation program, see Section 4.1.2, “Running the Linux

Vibe Installation Program,” on page 51 or Section 4.2.2, “Running the Windows Vibe Installation
Program,” on page 59.

3 On the Choose Installation Type page, select Advanced, then click Next.
4 Click Next until you reach the Lucene Configuration page.

Novell Vibe 3iInstallation Program

Lucene Configuration

Use the following fields to configure the Lucene index N

To run the Lucene index as a server, select Server from the drop-down list.
You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max booleans 10000
Merge factor |10

Lucene cenfiguration type: local j

=
s
——

5 In the Lucene configuration type field, select server to activate additional fields.
Host: Specify the hostname of the server where you installed the Lucene Index Server software.

RMI Port: Use the same port number that you used when you installed the Lucene Index Server
software. The default RMI port is 1199.

6 Click Next until you reach the Ready to Install page, then click Install.
7 When the installation is complete, click Finish.
8 Start Vibe.

Managing a Remote Lucene Index Server

¢ Section 14.3.1, “Linux: Managing a Remote Lucene Index Server,” on page 123

¢ Section 14.3.2, “Windows: Managing a Remote Lucene Index Server,” on page 124

Linux: Managing a Remote Lucene Index Server

Use the following commands to start and stop the Lucene Index Server manually:

/etc/init.d/indexserver start
/etc/init.d/indexserver stop

To configure the Lucene Index Server to start automatically when the Linux server reboots, use:

chkconfig --add indexserver
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14.3.2
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Windows: Managing a Remote Lucene Index Server

Use the following commands at a DOS command prompt to start and stop the Lucene Index Server
manually:

c¢:\Program Files\Novell\Teaming\luceneserver\indexserver\bin)\

indexserver-startup.bat

c¢:\Program Files\Novell\Teaming\luceneserver\indexserver\bin)\

indexserver-shutdown.bat

To configure the Lucene Index Server to start automatically when the Windows server reboots, you
can set it up as a scheduled task that runs at system startup.

1

0 N o O

On the Windows server where the Lucene Index Server is installed, click Start > All Programs >
Accessories > System Tools > Scheduled Tasks.

Double-click Add Scheduled Task. to open the Scheduled Task Wizard, then click Next to continue.
Click Browse, then browse to and double-click the indexserver-startup.bat file in the

following directory:

c:\Program Files\Novell\Teaming\luceneserver\indexserver\bin

In the Task name field, specify an informative name for the task, such as Lucene Index Server.
The default task name is the name of the batch file.

In the Perform this task field, select When my computer starts, then click Next.

Specify and confirm the Administrator password for the Windows server, then click Next.
Select Open advanced properties for this task when I click Finish, then click Finish.

Verify that Run only if logged on is deselected, then click OK.

A new task with the name you specified in Step 4 is added to the list in the Scheduled Tasks
window.

Click File > Exit to close the Scheduled Task Wizard.
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15.1

15.1.1

15.1.2

Running Vibe on Multiple Servers

By running Novell Vibe on multiple servers, you can achieve high availability, including failover and
load balancing, depending on how you configure your servers. You must perform an Advanced
installation on each server in order to configure the Vibe software for such a clustered environment.
¢ Section 15.1, “Planning a Multi-Server Vibe Configuration,” on page 125
¢ Section 15.2, “Installing the Vibe Software on Multiple Servers,” on page 126

¢ Section 15.3, “Configuring a Web Application to Provide High Availability Functionality for
Your Vibe Site,” on page 128

¢ Section 15.4, “Configuring Internet Information Services to Support Multiple Vibe Servers,” on
page 130

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommended that you follow the instructions in Part II, “Basic Installation,”
on page 23 before attempting a more complex Vibe configuration.

Planning a Multi-Server Vibe Configuration

¢ Section 15.1.1, “Lucene Index Server Considerations,” on page 125
¢ Section 15.1.2, “Vibe File Repository Considerations,” on page 125
¢ Section 15.1.3, “Configuring Routing for Multicast IP on the Vibe Server,” on page 126

Lucene Index Server Considerations

Before you can implement a multi-server Novell Vibe configuration, you must move your Lucene
Index Server away from the initial Vibe server, as described in Chapter 14, “Installing the Lucene
Index Server on a Remote Server,” on page 121.

Vibe File Repository Considerations

Before you implement a multi-server Novell Vibe configuration, you must plan the Vibe file
repository for the clustered Vibe servers. Your configuration must comply with the following
restrictions:

¢ The Vibe file repository must be placed in a shared location that is accessible to each Tomcat
instance.

¢ All Tomcat instances must be configured with the same path leading to the shared storage.

For background information on the contents of the Vibe file repository, see Section 9.2, “Distributing
Different Data Types to Different Locations,” on page 82.
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15.2
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Configuring Routing for Multicast IP on the Vibe Server

If you are planning to use ehcache as your hibernate caching provider, you might need to set up the
routing for multicast IP on each server where Vibe is installed. If this is not done, then depending on
your Vibe system, you might see a communication error when you start the Vibe server. For example,
in the log file you might see the following:

Error starting heartbeat. Error was: No such device.

To prevent this error, or to fix the Vibe system after the error occurs:

1 Run the following command:

route add -net 232.0.0.0/8 dev ethO

Installing the Vibe Software on Multiple Servers

1 Update your existing Novell Vibe server to participate in a multi-server configuration:

la
1b

1c
1d
le

1f

19

1h

1i

Stop Vibe.
Start the Vibe Installation program.

For information on how to start the installation program, see Section 4.1.2, “Running the
Linux Vibe Installation Program,” on page 51 or Section 4.2.2, “Running the Windows Vibe
Installation Program,” on page 59.

On the Installation Settings page, select Reconfigure Settings, then click Next.
On the Choose Installation Type page, select Advanced, then click Next.
Click Next to proceed through the installation pages where no changes are needed.

(Conditional) If you do not have the Basic Vibe Installation Summary Sheet and Advanced
Vibe Installation Summary Sheet from the initial Vibe server installation, record the
configuration of the initial Vibe server as you proceed through the installation pages.

Subsequent Vibe servers in the multi-server configuration must be installed with the same
configuration settings as the initial Vibe server.

On the Vibe Cluster Configuration page, select Enable clustered environment to enable
clustering.

On the first Vibe node, in the JVM Route field, specify worker1. On the second Vibe node, in
the JVM Route field, specify worker2, and so forth for each Vibe node, incrementing the
JVM Route setting. Each tomcat instance should have a unique JVM Route setting.

workerl, worker2, and so forth are the default names for the matching values used for the
reverse proxy configuration. For example, if you have set up Apache or IIS as a reverse
proxy, these are the default values. The JVM Route setting in the Vibe installer must match
these values.

Select one of the following options for your hibernate caching provider:

ecache: Ecache is recommended for small clustered Vibe sites, and is included in the Vibe
software. If you select this option, no further configuration is necessary. For more
information, see Ehcache (http://ehcache.sourceforge.net).

memcached: Memcached is recommended for medium to large clustered Vibe sites.
Memcached is not included in the Vibe software. If you select this option, you must
download and install memcached on each server in your Vibe cluster. For information
about downloading and installing memcached, see Memcached (http://
software.opensuse.org).
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1k

Depending on the cache provider you select, different options are displayed.

Hovell Vibe 3 Installation Program x|

Vibe Cluster Configuration

Select the checkbox to configure this Vibe installation to participate in a cluster, N

¥ Enable dustered emvironment
Hibernate caching provider: I ﬂ

Metwork interface for distributed cache service (Optional: IP address or hostname expected)

Hosthame: |

Multicast Group Address (Ip Address): |232.'I|.'I|. 1

Multicast Group Port: |+H-5

Novell Vibe 3 Installation Program x|

Vibe Cluster Configuration

Select the checkbox to configure this Vibe installation to participate in a cluster. N

[V Enable clustered environment

Hibernate caching provider: ﬂ

Enter a space delimited list of memcached instances in the format host:port
For example, 192.168.1,5:11211 192,168,1.7:11212

Server Addresses: |

(Conditional) If you selected ehcache as the hibernate caching provider in Step 1g, specify
the following information on the Vibe Cluster Configuration page to configure ehcache:

Network interface for distributed cache service: Specify the IP address or hostname of the
distributed cache service.

Multicast Group Address: (Optional) Specify the common multicast group IP address.
Each clustered node recognizes other nodes in the cluster by means of this IP address.

IMPORTANT: Make sure you specify the same IP address on all Vibe nodes in the cluster.
After you have set this IP address for each Vibe node, restart each node in succession,
allowing each node to initialize before restarting the next.

The default multicast group IP address is 232.0.0.1. If you have more than one clustered
Vibe system (for example, one in the lab and one in production), or if you have another
software product that is already using the default multicast group IP address, you must
update this field for one system so that it uses an IP address other than the default.

Use an IP address in the range of 224.0.0.1 to 239.255.255.255.

Multicast Group Port: (Optional) Specify the port number through which the Vibe nodes
will communicate.

(Conditional) If you selected memcached as the hibernate caching provider in Step 1g,
specify the following information on the Vibe Cluster Configuration page to configure
memcached:

Server Addresses: Specify a list of memcached servers, with each server separated by a
space. For example, hostnamel:port hostname2:port hostname3: port
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Memcached is not included in the Vibe software. If you select memcached as your hibernate
caching provider, you must download and install memcached on each server in your Vibe
cluster. For information about downloading and installing memcached, see Memcached
(software.opensuse.org).

11 On the Ready to Install page, click Install.
1m On the Installation Complete page, click Finish.

2 Install the Vibe software on each additional server, using the same installation settings that you
used for the initial Vibe server.

3 On each Linux server where you installed the Vibe software, set the multicast route to enable the
servers to function as a cluster:

3a Use the following command on the command line to immediately set the multicast route
for the server:

route add -net 232.0.0.0/8 dev etho

3b To run this command each time the server reboots, add the command to the following file
on each server:

/etc/init.d/boot.local

4 Start Vibe on each server, as described for the platform where you are installing Vibe:
¢ Section 4.1.7, “Starting Vibe on Linux,” on page 56
¢ Section 4.2.4, “Running Vibe as a Windows Service,” on page 61
¢ Section 4.2.5, “Running Vibe as a Windows Application,” on page 62

5 (Conditional) If you set up ehcache as the caching provider and the Vibe servers fail to start
because of a communication error, ensure that you have followed the steps in Section 15.1.3,
“Configuring Routing for Multicast IP on the Vibe Server,” on page 126.

6 Continue with Configuring a Web Application to Provide High Availability Functionality for
Your Vibe Site.

15.3 Configuring a Web Application to Provide High Availability
Functionality for Your Vibe Site

After Novell Vibe is installed and running on multiple servers, you must provide additional software
to provide high availability functionality. Because Vibe is based on Tomcat, you can use software that
provides high availability for Tomcat.

1 Install and configure one of the following Web applications to provide high availability for your
Vibe site:
¢ Apache Web server (http://www.apache.org)
¢ Linux Virtual Server (http://www.linuxvirtualserver.org)
¢ Novell Access Manager (https://www.netiq.com/products/access-manager/)
¢ Microsoft Internet Information Services (http://www.iis.net)

2 Configure the Web application to establish the Vibe site URL, which then stays constant for Vibe
users regardless of which Vibe server they access at any given time.

3 Start the Web application with its new configuration settings.
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15.3.1

4 Test your Vibe site for high availability.

¢ If you are using Apache Web server, Linux Virtual Services, or Microsoft Internet
Information Services, users can immediately log in to the Vibe site again after a failover has
occurred. The connection between the user’s browser and the Vibe site is maintained as the
failover occurs.

¢ If you are using Novell Access Manager, users must start a new browser session, then log in
to the Vibe site after a failover has occurred. They cannot log in again from the same
browser session because the connection between the user’s browser and the Vibe site must
be reestablished after the failover.

The following sections provide examples of how to configure the Web applications:

¢ Section 15.3.1, “Configuring Tomcat and Apache as a Load Balancer,” on page 129

¢ Section 15.3.2, “Configuring Linux Virtual Server as a Load Balancer,” on page 130

Configuring Tomcat and Apache as a Load Balancer

The following example configuration uses the balancer module built into the newer Apache (version
2.2.4 and later) Web server. It is based on a widely used sticky session technique. Novell Vibe does
not support session sharing/replication among Tomcat instances.

If you are using Novell Access Manager as described in Section 9.8, “Configuring Single Sign-On
with Novell Access Manager,” on page 88, you do not need to configure Tomcat and Apache to load
balance as described in this section, because Access Manager provides this service.

NOTE: When you update your Vibe system, these settings are not preserved. You must redefine
these settings each time you update your Vibe system.

To configure Tomcat and Apache to load balance:

1 Install the Apache Web server (http://httpd.apache.org) on one server.
2 Edit the httpd. conf file in the Apache installation:
The httpd. conf file is located in the conf subdirectory in the Apache installation.

2a Locate and uncomment the following lines:

LoadModule proxy module modules/mod proxy.so
LoadModule proxy ajp module modules/mod proxy ajp.so
LoadModule proxy balancer module modules/mod proxy balancer.so

2b Append the following section to the httpd. conf file, providing a BalancerMember line for
each jvmRoute value in a Tomcat server.xml file.

<Location /balancer-managers
SetHandler balancer-manager
Order deny,allow
Deny from all
Allow from 127.0.0.1
</Location>
<Proxy balancer://cluster name>
BalancerMember ajp://vibe server 1:8009 route=workerl
BalancerMember ajp://vibe server 2:8009 route=worker2
</Proxy>
<Location />
ProxyPass balancer://cluster name/ stickysession=JSESSIONID
</Location>
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The values that you specify for the route setting (for example, worker1, worker2, etc.) must
exactly match the values that you specify as the JVM Route setting during the Vibe
installation, as described in Section 15.2, “Installing the Vibe Software on Multiple Servers,”
on page 126.

2c Save the httpd.conf file

3 Reconfigure each Vibe server in the cluster so that each server has the same hostname as the
Apache Web server.

For information on how to reconfigure your Vibe server, see Chapter 11, “Setting Configuration
Options after Installation,” on page 107.

4 Restart Tomcat and Apache.

TIP: For enhanced performance when using the Internet Explorer browser to access a Vibe system
that is using Apache as an SSL reverse-proxy server, change the Apache SSL exclusion regular
expression configuration from the following:

SetEnvIf User-Agent ".*MSIE.*" \
nokeepalive ssl-unclean-shutdown \
downgrade-1.0 force-response-1.0

to the following;:

SetEnvIf User-Agent ".*MSIE [1-5].*"
nokeepalive ssl-unclean-shutdown
downgrade-1.0 force-response-1.0

SetEnvIf User-Agent ".*MSIE [6-9].*"
ssl-unclean-shutdown

15.3.2  Configuring Linux Virtual Server as a Load Balancer

Consult the following online sources for instructions for setting up Linux Virtual Server as a load
balancer for your Novell Vibe site:

¢ The Linux Virtual Server Project (http://www.linuxvirtualserver.org)
¢ Linux Virtual Server (LVS) Project (http://www.austintek.com/LVS)

¢ Linux Virtual Server Tutorial (http://www.ultramonkey.org/papers/lvs_tutorial/html)

15.4  Configuring Internet Information Services to Support
Multiple Vibe Servers

You can configure Internet Information Services (IIS) to support multiple Novell Vibe servers. For
more information, see Section 9.9.9, “Configuring IIS to Load Balance in a Clustered Environment,”
on page 101.
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16.1

Running Multiple Lucene Index Servers

Your Novell Vibe site depends on the Lucene Index Server for full functionality. Different Lucene
configurations provide different levels of scalability and reliability.

You can install the Lucene Index Server on a different server from where Vibe is running so that both
programs have access to more server memory, disk space, and CPU resources. However, the Vibe
server and the Lucene Index Server must not have a firewall between them. The RMI protocol used
for the Lucene Index Server port works only within a trusted local area network (LAN).

¢ A Basic installation of Vibe places the Lucene Index Server on the same server where the Vibe
software is installed.

¢ To provide additional memory for the Lucene Index Server, you might already have configured
it to run in its own memory space, as described in Section 9.5.3, “Running the Lucene Index
Server in Its Own JVM,” on page 86.

¢ To provide additional disk space and memory for the Lucene Index Server, you might already
have moved it to a different server, as described in Chapter 14, “Installing the Lucene Index
Server on a Remote Server,” on page 121.

These configurations provide additional resources for the Lucene Index Server, but it is still a single
point of failure for your Vibe site. If the Lucene Index Server goes down, the Vibe site becomes
inaccessible until access to the Lucene Index Server is restored.

Running multiple Lucene Index Servers provides high availability functionality, so that if one Lucene
Index Server goes down, Vibe users can still access the Vibe site because other Lucene Index Servers
are still available.

¢ Section 16.1, “Planning a High Availability Lucene Configuration,” on page 131

¢ Section 16.2, “Setting Up a High Availability Lucene Configuration,” on page 132

¢ Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144

¢ Section 16.4, “Synchronizing a High Availability Lucene Configuration,” on page 146

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part II, “Basic Installation,” on
page 23 before attempting a more complex Vibe and Lucene configuration.

Planning a High Availability Lucene Configuration

A high availability Lucene Index Server configuration must include at least two different servers
(either physical or virtual), referred to as “nodes” in the Vibe installation program. Lucene nodes in a
high availability configuration can be set up on Linux servers, Windows servers, or both.

Each Lucene node must have its own independent directory structure for index files. The default
location for the index files for the Lucene Index Server varies by platform:
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16.2

16.2.1

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene

As you plan your high availability Lucene configuration, you can use the Advanced Vibe Installation
Summary Sheet to record the options you want to use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the number of Lucene nodes that you want in your
high availability Lucene configuration.

Each Lucene node needs a unique name, a descriptive title, and a static IP address. The name and title
identify the node in the Vibe administrative interface. Typically, the Lucene Index Server listens on
RMI port 1199 on its server, but you can configure it to use a different port number if the default port
number is already in use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the hame, description, IP address, and RMI port
number for each Lucene node.

If you have already accumulated index data on your initial Vibe server, you can choose to copy the
index files to the Lucene nodes, or you can reindex the Vibe site after the new Lucene nodes are
running. Depending on the amount of accumulated index data, reindexing can be a time-consuming
process.

The Vibe server and the Lucene nodes must not have a firewall between them. The RMI protocol used
for the Lucene Index Server port works only within a trusted local area network (LAN).

Setting Up a High Availability Lucene Configuration

*

Section 16.2.1, “Changing from a Local Lucene Index Server,” on page 132
¢ Section 16.2.2, “Changing from a Single Remote Lucene Index Server,” on page 135

¢ Section 16.2.3, “Expanding an Existing High Availability Lucene Configuration,” on page 138

*

Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site Down Time,” on
page 140

Changing from a Local Lucene Index Server

To change from a local Lucene Index Server running on the Novell Vibe server, you must install the
Lucene Index Server on two or more remote servers, then reconfigure Vibe for a high availability
Lucene configuration.
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NOTE: Although it is possible to use the Lucene Index Server on the Vibe server as one of the
“remote” Lucene nodes, this is not a recommended configuration. Consider it only if you are
restricted to two servers for your Vibe site.

1 Set up two or more Lucene nodes:

la Install the Lucene Index Server on each node, as described in Section 14.1, “Installing the
Lucene Software,” on page 121.

1b (Optional) Copy accumulated index data from the initial Lucene Index Server to each
additional Lucene node.

The default location for the index files varies by platform:

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene

1c Start the Lucene Index Server on each Lucene node, as described in Section 14.3, “Managing
a Remote Lucene Index Server,” on page 123.

2 Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 15,
“Running Vibe on Multiple Servers,” on page 125, stop Vibe on all servers, or follow the
instructions in Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site Down
Time,” on page 140.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields:
Lucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed and started the Lucene Index Server.

Novell Vibe 3 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index

To run the Lucene index as a server, select Server from the drop-down list.
You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI pert if the default port cannot be used.

Max booleans |10000
Merge factor |10
Lucene configuration type: high availability j

Number of high availability search nodes:

3e Click Next.
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3f On the Configure High Availability Search Nodes page, specify the configuration
information for each Lucene node from the Advanced Vibe Installation Summary Sheet that
you filled out in Section 16.1, “Planning a High Availability Lucene Configuration,” on
page 131, then click Next.

Novell'Vibe 3iInstallation Program

Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep' check box.

Enter the high availability service name, host name and edit the RMI Port if the default port cannot
be used.

rHigh Availability Search Node 1

v Keep Senvice name|LuceneUnux

Service title |Lucene on Linux

Host[172.16.5.2

RMI port 1199

rHigh Awvailability Search Node 2

v Keep Service namelLuceneWinduws

Service title |Lucene on Windows

Host |172.16.5.19

RMI port 1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

Help | < Back | Next > ‘ Cancel |

3g Click Next until you reach the Ready to Install page, then click Install.

3h On the Installation Complete page, click Finish.

3i Start Vibe.

3] (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:

4a Log in to the Vibe site as the Vibe administrator.

4b Click the Settings icon [EM in the upper right corner of the page, then click the
Administration Console icon E
4c Under Search Index, click Nodes.
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16.2.2

Lucene on Linux {lucenelinux)

Host 1721652
RMI port: 1199

User Mode Access
@ Read and Write
' Write Only
~' Mo Access

Enable Deferred Update Log
No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host: 172.16.5.19
RMI port: 1198

User Mode Access
' Read and Write
@ Write Only
~' Mo Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes, click Apply, then
click Close.

The new setting is put into effect immediately, so that users immediately have access to the
additional Lucene nodes.

5 Skip to Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144.

Changing from a Single Remote Lucene Index Server

To change from a single remote Lucene Index Server to a high availability configuration, you must
install the Lucene Index Server on one or more additional remote servers, then reconfigure Novell
Vibe for additional Lucene nodes.

1 Bring down your Vibe site:

la Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 15,
“Running Vibe on Multiple Servers,” on page 125, stop Vibe on all servers, or follow the
instructions in Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site
Down Time,” on page 140.

1b Make sure that the existing remote Lucene Index Server also stops.
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2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in
Section 14.1, “Installing the Lucene Software,” on page 121.

2b (Optional) Copy accumulated index data from the initial remote Lucene node to each
additional Lucene node.

The default location for the index files varies by platform:

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene

2c Start the Lucene Index Server on each Lucene node, as described in Section 14.3, “Managing
a Remote Lucene Index Server,” on page 123, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields:
Lucene configuration type: Change server to high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where
you have installed the Lucene Index Server.

Nowvell Vibe 3 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index

To run the Lucene index as a server, select Server from the drop-down list.
You can run Lucens as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannct be used.

Max booleans |10000
Merge factor |10

Lucene configuration type: high availability j

Number of high availability search nodes:

3e Click Next.

3f On the Configure High Availability Search Nodes page, specify the configuration
information for each Lucene node from the Advanced Vibe Installation Summary Sheet that
you filled out in Section 16.1, “Planning a High Availability Lucene Configuration,” on
page 131, then click Next.
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B8 Novell Vibe 3iInstallation Program - X
Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel.

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port if the default port cannot
be used

High Availability Search Nede 1
M Keep Senvice name|LuceneLinux

Service title |Lucene on Linux

Host |172.16.5.2

RMI port 1199

rHigh Availability Search Node 2
v Keep Senvice name|LuceneWind0ws

Service title |Lucene on Windows

Host [172.16.5.19

RMI port 1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

Movell Vibe 3.0.0 Installation Program

Help | < Back | Next = ‘ Cancel |

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:

4a Log in to the Vibe site as the Vibe administrator.
4b Click the Settings icon [C3M in the upper right corner of the page, then click the

Administration Console icon E
4c Under Search Index, click Nodes.

Lucene on Linux (lucenelinux)

Host 1721652
RMI port: 1199

User Mode Access
© Read and Write
Write Only
© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 17216 5.19
RMI port: 1199

User Mode Access
© Read and Write
Write Only
© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists
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By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to the
additional Lucene nodes.

5 Skip to Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144.

16.2.3  Expanding an Existing High Availability Lucene Configuration

138

After you have set up an initial high availability Lucene configuration, you can add additional
Lucene nodes at any time.
1 Bring down your Vibe site:
la Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 15,
“Running Vibe on Multiple Servers,” on page 125, stop Vibe on all servers, or follow the
instructions in Section 16.2.4, “Changing Your Lucene Configuration without Vibe Site
Down Time,” on page 140.

1b Stop all Lucene nodes, as described in Section 14.3, “Managing a Remote Lucene Index
Server,” on page 123.

2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in
Section 14.1, “Installing the Lucene Software,” on page 121.

2b (Optional) Copy accumulated index data from an existing Lucene node to each additional
Lucene node.

The default location for the index files varies by platform:

Linux: /var/opt/novell/teaming/lucene

Windows: c:\Novell\Teaming\lucene

2c Start the Lucene Index Server on each Lucene node, as described in Section 14.3, “Managing
a Remote Lucene Index Server,” on page 123, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for the additional Lucene nodes:
3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.

3d On the Lucene Configuration page, increase the number of nodes in the Number of high
availability search nodes field, then click Next.
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x| Novell Vibe 3 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index. N

To run the Lucene index as a server, select Server from the drop-down list.

Youcan run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI pert if the default port cannot be used.

Max booleans |10000
Merge facter |10

Lucene configuration type: high availability j
Number of high availability search nodes: |:|

3e On the Configure High Availability Search Nodes page, specify the configuration
information for each additional Lucene node, then click Next.

x| Novell Vibe 3'Installation/ Program - X
Configure High Availablity Search Nodes
Configure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep” check box.

Enter the high availability service name, host name and edit the RMI Port if the default port cannot
be used.

RMI port 1199 | N

~High Availability Search Node 2

¥ Keep Service namelLuceneWinduws

Service title |Lucene on Windows

Host |172.16.5.19

RMI port 1199

~High Availability Search Node 3

v Keep Service namel

Sewicetillel
Hasl|
RMI port 1199

If you need mere than 3 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3f Click Next until you reach the Ready to Install page, then click Install.

3g On the Installation Complete page, click Finish.

3h Start Vibe.

3i (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:

4a Log in to the Vibe site as the Vibe administrator.

4b Click the Settings icon [ElM in the upper right corner of the page, then click the
Administration Console icon E
4¢c Under Search Index, click Nodes.
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Lucene on Linux (lucenelinux)
Host 172.18.5.2
RMI port. 1199
User Mode Access
@ Read and Write
- Write Only
) No Access

Enable Deferred Update Log
Mo Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)
Host 172.18.5.19
RMI port. 1199
User Mode Access
) Read and Write
@ Write Only
) No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to the
additional Lucene nodes.

5 Skip to Section 16.3, “Testing Your Lucene High Availability Configuration,” on page 144.

16.2.4  Changing Your Lucene Configuration without Vibe Site Down Time
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Vibe site down time can be avoided only if you have installed the Vibe software on multiple servers,
as described in Chapter 15, “Running Vibe on Multiple Servers,” on page 125.

To change to a high availability Lucene configuration in a multiple Vibe server configuration:

1 Set up two or more Lucene nodes:

la Install the Lucene Index Server on each node, as described in Section 14.1, “Installing the
Lucene Software,” on page 121

1b Start the Lucene Index Server on each Lucene node, as described in Section 14.3, “Managing
a Remote Lucene Index Server,” on page 123.

2 Stop Vibe on one server.

The other Vibe servers remain in service for users and continue to communicate with the
original Lucene Index Server.

3 Run the Vibe installation program on the Vibe server that you stopped to configure it for
multiple Lucene Index Servers:

3a On the Installation Settings page, select Reconfigure Settings, then click Next.
3b On the Choose Installation Type page, select Advanced, then click Next.
3c Click Next to proceed through the installation pages where no changes are needed.

3d On the Lucene Configuration page, fill in the following fields.
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Lucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where

you have installed the Lucene Index Server.

B Novell Vibe 3 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index.

- X

N

To run the Lucene index as a server, select Server from the drop-down list.

remote machine.

Enter the host name and edit the RMI pert if the default port cannot be used.

Max booleans |10000

Merge factor |10
high availability =
Number of high availability search nodes: I:|

Lucene configuration type:

3e Click Next.

You can run Lucene as a server on the same machine where the Vibe software is installed or on a

3f On the Configure High Availability Search Nodes page, specify the configuration
information for each Lucene node from the Advanced Vibe Installation Summary Sheet that

you filled out in Section 16.1, “Planning a High Availability Lucene Configuration,” on

page 131, then click Next.

B8 Novell Vibe 3iInstallation Program
Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel.

Use the following fields to configure each high availability search node.

To remove one of the high available search nodes, unselect its "Keep" check box.
be used.

High Availability Search Nede 1

Enter the high availability service name, host name and edit the RMI Port if the default port cannot

¥ Keep Service namelLuceﬂeLinux

Service title |Lucene on Linux

Host |172.16.5.2

RMI port 1199

rHigh Availability Search Node 2

V¥ Keep Senvice name|LuceneWindnws

Service title |Lucene on Windows

Host [172.16.5.19

RMI port |1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nedes.

Help | <Back | Next> |

Cancel |

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.

4 Start the reconfigured Vibe server.

5 Access the reconfigured Vibe server and prevent access to the additional Lucene nodes:
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IMPORTANT: All Vibe servers must be reconfigured before any of them access the additional
Lucene nodes.

5a Log in to the reconfigured Vibe server as the Vibe administrator, using the server hostname
rather than your Vibe site URL.

5b Click the Settings icon [EM in the upper right corner of the page, then click the
Administration Console icon E
5¢ Under Search Index, click Nodes.

Lucene on Linux (lucenelinux)
Host: 172.16.5.2
RMi port: 1199
User Mode Access
@ Read and Write
2 Write Only
) No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 172.16.5.19
RMi part: 1199

User Mode Access
) Read and Write
@ Write Only
) No Access
Enable Deferred Update Log

No Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. When you set up a high availability Lucene configuration
without Vibe site down time, you need to prevent write access during the reconfiguration
process.

5d In the User Mode Access box, change Write Only to No Access for the additional Lucene
nodes.

5e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe server does not
communicate with the additional Lucene nodes.

6 Reconfigure the rest of the Vibe servers:
6a Stop each Vibe server.
6b Repeat Step 3 to configure each Vibe server for the additional Lucene nodes.
6c Start each reconfigured Vibe server.
7 Access the reconfigured Vibe site and allow write access to the additional Lucene nodes:

7a Log in to the reconfigured Vibe as the Vibe administrator.

7b Click the Settings icon [ElM in the upper right corner of the page, then click the
Administration Console icon E
7c¢ Under Search Index, click Nodes.
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Lucene on Linux {LuceneLinux)

Host172.16.5.19
RMI port: 1183

User Mode Access
@ Read and Write
O write Only
O No access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (LuceneWindows)

Host: 137.65.67 222
RMI port: 1133

User Mode Access
O Read and Witz
© write Only
@ NoAccess

Enable Deferred Update Log

No Deferred Update Log Record Exists

7d In the User Mode Access box, change No Access to Write Only for the additional Lucene
nodes.

7e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe servers can
now communicate with the additional Lucene nodes, although user access is still
disallowed.

8 Reindex the Vibe site, so that the additional Lucene nodes are updated with the same index data
that the original Lucene Index Server has:

8a On the Administration page, under Search Index, click Index.

Manage Search index [eliiyrEsia BTG

«» €

[”] ReIndex Everything

Select the Places to be Re-Indexed:
(Selecting a folder or workspace wil automatically index all folders and workspaces within it.)

O] -8 Home workspace

= i...@w Users and Groups
= +9 Clobal Workspaces
D B9 Personal Workspaces

D -ﬁnTeam Workspaces

Select the Nodes to Apply Re-Indexing to:

If re-indexing all or large part of the tree, itis strongly recommended to change the access mode of the node(s) to write-only before starting
re-indexing o that all read requests can go to the other unselected node(s) while re-indexing iz in progress. Atleast one node must allow
read-write at any given time. Once re-indexing is completed, change the access mode of the node(s) back to read-write so that search
requests can use them again

I Lucene on Linux (lucenelinux) - Read and Write, Deferred Update Log Enabled, No Deferred Update Log Record Exists
[Z] Lucene on Windows (lucenewindows) - Write Only, Deferred Update Log Enabled, No Deferred Update Log Record Exists

-« ©

8b On the Manage Search Index tab, select Re-Index Everything, so that the entire Vibe site is
reindexed.

8c Select the additional Lucene nodes, but do not select any previously existing nodes.
8d Click OK to start the indexing.
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16.3

Depending on the size of your Vibe site, reindexing can be a time-consuming process.
However, because one or more previously existing Lucene Index Servers are still servicing
the Vibe site, users are not affected by the reindexing process.

8e When the reindexing is completed, click Close.
9 Make the additional Lucene nodes available to Vibe users:

9a On the Administration page, under Search Index, click Nodes.

Lucene on Linux (lucenelinux)

Host: 172.16.5.2
RMi port: 1199

User Mode Access
@ Read and Write
Write Only
No Access

| Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 172.16.5.19
RMi part: 1199

User Mode Access
Read and Write
@ Write Only
No Access

| Enable Deferred Update Log

No Deferred Update Log Record Exists

9b In the User Mode Access box, change Write Access to Read and Write for the additional Lucene

nodes.

9c Click Apply, then click Close.

The new setting is put into effect immediately, so that Vibe users have additional Lucene
Index Servers available as they use the Vibe site.

Testing Your Lucene High Availability Configuration

When you first set up your high availability Lucene configuration, you can configure Novell Vibe to
write Lucene node information to the Tomcat log file so that you can observe the behavior of the
Lucene nodes. Then you can take nodes down and bring them up again to see the effect on your Vibe
site. This process helps you prepare for the situation where a Lucene node goes down unexpectedly
or you need to take one down on purpose, perhaps for maintenance.

¢ Section 16.3.1, “Configuring Vibe to Log Lucene Node Activity,” on page 145
¢ Section 16.3.2, “Observing Lucene Node Activity,” on page 145

NOTE: For background information about the Tomcat log file, see “Tomcat Log File” in “Site
Maintenance” in the Novell Vibe 3.2 Administration Guide.
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16.3.1 Configuring Vibe to Log Lucene Node Activity

By default, Vibe writes an error to the Tomcat log file whenever it cannot communicate with a Lucene
node. For testing purposes, you can change the logging level so that the Tomcat log file includes a
message for each time Vibe contacts a Lucene Index Server.

After observing and understanding the behavior, you should return the logging to normal levels.

1 Open the 1log4j.properties file in a text editor.

The location of the 1og4j . properties file varies by platform.

Linux: /opt/novell/teaming/apache-tomcat/webapps/ssf/WEB-INF

Windows: c:\Program Files\Novell\Teaming\apache-tomcat\
webapps\ssf\WEB-INF

2 Search for the following line:

#log4j.category.com.novell.teaming. search=DEBUG

3 Remove the pound sign (#) from the beginning of the line to activate the DEBUG logging level
for the Lucene Index Server.

The DEBUG logging level adds a message for each time Vibe contacts a Lucene Index.
4 Save the 1log4j.properties file, then exit the text editor.
5 Stop Vibe, then start Vibe to put the new logging level into effect.

16.3.2  Observing Lucene Node Activity

After changing the Vibe logging level to include Lucene node activity, you can monitor the Tomcat
log file to see which Lucene nodes Vibe is contacting.
1 Change to the directory where the Tomcat log file is located.

For background information about the Tomcat log file, see “Tomcat Log File” in “Site
Maintenance” in the Novell Vibe 3.2 Administration Guide.

2 On Linux, use the tail command to monitor the end of the Tomcat log file.
tail -f catalina.out
or

On Windows, download an equivalent command from the Internet in order to perform the
following steps.

For example, there is a command available at SourceForge.net (http://sourceforge.net/projects/
tailforwin32).

3 Perform some activities on the Vibe site to create new content.

For example, you could create a blog entry. The Tomcat log file shows that Vibe is contacting
each available Lucene Index Server in turn as it submits the new information for indexing.
Nodes are considered available if they are marked Read and Write in the User Mode Access box on
the Lucene Nodes page.

4 Bring down one of the Lucene nodes.

For example, you might reboot the Lucene server, stop the Lucene Index Server on the node, or
otherwise prevent Vibe from contacting the Lucene node.

5 Observe that the Tomcat log file displays an error when the Lucene node becomes unavailable.
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Perform some additional activities on the Vibe site that create new content.

You might notice a pause as Vibe tries to connect with the Lucene node that is no longer
available.

Observe that the Tomcat log file shows when normal Vibe processing has resumed without
access to the unavailable Lucene node.

8 Make the unavailable Lucene node available again.

9 Observe that the Tomcat log file indicates that Vibe has created a journal record on the Lucene

10

node that was temporarily unavailable.

The journal record contains the indexing operations that failed to take place while the Lucene
node was unavailable. Even though the Lucene node is back up, Vibe does not start accessing it
until it has been synchronized with the latest index information.

To synchronize the out-of-date Lucene node, follow the steps in Section 16.4, “Synchronizing a
High Availability Lucene Configuration,” on page 146.

After the out-of-date Lucene node has been synchronized, Vibe starts accessing it again.

If a situation arises where no Lucene node is marked Read and Write in the User Mode Access box on
the Lucene Nodes page, Vibe temporarily accesses the first node in the list that is set to Write Only. If
no nodes are set to Write Only or Read and Write, Vibe temporarily access the first node in the list, even
though it is set to No Access. This functionality is required because you cannot log in to the Vibe site
without access to a Lucene Index Server.

Synchronizing a High Availability Lucene Configuration

You should ensure that your Lucene node servers remain in sync with each other. Whenever a
Lucene node is down for a relatively short period of time (no more than one or two days), you can
synchronize it with other Lucene nodes whose index files are up-to-date.

1 Make sure that the out-of-date Lucene node is running reliably again.

Log in to the Novell Vibe site as the Vibe administrator.
Click the Settings icon [E3l in the upper right corner of the page, then click the Administration

Console icon E
Under Search Index, click Nodes.

Mo Defensed Update Log Record Exists

To repair the out-of-date Lucene node, select Apply Deferred Update Log Records to the Index, then
click Apply.
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The Deferred Update Log options disappear if the update is successful. If for some reason the
deferred update log records cannot be applied to the index, you can rebuild the index, as
described in “Rebuilding the Lucene Index” in “Site Maintenance” in the Novell Vibe 3.2
Administration Guide.

6 Click Close.
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Running Multiple Database Servers

Each of the three databases supported by Novell Vibe (MySQL, Microsoft SQL, and Oracle) has its
own approach to clustering the database server. Information about clustering database servers is
available on the Internet, for example:

+ MySQL Cluster (http://www.mysql.com/products/database/cluster)

¢ SQL Server Clustering (http://www.sql-server-performance.com/articles/clustering/
clustering_intro_p1l.aspx)

¢ Oracle Real Application Clusters (http://www.oracle.com/technology/products/database/
clustering)

NOTE: We highly recommend that you follow the instructions in Part II, “Basic Installation,” on
page 23 before attempting a more complex Vibe configuration.

Running Multiple Database Servers
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V Update

¢ Chapter 18, “What’s New in Novell Vibe 3.x,” on page 153

¢ Chapter 19, “Updating From Novell Vibe 3.1 to Novell Vibe 3.2,” on page 157

¢ Chapter 20, “Updating from Novell Vibe 3 to Novell Vibe 3.2,” on page 165

¢ Chapter 21, “Updating from Novell Vibe 3 to Novell Vibe 3.1,” on page 173

¢ Chapter 22, “Updating the Operating System Where Vibe Is Running,” on page 179

¢ Chapter 23, “Migrating Existing Novell Vibe Data into a New Vibe 3.2 System,” on page 181
¢ Chapter 24, “Migrating from SiteScape Forum or Other Collaboration Software,” on page 187
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18.1

18.2

What's New in Novell Vibe 3.x

Novell Vibe is the new name for the product formerly known as Novell Teaming. This section
describes new features that have been added to Novell Vibe 3.x.

¢ Section 18.1, “Vibe 3.x User Enhancements,” on page 153

¢ Section 18.2, “Vibe 3.x Installation Enhancements,” on page 153

¢ Section 18.3, “Vibe 3.x Administration Enhancements,” on page 153

Vibe 3.x User Enhancements

For a list of Novell Vibe enhancements and instructions for use, see:

+ “What’s New in Novell Vibe 3.x” in the Novell Vibe 3.2 User Guide
+ “What’s New in Vibe 3.x”in the Nowvell Vibe 3.2 Advanced User Guide

Vibe 3.x Installation Enhancements

¢ Support for memcached caching (v3.2): Memcached is a high-performance, distributed caching
system that is suitable for large clustered Vibe systems. For more information, see Section 15.2,
“Installing the Vibe Software on Multiple Servers,” on page 126.

¢ Support for Windows Authentication (v3.1): You can configure a single sign-on experience for
your users when you run Novell Vibe on a Windows server. For more information, see
Section 9.9, “Configuring Single Sign-On with Internet Information Services for Windows,” on
page 89.

18.3 Vibe 3.x Administration Enhancements

¢ Monitor the Vibe Site with JMX (3.2): You can now monitor your Vibe site through JMX. For
more information, see “Using JMX to Monitor the Vibe Site” in the Novell Vibe 3.2 Administration
Guide.

+ Disable User Accounts (v3.1): You can disable user accounts rather than delete them. For more
information, see “Disabling Vibe User Accounts” in the Nowvell Vibe 3.2 Administration Guide.

¢ E-Mail Report (v3.1): You can generate reports for all e-mail messages sent from and into the
Vibe site, as well as e-mail errors that have been encountered. For more information, see “E-Mail
Report” in the Nowvell Vibe 3.2 Administration Guide.

¢ Restricting User Access by IP Address (v3.1): You can restrict what information users can
access when they are outside your corporate firewall. For more information, see “Restricting
Access Rights of Users Outside the Firewall” in the Novell Vibe 3.2 Administration Guide.
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Workspace and Folder Data Quotas (3.1): You can limit the amount of information that can exist
in specific workspaces and folders. For more information, see “Managing Workspace and Folder
Data Quotas” in the Nowvell Vibe 3.2 Administration Guide.

Configuring Search Functionality (3.1): You can configure the settings for how items are
indexed and how searches are executed on the Vibe site. For more information, see
“Understanding and Configuring Search Functionality” in the Novell Vibe 3.2 Administration
Guide.

Site-Wide Brand: You can create a site-wide brand and manage users’ ability to create
individual brands on lower-level workspaces. For more information, see “Creating a Site-Wide
Brand” in the Novell Vibe 3.2 Administration Guide.

Default Home Page: You can set a default home page where all users are first taken when they
access the Novell Vibe site. You can create a separate default home page for visitors. For more
information, see “Setting a Default Home Page” in the Novell Vibe 3.2 Administration Guide.

User and Group Management: When you move or rename users and groups that are being
synchronized via LDAP, Vibe now recognizes the change and maintains the association between
the user or group that was moved or renamed and the LDAP server. For more information, see
“LDAP Attribute to Identify a User or Group” on page 43.

User Visibility: You can hide one set of users from another set of users. For example, you might
want to do this if your Vibe site has users from more than one company and you want users to
see only the users who belong to the same company. For more information, see “Restricting
Groups of Users from Seeing One Another” in the Novell Vibe 3.2 Administration Guide.

Integrations with Novell Messenger: Vibe 3 provides tight integrations with Novell Messenger,

which allows Vibe users to see who is currently online. Presence icons & are located next to
users’ names in folder entries.

Vibe administrators must configure Novell Messenger to work with Novell Vibe, as described in
“Integrating Messenger with Vibe” in the Novell Vibe 3.2 Administration Guide.

Expanded User Profile: The User Profile section in Vibe 3 has been expanded to rival other
professional knowledgebases such as LinkedIn. Now users can include more information to
share with their colleagues, such as education, qualifications, and competencies. For more
information, see “Modifying Your Profile” in the Novell Vibe 3.2 User Guide.

For information about how Vibe administrators can modify the information that is displayed in
the profile view, see “Customizing the Default User Profile View” in “Setting Up Users” Personal
Workspaces” in the Novell Vibe 3.2 Administration Guide.

If you have modified the User Profile definition for your Vibe site, these changes are not
displayed when you update to Vibe 3. To display these changes, complete the steps in
Section 21.4.1, “Resetting Your Definitions,” on page 177.

Profile Quick View Dialog Box: The Profile Quick View dialog box is displayed when users
click a user’s Presence icon &. It enables them to see information about that user, view the
user’s micro-blog or workspace, follow the user, and more.

For information about how Vibe administrators can modify the information that is displayed in
the Profile Quick View, see “Customizing the Default Profile Quick View” in the Nowvell Vibe 3.2
Administration Guide.

If you have modified the User Profile definition for your Vibe site, this dialog box is not
displayed when you update to Vibe 3. To display these changes, complete the steps in
Section 21.4.1, “Resetting Your Definitions,” on page 177.

Novell Vibe 3.2 Installation Guide



¢ Ability to Send Vibe Mail Messages from a Custom Address: You can configure Vibe to send
e-mail messages from a zone-specific or site-wide address. In previous versions of Vibe, when a
user sends an e-mail message from Vibe, the message can be shown only as being from that
specific user.

For more information, see “Configuring Vibe to Send E-Mail Messages and Notifications from a
Custom Address” in the Novell Vibe 3.2 Administration Guide.
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Updating From Novell Vibe 3.1 to Novell
Vibe 3.2

This section describes how to update to Novell Vibe 3.2 from Novell Vibe 3.1. If you are updating
from a version of Vibe prior to Vibe 3 (Vibe versions prior to Vibe 3 are called Novell Teaming), you
must first update to Vibe 3 before you can update to Vibe 3.1. For information on how to update to
Novell Vibe 3, see “Update” in the Novell Vibe OnPrem 3 Installation Guide (http://www.novell.com/
documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html).

After you update your Vibe system, make sure that you check on the Vibe download site where you
downloaded the Vibe software for any hot patches that might be available.

¢ Section 19.1, “Understanding the Update Process,” on page 157

¢ Section 19.2, “Updating a Single-Server System from Vibe 3.1 to Vibe 3.2,” on page 158

¢ Section 19.3, “Updating a Multiple-Server System from Vibe 3.1 to Vibe 3.2,” on page 160
¢ Section 19.4, “Performing Post-Update Tasks,” on page 162

19.1 Understanding the Update Process

When you update to Novell Vibe 3.2, each user who has used a previous version of Vibe must clear
his or her browser’s cache, regardless of which browser he or she is using. Not clearing the browser
cache results in Vibe not displaying correctly.

Ensure that you communicate this to each Vibe user in your system.

During the update from Novell Vibe 3.1 to Vibe 3.2, the following aspects of your Vibe system are
modified:

¢ The software is updated from Vibe 3.1 to Vibe 3.2.

¢ A backup copy of your existing Vibe 3.1 installation is created in the following directory:

Linux: /opt/novell/teaming/teaming-backup

Windows: C:\Program Files\Novell\Teaming\teaming-backup

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell
Teaming), the backup copy is located in the following directory:

Linux: /opt/icecore

Windows: C:\Program Files\icecore
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19.2 Updating a Single-Server System from Vibe 3.1 to Vibe 3.2

When you update a single-server Novell Vibe installation from Vibe 3.1 to Vibe 3.2, you need to
update the Vibe software and the Vibe database separately. You can update the software and
database in whichever order you prefer.

¢ Section 19.2.1, “Backing Up Vibe Data,” on page 158

¢ Section 19.2.2, “Updating the Vibe Database from 3.1 to 3.2,” on page 158

¢ Section 19.2.3, “Updating the Vibe Software,” on page 158

19.2.1 Backing Up Vibe Data

Make sure your Vibe data is backed up before you begin the update process. For information
regarding the data that needs to be backed up, see “Backing Up Vibe Data” in the Nowvell Vibe 3.2
Administration Guide.

19.2.2  Updating the Vibe Database from 3.1to 3.2

When updating to Vibe 3.2, The Vibe Installation program does not update the database as part of the
Vibe software update. Therefore, you must manually run the database update script after you have
stopped Vibe:

1 Make sure you have a current backup of your Vibe 3.1 system.

2 Stop Vibe.

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.1 system.

4 Change to the directory where the Vibe 3.2 installation program is located.
5 Unzip the teaming-3.2.n-sql.zip file to create the update-3.1.0-3.2.ndirectory

The update-3.1.0-3.2.ndirectory contains an update script for each type of database
(MySQL, Microsoft SQL, and Oracle).

6 Use the database utility for your database type to run the script:

MySQL: mysql -uusername -ppassword < /path/update-mysqgl.sqgl

Microsoft osqgl -Uusername -Ppassword -i update-sglserver.sqgl

SQL:
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.

Oracle: sglplus "/ as sysdba"

SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;

7 Continue with Section 19.2.3, “Updating the Vibe Software,” on page 158.

19.2.3  Updating the Vibe Software

1 Make sure you have a current backup of your Vibe 3.1 system.
2 Stop Vibe.
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11
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13
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Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.1 system.

Copy the installer.xml file from the directory where the Vibe 3.1 Installation program is
located to the directory where you have extracted the Vibe 3.2 software.

You must obtain a new license-key.xml file when upgrading to Vibe 3.2.

The installer.xml file provides default values when you run the Vibe 3.2 Installation
program.

Start the Vibe 3.2 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are updating Vibe:

¢ Section 4.1.2, “Running the Linux Vibe Installation Program,” on page 51
¢ Section 4.2.2, “Running the Windows Vibe Installation Program,” on page 59
Accept the License Agreement, then click Next.

Novell Vibe 3/ Installation Program)

Installation Options

Select the action you want to perform

" New installation
® Update scoftware and settings
" Reconfigure settings

Because you provided your Vibe 3.1 installer.xml file in the directory with the Vibe 3.2
installation program, the Update software and settings installation option is selected by default.

Click Next to continue.
Click Yes to let the Installation program know that you have stopped Vibe.

Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

Select Basic or Advanced, depending on the type of Vibe installation you are updating, then click
Next.

For more information about the differences between basic and advanced installations, see
Section 3.1, “What Is a Basic Vibe Installation?,” on page 25 and Section 9.1, “What Is an
Advanced Installation?,” on page 81.

Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 3.2 system.

Click Install when you are ready to perform the update.
Click Finish when the update is completed.

If you have not yet updated the Vibe database, complete Section 19.2.2, “Updating the Vibe
Database from 3.1 to 3.2,” on page 158 before you start Vibe.

Start Vibe 3.2 in the same way that you have been starting Vibe 3.1.

When you start Vibe for the first time after the update, it takes longer to start than usual because
data in the Vibe database must be updated before the Vibe site is ready to use.
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19.3

19.3.1

19.3.2

Updating a Multiple-Server System from Vibe 3.1 to Vibe 3.2

If your Novell Vibe 3.1 system is distributed across multiple servers, the Vibe 3.2 installation program
can update Vibe components on the Vibe server, but you must manually update any Vibe
components that you have placed on remote servers.

¢ Section 19.3.1, “Backing Up Vibe Data,” on page 160

¢ Section 19.3.2, “Manual Vibe Database Update,” on page 160

¢ Section 19.3.3, “Remote Lucene Index Server Update,” on page 161

Backing Up Vibe Data

Make sure your Vibe data is backed up before you begin the update process. For information
regarding the data that needs to be backed up, see “Backing Up Vibe Data” in the Nowvell Vibe 3.2
Administration Guide.

Manual Vibe Database Update

In order to update a database from Vibe 3.1 to 3.2, you must run the Vibe 3.2 database update script.

1 Stop Vibe.

2 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.1 system.

3 Change to the directory where the Vibe 3.1 installation program is located.
4 Unzip the teaming-3.2.n-sql.zip file to create the update-3.1.0-3.2.n directory

The update-3.1.0-3.2.ndirectory contains an update script for each type of database
(MySQL, Microsoft SQL, and Oracle).

5 Copy the script for your database type to the server where the Vibe database is located.

6 (Conditional) If you have multiple Oracle databases, you must edit the update-oracle.sql
script and add @database_name to the first line of the script. For example, connect sitescape/
sitescape@vibe.

7 Use the database client utility for your database type to run the script:

MySQL: mysqgl -uusername -ppassword < /path/update-mysqgl.sqgl

Microsoft osqgl -Uusername -Ppassword -1 update-sglserver.sqgl

SQL:
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.

Oracle: sglplus "/ as sysdba"

SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;

8 After you have updated the database from Vibe 3.1 to Vibe 3.2:
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If your Lucene Index Server is also on a remote server, continue with Section 19.3.3, “Remote
Lucene Index Server Update,” on page 161.

or

If all remaining components that need to be updated from Vibe 3.1 to Vibe 3.2 are on the Vibe
server, follow the instructions in Section 19.2, “Updating a Single-Server System from Vibe 3.1 to
Vibe 3.2,” on page 158.

19.3.3 Remote Lucene Index Server Update

In order to update your index from Novell Vibe 3.1 to Novell Vibe 3.2 when the Vibe installation
program cannot do it for you, you need to run the Remote Lucene Server installation program.

1 Stop Vibe.

2 Stop the Lucene Index Server.

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3.1 system.

4 Copy the Vibe 3.2 Remote Lucene Server Installation program from the directory where the Vibe
3.2 Installation program is located to a convenient directory on the server where the remote
Lucene Index Server is located.

The name of the Remote Lucene Server Installation program varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Start the Vibe 3.2 Remote Lucene Server installation program.
Accept the License Agreement, then click Next.
Select Update software and settings.

Click Next to continue.

© 00 N o O

Click Next to accept the installation location.

10 Click Next to accept the Java JDK location.

11 In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see Section 9.5.2, “Changing Lucene
Configuration Settings,” on page 85.

13 Click Install to install the updated Lucene Index Server software.
14 Click Finish when the update is completed.
15 Start the Lucene Index Server.

16 Now that all remote Vibe components have been updated, follow the instructions in
Section 19.2, “Updating a Single-Server System from Vibe 3.1 to Vibe 3.2,” on page 158.
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19.4

19.4.1

19.4.2

Performing Post-Update Tasks

After you start Novell Vibe 3.2, you can access your Vibe site as usual. However, you need to reset
some aspects of the interface before you allow users to access the updated site. The interface reset
affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

¢ Section 19.4.1, “Resetting Your Definitions,” on page 162

¢ Section 19.4.2, “Resetting the Search Index,” on page 162
¢ Section 19.4.3, “Resetting the Standard Templates,” on page 163

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced in Vibe 3.2. Some of these
enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the Vibe 3.2
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes
you have made in order to make it easier to reconstruct the definition after you reset it.

To reset your Vibe definitions:
1 Log in to the Vibe site as the Vibe administrator.

2 Click the Settings icon [E3M in the upper right corner of the page, then click the Administration
Console icon E
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.
6 Click OK.

Resetting the Search Index

Search functionality has been improved in Vibe 3.2. For optimal search performance, you need to re-
index the search index after you update to Vibe 3.2.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 16, “Running Multiple
Lucene Index Servers,” on page 131.

Depending on the size of your Vibe site, this can be a very time-consuming process.

¢ “Resetting a Single Search Index” on page 163
¢ “Resetting the Search Index with Multiple Index Servers” on page 163
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Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Settings icon [EJM in the upper right corner of the page, then click the Administration
Console icon E

3 In the Management section, click Search Index.

4 Select Re-Index Everything.

5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.

Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Settings icon [E3M in the upper right corner of the page, then click the Administration
Console icon E

In the Search Index section, click Index.

Select Re-Index Everything.

Select each node that you want to re-index.

Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

o 01~ W

A message notifies you when indexing is complete.

19.4.3 Resetting the Standard Templates

IMPORTANT: If you have manually customized any templates that are included with the Vibe
product, back up the files you have modified before performing the interface reset.

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Settings icon [E3M in the upper right corner of the page, then click the Administration
Console icon E

3 In the Management section, click Workspace and Folder Templates.
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Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically provide information on a
group of authors. Optionally, the blog folder can be configured so that a larger group can make comments on the entries posted by the original author

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestoook folder is a simple place that individuals can “sign.” indicating that they have visited a user's Personal Workspace. Visitors may also leave comme
workspace. Comments are displayed in reverse chronological order. A picture of the individual signing the guestbook is displayed with the comment. The guestbook is ust
Files - Afile folder is a place to putfiles. Comments or entire discussions can be posted about individual files. Additionally, the files can be automatically locked, edited-in-f
the file. A file folder can emulate 3 WebDAY server. This allows a userto add and delete files via any WebDAV client, such as the MS Windows File Manager.

Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - & micro-blog folder is a special folder that gets created automatically for each user. Itis intended to contain short text entries only. Each user can add micro-bl
page. While you can create multiple micro-blog folders, only the one that is created automatically will be accessed as the user's real micro-blog

Mirrored Files - A mirrored file folder is a special type of file folder where it uses a server file system directory as its file storage area instead of the normal Vibe repository.”
via normal file sharing mechanisms. Vibe attempts to keep its knowledoe about the folder contents in synch with whatever is in the directory. The mirrared folder feature ca

4 Click Reset.
5 Click OK to confirm, then click Close.

Your Vibe 3.2 site is now ready for use.

IMPORTANT: If Vibe users encounter problems displaying any pages on the Vibe site after the
update, simply have them clear the browser cache.
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20.1

Updating from Novell Vibe 3 to Novell
Vibe 3.2

This section describes how to update to Novell Vibe 3.2 from Novell Vibe 3. If you are updating from
a version of Vibe prior to Vibe 3 (Vibe versions prior to Vibe 3 are called Novell Teaming), you must
first update to Vibe 3 before you can update to Vibe 3.2. For information on how to update to Novell
Vibe 3, see “Update” in the Novell Vibe OnPrem 3 Installation Guide (http://www.novell.com/
documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html).

After you update your Vibe system, make sure that you check on the Vibe download site where you
downloaded the Vibe software for any hot patches that might be available.

¢ Section 20.1, “Understanding the Update Process,” on page 165

¢ Section 20.2, “Updating a Single-Server System from Vibe 3 to Vibe 3.2,” on page 166

¢ Section 20.3, “Updating a Multiple-Server System from Vibe 3 to Vibe 3.2,” on page 168
¢ Section 20.4, “Performing Post-Update Tasks,” on page 170

Understanding the Update Process

When you update to Novell Vibe 3.2, each user who has used a previous version of Vibe must clear
his or her browser’s cache, regardless of which browser he or she is using. Not clearing the browser
cache results in Vibe not displaying correctly.

Ensure that you communicate this to each Vibe user in your system.

During the update from Novell Vibe 3.1 to Vibe 3.2, the following aspects of your Vibe system are
modified:

¢ The software is updated from Vibe 3.1 to Vibe 3.2.

¢ A backup copy of your existing Vibe 3.1 installation is created in the following directory:

Linux: /opt/novell/teaming/teaming-backup

Windows: C:\Program Files\Novell\Teaming\teaming-backup

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell
Teaming), the backup copy is located in the following directory:

Linux: /opt/icecore

Windows: C:\Program Files\icecore
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20.2

20.2.1

20.2.2

Updating a Single-Server System from Vibe 3 to Vibe 3.2

When you update a single-server Novell Vibe installation from Vibe 3 to Vibe 3.2, you need to update
the Vibe software and the Vibe database separately. You can update the software and database in
whichever order you prefer.

¢ Section 20.2.1, “Backing Up Vibe Data,” on page 166

¢ Section 20.2.2, “Updating the Vibe Database,” on page 166

¢ Section 20.2.3, “Updating the Vibe Software,” on page 167

Backing Up Vibe Data

Make sure your Vibe data is backed up before you begin the update process. For information
regarding the data that needs to be backed up, see “Backing Up Vibe Data” in the Nowvell Vibe 3.2
Administration Guide.

Updating the Vibe Database

When updating to Vibe 3.2, The Vibe Installation program does not update the database as part of the
Vibe software update. Therefore, you must manually run the database update scripts after you have
stopped Vibe:

1 Make sure you have a current backup of your Vibe 3 system.

2 Stop Vibe.

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3 system.

4 Change to the directory where the Vibe 3.2 installation program is located.

5 Unzip the teaming-3.2.n-sql.zip file to create the update-3.0.0-3.1.0 and update-3.1.0-
3.2.ndirectories.

The update-3.0.0-3.1.0 and update-3.1.0-3.2.ndirectories contain update scripts for each
type of database (MySQL, Microsoft SQL, and Oracle).

6 Use the database utility for your database type to run the corresponding script for your database
from both the update-3.0.0-3.1.0 and update-3.1.0-3.2.n directories:

MySQL: mysql -uusername -ppassword < /path/update-mysqgl.sqgl

Microsoft osqgl -Uusername -Ppassword -i update-sglserver.sqgl

SQL:
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.

Oracle: sglplus "/ as sysdba"

SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;

NOTE: You must run each database update script in the correct order: first run the update script
for Vibe 3 to 3.1, then run the script for Vibe 3.1 to Vibe 3.2.

7 Continue with Section 19.2.3, “Updating the Vibe Software,” on page 158.
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20.2.3

Updating the Vibe Software

1 Make sure you have a current backup of your Vibe 3 system.

10

11

12
13
14

Stop Vibe.

Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3 system.

Copy the installer.xml file from the directory where the Vibe 3 Installation program is located
to the directory where you have extracted the Vibe 3.2 software.

You must obtain a new license-key.xml file when upgrading to Vibe 3.2.

The installer.xml file provides default values when you run the Vibe 3.2 Installation
program.

Start the Vibe 3.2 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are updating Vibe:

¢ Section 4.1.2, “Running the Linux Vibe Installation Program,” on page 51
¢ Section 4.2.2, “Running the Windows Vibe Installation Program,” on page 59
Accept the License Agreement, then click Next.

Novell Vibe 3 Installation Program)

Installation Options

Select the action you want to perform

" New installation
® Update software and settings
" Reconfigure settings

Because you provided your Vibe 3 installer.xml file in the directory with the Vibe 3.2
installation program, the Update software and settings installation option is selected by default.

Click Next to continue.
Click Yes to let the Installation program know that you have stopped Vibe.

Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

Select Basic or Advanced, depending on the type of Vibe installation you are updating, then click
Next.

For more information about the differences between basic and advanced installations, see
Section 3.1, “What Is a Basic Vibe Installation?,” on page 25 and Section 9.1, “What Is an
Advanced Installation?,” on page 81.

Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 3.2 system.

Click Install when you are ready to perform the update.
Click Finish when the update is completed.

If you have not yet updated the Vibe database, complete Section 19.2.2, “Updating the Vibe
Database from 3.1 to 3.2,” on page 158 before you start Vibe.
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20.3

20.3.1

20.3.2

15 Start Vibe 3.2 in the same way that you have been starting Vibe 3.

When you start Vibe for the first time after the update, it takes longer to start than usual because
data in the Vibe database must be updated before the Vibe site is ready to use.

Updating a Multiple-Server System from Vibe 3 to Vibe 3.2

If your Novell Vibe 3 system is distributed across multiple servers, the Vibe 3.2 installation program
can update Vibe components on the Vibe server, but you must manually update any Vibe
components that you have placed on remote servers.

¢ Section 20.3.1, “Backing Up Vibe Data,” on page 168

¢ Section 20.3.2, “Manual Vibe Database Update,” on page 168

¢ Section 20.3.3, “Remote Lucene Index Server Update,” on page 169

Backing Up Vibe Data

Make sure your Vibe data is backed up before you begin the update process. For information
regarding the data that needs to be backed up, see “Backing Up Vibe Data” in the Nowvell Vibe 3.2
Administration Guide.

Manual Vibe Database Update

In order to update a database from Vibe 3 to 3.2, you must run the Vibe 3.2 database update scripts.

1 Stop Vibe.

2 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3 system.

3 Change to the directory where the Vibe 3 installation program is located.

4 Unzip the teaming-3.2.n-sql.zip file to create the update-3.0.0-3.1.0 and update-3.1.0-
3.2.ndirectories.

The update-3.0.0-3.1.0 and update-3.1.0-3.2.ndirectories contain update scripts for each
type of database (MySQL, Microsoft SQL, and Oracle).

5 Copy the scripts for your database type to the server where the Vibe database is located.

6 (Conditional) If you have multiple Oracle databases, you must edit the update-oracle.sql
scripts in each directory and add @edatabase_name to the first line of the scripts. For example,
connect sitescape/sitescape@vibe.

7 Use the database utility for your database type to run the corresponding script for your database
from both the update-3.0.0-3.1.0 and update-3.1.0-3.2.n directories:

MySQL: mysql -uusername -ppassword < /path/update-mysqgl.sqgl

Microsoft osqgl -Uusername -Ppassword -i update-sqglserver.sqgl

SQL:
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.

Oracle: sglplus "/ as sysdba"

SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;

168 Novell Vibe 3.2 Installation Guide


http://www.microsoft.com/downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-27ed01cf6b02&displaylang=en

8 After you have updated the database from Vibe 3 to Vibe 3.2:

If your Lucene Index Server is also on a remote server, continue with Section 19.3.3, “Remote
Lucene Index Server Update,” on page 161.

or

If all remaining components that need to be updated from Vibe 3 to Vibe 3.2 are on the Vibe
server, follow the instructions in Section 20.2, “Updating a Single-Server System from Vibe 3 to
Vibe 3.2,” on page 166.

20.3.3 Remote Lucene Index Server Update

In order to update your index from Novell Vibe 3.0 to Novell Vibe 3.2 when the Vibe installation
program cannot do it for you, you need to run the Remote Lucene Server installation program.

1 Stop Vibe.

2 Stop the Lucene Index Server.

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3 system.

4 Copy the Vibe 3.2 Remote Lucene Server Installation program from the directory where the Vibe
3.2 Installation program is located to a convenient directory on the server where the remote
Lucene Index Server is located.

The name of the Remote Lucene Server Installation program varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Start the Vibe 3.2 Remote Lucene Server installation program.
Accept the License Agreement, then click Next.
Select Update software and settings.

Click Next to continue.
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Click Next to accept the installation location.

10 Click Next to accept the Java JDK location.

11 In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
12 Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see Section 9.5.2, “Changing Lucene
Configuration Settings,” on page 85.

13 Click Install to install the updated Lucene Index Server software.
14 Click Finish when the update is completed.
15 Start the Lucene Index Server.

16 Now that all remote Vibe components have been updated, follow the instructions in
Section 19.2, “Updating a Single-Server System from Vibe 3.1 to Vibe 3.2,” on page 158.
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20.4

20.4.1

20.4.2

Performing Post-Update Tasks

After you start Novell Vibe 3.2, you can access your Vibe site as usual. However, you need to reset
some aspects of the interface before you allow users to access the updated site. The interface reset
affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

¢ Section 20.4.1, “Resetting Your Definitions,” on page 170

¢ Section 20.4.2, “Resetting the Search Index,” on page 170
¢ Section 20.4.3, “Resetting the Standard Templates,” on page 171

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced in Vibe 3.2. Some of these
enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the Vibe 3.2
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes
you have made in order to make it easier to reconstruct the definition after you reset it.

To reset your Vibe definitions:
1 Log in to the Vibe site as the Vibe administrator.

2 Click the Settings icon [E3M in the upper right corner of the page, then click the Administration
Console icon E
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.
6 Click OK.

Resetting the Search Index

Search functionality has been improved in Vibe 3.2. For optimal search performance, you need to re-
index the search index after you update to Vibe 3.2.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 16, “Running Multiple
Lucene Index Servers,” on page 131.

Depending on the size of your Vibe site, this can be a very time-consuming process.

¢ “Resetting a Single Search Index” on page 171
¢ “Resetting the Search Index with Multiple Index Servers” on page 171
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Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Settings icon [EJM in the upper right corner of the page, then click the Administration
Console icon E

3 In the Management section, click Search Index.

4 Select Re-Index Everything.

5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.

Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Settings icon [E3M in the upper right corner of the page, then click the Administration
Console icon E

In the Search Index section, click Index.

Select Re-Index Everything.

Select each node that you want to re-index.

Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

o 01~ W

A message notifies you when indexing is complete.

20.4.3 Resetting the Standard Templates

IMPORTANT: If you have manually customized any templates that are included with the Vibe
product, back up the files you have modified before performing the interface reset.

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Settings icon [E3M in the upper right corner of the page, then click the Administration
Console icon E

3 In the Management section, click Workspace and Folder Templates.
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Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically provide information on a
group of authors. Optionally, the blog folder can be configured so that a larger group can make comments on the entries posted by the original author

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestoook folder is a simple place that individuals can “sign.” indicating that they have visited a user's Personal Workspace. Visitors may also leave comme
workspace. Comments are displayed in reverse chronological order. A picture of the individual signing the guestbook is displayed with the comment. The guestbook is ust
Files - Afile folder is a place to putfiles. Comments or entire discussions can be posted about individual files. Additionally, the files can be automatically locked, edited-in-f
the file. A file folder can emulate 3 WebDAY server. This allows a userto add and delete files via any WebDAV client, such as the MS Windows File Manager.

Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - & micro-blog folder is a special folder that gets created automatically for each user. Itis intended to contain short text entries only. Each user can add micro-bl
page. While you can create multiple micro-blog folders, only the one that is created automatically will be accessed as the user's real micro-blog

Mirrored Files - A mirrored file folder is a special type of file folder where it uses a server file system directory as its file storage area instead of the normal Vibe repository.”
via normal file sharing mechanisms. Vibe attempts to keep its knowledoe about the folder contents in synch with whatever is in the directory. The mirrared folder feature ca

4 Click Reset.
5 Click OK to confirm, then click Close.

Your Vibe 3.2 site is now ready for use.

IMPORTANT: If Vibe users encounter problems displaying any pages on the Vibe site after the
update, simply have them clear the browser cache.
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21.1

Updating from Novell Vibe 3 to Novell
Vibe 3.1

This section describes how to update to Novell Vibe 3.1 from Novell Vibe 3. If you are updating from
an earlier version of Novell Vibe (earlier versions of Novell Vibe are called Novell Teaming), you
must first update to Novell Vibe 3 before you can update to Novell Vibe 3.1. For information on how
to update to Novell Vibe 3, see “Update” in the Novell Vibe OnPrem 3 Installation Guide (http://
www.novell.com/documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html)

¢ Section 21.1, “Understanding the Update Process,” on page 173

¢ Section 21.2, “Updating a Single-Server System from Vibe 3 to Vibe 3.1,” on page 174

¢ Section 21.3, “Updating a Multiple-Server System from Vibe 3 to Vibe 3.1,” on page 175
¢ Section 21.4, “Performing Post-Update Tasks,” on page 177

Understanding the Update Process

When you update to Novell Vibe 3.1, each user who has used a previous version of Vibe must clear
his or her browser’s cache, regardless of which browser he or she is using. Not clearing the browser
cache results in Vibe not displaying correctly.

Ensure that you communicate this to each Vibe user in your system.

During the update from Novell Vibe 3 to Vibe 3.1, the following aspects of your Vibe system are
modified:

¢ The software is updated from Vibe 3 to Vibe 3.1.

¢ A backup copy of your existing Vibe 3 installation is created in the following directory:

Linux: /opt/novell/teaming/teaming-backup

Windows: C:\Program Files\Novell\Teaming\teaming-backup

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell
Teaming), the backup copy is located in the following directory:

Linux: /opt/icecore

Windows: C:\Program Files\icecore

Updating from Novell Vibe 3 to Novell Vibe 3.1 173


http://www.novell.com/documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html

21.2 Updating a Single-Server System from Vibe 3 to Vibe 3.1

174

When you update a single-server Novell Vibe installation from Vibe 3 to Vibe 3.1, the Vibe
Installation program can perform the entire update in a single process.

1
2
3

10

11

12

13

Make sure you have a current backup of your Vibe 3 system.
Stop Vibe.

Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3 system.

Copy the installer.xml file from the directory where the Vibe 3 Installation program is located
to the directory where you have extracted the Vibe 3.1 software.

You must obtain a new license-key.xml file when upgrading to Vibe 3.1.

The installer.xml file provides default values when you run the Vibe 3.1 Installation
program.

Start the Vibe 3.1 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are updating Vibe:

¢ Section 4.1.2, “Running the Linux Vibe Installation Program,” on page 51
¢ Section 4.2.2, “Running the Windows Vibe Installation Program,” on page 59
Accept the License Agreement, then click Next.

Novell Vibe 3/ Installation Program)

Installation Options

Select the action you want to perform

" New installation
® Update scoftware and settings
" Reconfigure settings

Because you provided your Vibe 3 installer.xml file in the directory with the Vibe 3.1
installation program, the Update software and settings installation option is selected by default.

Click Next to continue.
Click Yes to let the Installation program know that you have stopped Vibe.

Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

Select Basic or Advanced, depending on the type of Vibe installation you are updating, then click
Next.

For more information about the differences between basic and advanced installations, see
Section 3.1, “What Is a Basic Vibe Installation?,” on page 25 and Section 9.1, “What Is an
Advanced Installation?,” on page 81.

Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 3.1 system.

Click Install when you are ready to perform the update.

The Installation program might seem to pause at this point. It needs to update tables and
indexes in the Vibe database. If you have a large database, this process can be time-consuming.

Click Finish when the update is completed.
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21.2.1

21.3

21.3.1

14 Start Vibe 3.1 in the same way that you have been starting Vibe 3.

When you start Vibe for the first time after the update, it takes longer to start than usual because
data in the Vibe database must be updated before the Vibe site is ready to use.

Updating an Oracle Database from 3to 3.1

The Vibe Installation program can update MySQL and Microsoft SQL databases as part of the Vibe
software update, but it cannot update an Oracle database. Therefore, if you are using Oracle, you
must manually run the database update script after you have stopped Vibe:

1 Change to the directory where the Vibe 3.1 Installation program is located.

2 Unzip the teaming-3.1.n-sql.zip file to create the update-3.0.0-3.1.ndirectory

The update-3.0.0-3.1.ndirectory contains an update script for each type of database
(MySQL, Microsoft SQL, and Oracle).

3 Run the update-oracle.sql script to update the database structure.

sglplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle;
SQL>quit;

4 Return to Step 5 in Section 21.2, “Updating a Single-Server System from Vibe 3 to Vibe 3.1,” on
page 174.

Updating a Multiple-Server System from Vibe 3 to Vibe 3.1

If your Novell Vibe 3 system is distributed across multiple servers, the Vibe 3.1 installation program
can update Vibe components on the Vibe server, but you must manually update any Vibe
components that you have placed on remote servers.

¢ Section 21.3.1, “Manual Vibe Database Update,” on page 175

¢ Section 21.3.2, “Remote Lucene Index Server Update,” on page 176

Manual Vibe Database Update

In order to update a database from Vibe 3 to 3.1 when the Vibe installation program cannot do it for
you, you must run the Vibe 3.1 database update script.
1 Stop Vibe.

2 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3 system.

3 Change to the directory where the Vibe 3 installation program is located.
4 Unzip the teaming-3.1.n-sql.zip file to create the update-3.0.0-3.1.n directory

The update-3.0.0-3.1.ndirectory contains an update script for each type of database
(MySQL, Microsoft SQL, and Oracle).

5 Copy the script for your database type to the server where the Vibe database is located.
6 Use the database client utility for your database type to run the script:

MySQL: mysgl -uusername -ppassword < /path/update-mysgl.sgl
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21.3.2

176

Microsoft osqgl -Uusername -Ppassword -1 update-sglserver.sqgl

SQL:
You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85c-
27ed01cf6b02&displaylang=en) to update the database.

Oracle: sglplus "/ as sysdba"
SQL>spool update-oracle.out;
SQL>@update-oracle
SQL>quit;

After you have updated the database from Vibe 3 to Vibe 3.1:

If your Lucene Index Server is also on a remote server, continue with Section 21.3.2, “Remote
Lucene Index Server Update,” on page 176.

or

If all remaining components that need to be updated from Vibe 3 to Vibe 3.1 are on the Vibe
server, follow the instructions in Section 21.2, “Updating a Single-Server System from Vibe 3 to
Vibe 3.1,” on page 174.

Remote Lucene Index Server Update

In order to update your index from Novell Vibe 3 to Novell Vibe 3.1 when the Vibe installation
program cannot do it for you, you need to run the Remote Lucene Server installation program.

1
2
3
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10
11
12

13
14

Stop Vibe.
Stop the Lucene Index Server.

Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 3 system.

Copy the Vibe 3.1 Remote Lucene Server Installation program from the directory where the Vibe
3.1 Installation program is located to a convenient directory on the server where the remote
Lucene Index Server is located.

The name of the Remote Lucene Server Installation program varies by platform:

Linux: lucene-installer.linux

Windows: lucene-installer.exe

Start the Vibe 3.1 Remote Lucene Server installation program.

Accept the License Agreement, then click Next.

Select Update software and settings.

Click Next to continue.

Click Next to accept the installation location.

Click Next to accept the Java JDK location.

In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see Section 9.5.2, “Changing Lucene
Configuration Settings,” on page 85.

Click Install to install the updated Lucene Index Server software.

Click Finish when the update is completed.
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15 Start the Lucene Index Server.

16 Now that all remote Vibe components have been updated, follow the instructions in
Section 21.2, “Updating a Single-Server System from Vibe 3 to Vibe 3.1,” on page 174.

21.4  Performing Post-Update Tasks

After you start Novell Vibe 3.1, you can access your Vibe site as usual. However, you need to reset
some aspects of the interface before you allow users to access the updated site. The interface reset
affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

¢ Section 21.4.1, “Resetting Your Definitions,” on page 177

¢ Section 21.4.2, “Resetting the Search Index,” on page 177
¢ Section 21.4.3, “Resetting the Standard Templates,” on page 178

21.4.1 Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced in Vibe 3.1. Some of these
enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the Vibe 3.1
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes
you have made in order to make it easier to reconstruct the definition after you reset it.

To reset your Vibe definitions:

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Administration icon E in the upper right corner of the page.
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.
6 Click OK.

21.4.2 Resetting the Search Index

Search functionality has been improved in Vibe 3.1. For optimal search performance, you need to re-
index the search index after you update to Vibe 3.1.

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Administration icon E in the upper right corner of the page.

3 In the Management section, click Search Index.
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4 Select Re-Index Everything.
5 Click OK, then click Close.

21.4.3 Resetting the Standard Templates

IMPORTANT: If you have manually customized any templates that are included with the Vibe
product, back up the files you have modified before performing the interface reset.

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Administration icon E in the upper right corner of the page.

3 In the Management section, click Workspace and Folder Templates.

Workspace and Folder Templates

Standard Templates

= Discussion - A Digcugsion folder is useful for creating a forum where users are likely to both create and reply o entries

= Blog - Ahlog folder is & forum where entire entries are displayed in reverse chronological order, based onwhen theywere created. Blogs ypically provide infarmation on a particular topic from an individual or small group ©
authors. Optianally, the blog folder can be configured so that a larger group can make comments on the entries posted by the original author.

= Calendar - A calendar folder is a place to post graup events or display other types of entries by date

u Guesthook - A guesthook folder is a simple place that individuals can"sign” indicating that they have visited 3 User's Personal Warkspace. Visitors may alsa leave comments about the entries created in that personal
workspace. Comments are displayed in reverse chranological order. A picture of the individual signing the guesthookis displayed with the comment. The guestbook is useful for expanding users' social networks.

= File Folder - Afile folder is a place to put files. Comments or entire diseussions can be posted about individual files. Additionally, the files can be automatically locked, edited-in-place, then unlocked, creating a new version
ofthe file. Afile falder can emulate a YWebDAY server. This allows a userta add and delete files via any wWebhDAY client, such as the MSWindows File Manager.

= Milestone Folder - A milestone folder is used to roll up or surmmarize activity in one or more Task foldars.

= Micro-Blog - A micro-blog folder is 3 special folder that gets created autornatically for each user. fis intended to contain short text entries only. Each user can add micro-blog entries directay from the tools area on every
page. While you can create multiple micro-blog folders, only the one that is created automatically will be accessed as the user's real micro-blog.

= Wirtored File Folder - A mirrored file folder is a special type offile folder where it uses a senver file system directory as ts file storage area instead of the normal Teaming repository. Typically the directoryis a file share
accessed via narmal filg sharing mechanisms. Teaming attempts 1o keep its knowledge about the folder contents in synch with whatever is in the ditectary. The mirrared falder feature can mirrar any Web DAY o local file
path

4 Click Reset.
5 Click OK to confirm, then click Close.

Your Vibe 3.1 site is now ready for use.

IMPORTANT: If Vibe users encounter problems displaying any pages on the Vibe site after the
update, simply have them clear the browser cache.
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Updating the Operating System Where
Vibe Is Running

You can update the operating system where Vibe is running.

1 update the Linux or Windows operating system to a version that Vibe supports.

For information about which versions are supported, see Section 2.1, “Vibe Server
Requirements,” on page 17.

For information about how to update the operating system, view the appropriate
documentation for your operating system.

2 (Conditional) If you updated a Linux server, the TrueType font path that Vibe uses for document
conversion might be broken after the update. To fix this problem, you need to re-run the Vibe
installation after upgrading the Linux operating system.

For information on how to run the Vibe installation, see Section 4.1, “Linux: Installing and
Setting Up a Basic Vibe Site,” on page 49 for a basic installation, or Chapter 10, “Performing an
Advanced Vibe Installation,” on page 105 for an advanced installation.
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23.1

Migrating Existing Novell Vibe Data into
a New Vibe 3.2 System

This section describes how to migrate data from an existing Vibe server to a new Vibe server. You
might want to do this for any of the following reasons:

¢ Your existing Vibe system has outgrown the server where you originally set it up

+ You want to move your existing Vibe system to a different operating system

In this case, you can install Vibe 3.2 on a new server, then migrate your existing Vibe 3.2 data (or
data from a previous version of Vibe) to your new Vibe 3.2 system

If you are migrating from a Teaming 2.1 server, follow the instructions in “Update” in the Novell
Vibe OnPrem 3 Installation Guide (http://www.novell.com/documentation/vibe_onprem3/
vibeprem3_inst/data/bookinfo.html).

¢ You created your Vibe system by using the Virtual Eval version of the Novell Vibe Starter Pack
(http://download.novell.com/Download?buildid=Y7]2HFucjfw~)

¢ You are upgrading from Kablink Vibe to Novell Vibe
Complete the following sections to migrate your Vibe data:

¢ Section 23.1, “Linux Migration with a MySQL Database,” on page 181
¢ Section 23.2, “Windows Migration with an MS SQL Database,” on page 183

NOTE: In these instructions, “target server” refers to the server where you install the Vibe 3.2
software, and “source server” refers to the existing server from which you are migrating Vibe data.

The instructions in this section are based on a single-server Vibe configuration. If you have a multi-
server Vibe configuration, the single-server instructions can serve as a foundation to get you started
with your more complex migration process.

This section does not include instructions for migrating an Oracle database. Use the instructions for
your Vibe platform as a guideline for the tasks that are involved in migrating Vibe data, then apply
these guidelines to your Oracle database migration.

Linux Migration with a MySQL Database

¢ Section 23.1.1, “Preparing the Target Linux Server,” on page 182

¢ Section 23.1.2, “Preparing the Source Linux Server,” on page 182

¢ Section 23.1.3, “Transferring Data from the Source Server to the Target Server,” on page 182
¢ Section 23.1.4, “Importing the Vibe Database to the Target Server,” on page 183

¢ Section 23.1.5, “Updating the Vibe Database on the Target Server,” on page 183

¢ Section 23.1.6, “Finalizing Your New Vibe 3.2 Site,” on page 183

Migrating Existing Novell Vibe Data into a New Vibe 3.2 System 181


http://www.novell.com/documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html
http://www.novell.com/documentation/vibe_onprem3/vibeprem3_inst/data/bookinfo.html
http://download.novell.com/Download?buildid=Y7J2HFucjfw~

23.1.1 Preparing the Target Linux Server

On the target server:
1 Install the Vibe 3.2 software on the target server, as described in Part II, “Basic Installation,” on
page 23, paying special attention to these important details:

¢ Set up the same Linux user to run the Vibe software that has been used to run the Vibe
software in the past.

¢ Select the same encryption algorithm for the Vibe database that was used in Vibe 3.

IMPORTANT: If the database encryption algorithms do not match between the source and
target Vibe systems, you cannot log in to the new Vibe 3.2 site.

Start Vibe on the target server.
Verify that the new Vibe site is working as expected.

Stop Vibe on the target server.
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Rename the teaming directory to teaming_backup. This is because in a future step you will
copy the teaming directory from the source server to the target server.

The location of the teaming directory varies by platform:

Linux: /var/opt/novell/teaming

Windows: c:\novell\teaming

6 Continue with Section 23.1.2, “Preparing the Source Linux Server,” on page 182.

23.1.2 Preparing the Source Linux Server

On the source server:

1 Stop Vibe.

2 Back up your existing database:

mysgldump -uusername -ppassword sitescape > sitescape.sqgl

This creates a file named sitescape.sql in the directory where you executed the mysgldump
command.

3 Make sure that you have a recent backup of your entire Vibe system.

4 Continue with Section 23.1.3, “Transferring Data from the Source Server to the Target Server,” on
page 182.

23.1.3  Transferring Data from the Source Server to the Target Server

On the source server:
1 Mount the target server to the source server so that data can be copied from one server to the
other.
2 In a terminal window on the source server, become the Linux user that runs the Vibe software.

3 Copy the database backup of your existing Vibe database (sitescape.sql file) that you created
in Step 2 in Section 23.1.2, “Preparing the Source Linux Server,” on page 182 to a convenient
temporary location on the target server.

182 Novell Vibe 3.2 Installation Guide



4 Copy the entire data area from /var/opt/novell/teaming on the source server to the same
location on the target server.

5 Continue with Section 23.1.4, “Importing the Vibe Database to the Target Server,” on page 183.

23.1.4 Importing the Vibe Database to the Target Server

On the target server:
1 Remove the empty Vibe database that was created when you installed the Vibe 3.2 software:

mysqgl>drop database sitescape;

2 Change to the directory where you copied the sitescape.sql file in Step 3 in Section 23.1.3,
“Transferring Data from the Source Server to the Target Server,” on page 182.

3 Create an empty database called sitescape:

mysqgl -uusername -ppassword -e "create database sitescape"

4 Manually re-create the Vibe database with the data that you copied from the source server:

mysgl -uusername -ppassword sitescape < sitescape.sql

23.1.5 Updating the Vibe Database on the Target Server

You must complete this section only if you are updating from a previous version of Vibe to Vibe 3.2.
On the target server:

1 Unzip the teaming-3.2.n.sql.zip file.
2 In the teaming-3.2.n-sql folder, change to the resulting update-3.1.0-3.2.ndirectory, then
run the update script to update the database from Vibe 3.1 to Vibe 3.2:

mysqgl -uusername -ppassword < update-mysqgl.sqgl

For more complete database update instructions, refer to Section 21.3.1, “Manual Vibe Database
Update,” on page 175.

3 Continue with Section 23.1.6, “Finalizing Your New Vibe 3.2 Site,” on page 183.

23.1.6  Finalizing Your New Vibe 3.2 Site

1 Start Vibe 3.2, as described in Section 4.1.7, “Starting Vibe on Linux,” on page 56.

2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in
the Nowvell Vibe 3.2 Administration Guide.

Your Vibe site should now function just as it did on the original source server.

23.2 Windows Migration with an MS SQL Database

¢ Section 23.2.1, “Preparing the Target Windows Server,” on page 184
¢ Section 23.2.2, “Preparing the Source Windows Server,” on page 184
¢ Section 23.2.3, “Transferring Data from the Source Server to the Target Server,” on page 184

¢ Section 23.2.4, “Importing the Database to the Target Server,” on page 185
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¢ Section 23.2.5, “Updating the Vibe Database on the Target Server,” on page 185
¢ Section 23.2.6, “Finalizing Your New Vibe 3.2 Site,” on page 186

23.2.1 Preparing the Target Windows Server

On the target server:

1 Install the Vibe 3.2 software, as described in Part II, “Basic Installation,” on page 23.

IMPORTANT: Select the same encryption algorithm for the Vibe 3.2 database as you selected for
the Vibe 3.1 database. If the database encryption algorithms do not match between the source
and target systems, you cannot log in to the new Vibe 3.2 site.

Start Vibe on the target server.
Verify that the new Vibe site is working as expected.

Stop Vibe on the target server.
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Rename the teaming directory to teaming_backup. This is because in a future step you will
copy the teaming directory from the source server to the target server.

The location of the teaming directory varies by platform:

Linux: /var/opt/novell/teaming

Windows: c:\Program Files\Novell\Teaming

6 Continue with Section 23.2.2, “Preparing the Source Windows Server,” on page 184.

23.2.2 Preparing the Source Windows Server

On the source server:

1 Stop Vibe.
2 Back up your existing database:

2a In Microsoft SQL Server Management Studio, browse to and right-click the existing
database (named sitescape), then click Tasks > Back Up.

2b For Backup type, select Full.

2c Set other backup options as desired, then click OK.
This creates a file named sitescape.bak in the following directory:
c:\Program Files\Microsoft SQL Server\MSSQL\Backup

3 Make sure that you have a recent backup of your entire system.

4 Continue with Section 23.2.3, “Transferring Data from the Source Server to the Target Server,” on
page 184.

23.2.3 Transferring Data from the Source Server to the Target Server

On the source server:

1 Map a drive from the target server to the source server so that data can be copied from one
server to the other.
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2 Copy your existing software extensions to the target server:

From: c¢:\home\icecoredata\extensions

To: c:\novell\teaming\extensions

Beginning with Vibe 3, the extensions directory now contains kablink and liferay.com
directories.

3 Delete the empty kablink directory.

4 Delete or rename the following directories to make room for the corresponding directories that
you are copying from the source server:

c:\novell\teaming
c:\novell\teaming\lucene
c:\novell\teaming\extensions

5 Copy the entire data area from c¢: \novell\teaming on the source server to the same location on
the target server.

6 Continue with Section 23.2.4, “Importing the Database to the Target Server,” on page 185.

23.2.4 Importing the Database to the Target Server

On the target server:

1 In Microsoft SQL Server Management Studio, browse to and right-click the existing Vibe
database (named sitescape) that was created when you installed the Vibe 3.2 software, then
click Delete.

2 To import the data from your source database, browse to and right-click Databases, then click
Tasks > Restore.

3 In the To database field, specify sitescape.

4 In the From device field, browse to and select the sitescape.bak file that you transferred to the
target server.

5 Set other restore options as desired, then click OK.

This creates the sitescape database in the following directory on the target server:

c:\Program Files\Microsoft SQL Server\MSSQL

Backed-up data from the source database is imported into the database for your new Vibe 3.2
system.

23.2.5 Updating the Vibe Database on the Target Server

You must complete this section only if you are updating from a previous version of Vibe to Vibe 3.2.
On the target server:

1 Unzip the teaming-3.2.n-sql.zip file, change to the resulting update-3.1.0-3.2.ndirectory,
then run the update script to update the database from Vibe 3.1 to Vibe 3.2:

osql -Uusername -Ppassword -i update-sglserver.sql

For more complete database update instructions, refer to Section 21.3.1, “Manual Vibe Database
Update,” on page 175.

2 Continue with Section 23.2.6, “Finalizing Your New Vibe 3.2 Site,” on page 186.
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23.2.6  Finalizing Your New Vibe 3.2 Site

1 Start Vibe 3.2, as described in Section 4.1.7, “Starting Vibe on Linux,” on page 56.

2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in
the Nowvell Vibe 3.2 Administration Guide.

Your Vibe site should now function just as it did on the original source server.
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2 Migrating from SiteScape Forum or
Other Collaboration Software

Moving legacy corporate data into a new collaboration system can look like a long, challenging
process. To make the job easier, see the Novell Teaming Migration Services Flyer. (http://
www.novell.com/docrep/2009/04/Novell_Teaming Migration_Flyer_en.pdf)
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¢ Appendix A, “Vibe System Requirements Assistance,” on page 191
¢ Appendix B, “Third-Party Materials,” on page 197
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Vibe System Requirements
Assistance

The system requirements for Novell Vibe include supporting components that might or might not be
already installed on your Vibe server. This section helps you meet the Vibe system requirements if
you are not familiar with how to install these supporting components.

¢ Section A.1, “Java Development Kit,” on page 191

¢ Section A.2, “MySQL Database Server,” on page 193

Java Development Kit

The Novell Vibe software runs inside a Java Virtual Machine (JVM). At present, Vibe requires a Java
Development Kit (JDK), not a Java Runtime Environment (JRE), in order to run properly. You can use
either the Sun JDK or the IBM JDK. Follow the instructions in the section below for your operating
system and JDK preference:

If you want to use an SSL connection between your Novell Vibe site and a WebDAYV server, and if the
WebDAV server has a self-signed certificate rather than a certificate provided by a certificate
authority, you must use the Sun JDK. The existing Vibe functionality for handling self-signed
certificates is not compatible with the way the IBM JDK handles self-signed certificates.

¢ Section A.1.1, “Oracle JDK on Linux,” on page 191

¢ Section A.1.2, “IBM JDK on Linux,” on page 192

¢ Section A.1.3, “Oracle JDK on Windows,” on page 193

Oracle JDK on Linux

1 Go to the following URL:
Java SE Downloads (http://www.oracle.com/technetwork/java/javase/downloads/index.html)
The update you need is listed as “Java SE 6 Update nn.”

2 Click Download next to this update.

3 Accept the License Agreement.

4 Click the jdk-6unn-1linux-version-rpm.bin file in the Download column, then save the file to
an empty temporary directory on your Linux server.

5 As the root user, change to that temporary directory, then use the following command to make
sure that the download arrived safely:

1s -1
You should see a file named jdk-6unn-1linux-version-rpm.bin.

6 Change the permissions on the file to include execute permissions:
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chmod +x jdk-6unn-linux-version-rpm.bin
7 Run the self-extracting file:
./jdk-6unn-linux-version-rpm.bin

This creates a file named jdk-6unn-linux-version.rpm, and a directory named /usr/java/
jdk.1.6.0 nnwith the Sun JDK software in it.

The Sun JDK is now installed on your Linux server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you install
the JDK. The Vibe installation program prompts you for this location.

IBM JDK on Linux

¢ “Installing the IBM JDK on SUSE Linux Enterprise Server 11” on page 192

¢ “Installing the IBM JDK on Open Enterprise Server 2 and SUSE Linux Enterprise Server 10” on
page 192

Installing the IBM JDK on SUSE Linux Enterprise Server 11

The IBM JDK 6.0 is available with SUSE Linux Enterprise Server (SLES) 11, which is used for Open
Enterprise Server (OES) 2. You can install it by using YaST.

1 In YaST, click Software > Software Management.

2 In the Search field, type ibm, then click Search.

3 Select Java 5 SDK, Standard Edition (java-1_5_0-ibm-devel), then click Accept.

4

Click Continue to accept the suggested dependencies, then click No because you don’t need any
more packages.

5 Exit YaST.

This creates a directory named /usr/1lib/jvm/java-1_5 0-ibm-1.5.0_sr3 with the IBM JDK
software in it.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you install
the JDK. The Vibe installation program prompts you for this location.

Installing the IBM JDK on Open Enterprise Server 2 and SUSE Linux Enterprise
Server 10

The IBM JDK 6.0 is not included with SUSE Linux Enterprise Server (SLES) 10.

To download the IBM JDK 6.0:

1 Go to the following URL:
Java SE Downloads (http://www.ibm.com/developerworks/java/jdk/linux/download.html)

2 In the Java SE Version 6 table, in the Download column, click the appropriate link for your
operating system.
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3 Sign in using your IBM account. If you don’t have an account, create one.
4 Agree to IBM’s License Agreement, then continue.

5 Download the ibm-java-i386-sdk-6.0-n.n.1386.rpm file to an empty temporary directory
on your Linux server.

6 Change to that directory, then run the downloaded file.
This creates a directory named opt \ ibm with the IBM JDK in it.

The IBM JDK is now installed on your Linux server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you install
the JDK. The Vibe installation program prompts you for this location.

Oracle JDK on Windows

1 Go to the following URL:
Java SE Downloads (http://www.oracle.com/technetwork/java/javase/downloads/index.html)
The update you need is listed as “Java SE 6 Update nn.”

2 Click Download next to this update.

3 Accept the license agreement.

4 Click the jdk-6unn-windows-version.exe file in the Download column, then save the file to an
empty temporary directory on your Windows server.

5 Change to that temporary directory, then run the downloaded executable.
This creates a directory named c: \Program Files\Java\jdkéunn with the Oracle JDK software
in it.

The Oracle JDK is now installed on your Windows server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Location on the Basic Vibe Installation Summary Sheet, specify the directory where you install
the JDK. The Vibe installation program prompts you for this location.

MySQL Database Server

¢ Section A.2.1, “MySQL on Linux,” on page 193
¢ Section A.2.2, “MySQL on Windows,” on page 195

MySQL on Linux

Depending on the options you select when installing Open Enterprise Server 2 and SUSE Linux
Enterprise Server (SLES), the MySQL database server might be installed along with the operating
system. Check for the following directory:

/usr/bin/mysqgl
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If the /usr/bin/mysql directory does not exist, you need to install the MySQL database server. If
MySQL is already installed, you still need to configure it for use with Vibe.

¢ “Installing MySQL"” on page 194
¢ “Configuring MySQL” on page 194
¢ “Learning More about MySQL” on page 195

Installing MySQL

Make sure you have access to your operating system installation media.
In YaST, click Software > Software Management.

In the Search field, type mysqgl, then click Search.

Select mysgql, then click Accept.

Click Continue to resolve dependencies.
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Click Continue to acknowledge package support status.
MySQL is then installed from the SLES media.
7 Continue with “Configuring MySQL” on page 194.

Configuring MySQL

When MySQL is initially installed, it is not configured with an administrator password, nor is it
configured to start automatically. Follow the steps below to set up the MySQL database server for use
with Vibe:

In YaST, click System > System Services.

Scroll to and select the MySQL service, then click Enable.

Click Continue to install dependencies, then click OK to close the status box.

Click OK > Yes to finish the installation, then exit YaST.

In a terminal window, become the root user.
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To verify that the MySQL database server has started, use the following command:
ps -eaf | grep mysqgl

You should see MySQL processes running.

7 Set the administrator password for the MySQL database server:

mysgladmin -u root password new password

This command changes the password for the MySQL root user, which is the default
administrator username for the MySQL database server. This command is part of the MySQL
client package.

IMPORTANT: The MySQL root username is not the same as the Linux root user. The Linux
root user has a password established for it when you install Linux. In a parallel fashion, the
MySQL root user needs to have a password established for it when you install MySQL.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the MySQL administrator
password. The Vibe installation program prompts you for this information.
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Learning More about MySQL

The following table includes some basic and useful MySQL commands:

Action Command
Stop MySQL /etc/initd/mysqgl stop
Start MySQL /etc/initd/mysqgl start

Show MySQL status  mysgladmin -u root -p extended-status

If you want to administer MySQL through a GUI interface, you can download tools from:
MySQL GUI Tools Downloads (http://dev.mysql.com/downloads/gui-tools/5.0.html)
For more information about MySQL, see:

MySQL Documentation (http://dev.mysql.com/doc)

A.2.2 MySQL on Windows

1 In your Web browser, go to the following URL:
MySQL 5.1 Downloads (http://dev.mysql.com/downloads/mysql/5.1.html)

2 Scroll down if necessary, then click the type of Windows operating system you are using (32-bit
or 64-bit).

On the Windows Essentials line, click Download.

Click Save File, browse to and select a convenient temporary directory, then click Save.
In Windows Explorer, browse to the directory where you saved the MySQL . exe file.
Double-click the MySQL . exe file to start the MySQL Setup Wizard.

Follow the online instructions to install the MySQL software on the Windows server, then
continue with Step 8 to configure the server.
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8 Unless you are already familiar with configuring MySQL on a Windows server, select Standard
Configuration, then click Next.

9 Select Include Bin Directory in Windows PATH, then click Next.
10 Set the MySQL root user password, then click Next.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Vibe Installation Summary Sheet, specify the MySQL
administrator password. The Vibe installation program prompts you for this information.

11 Click Execute to configure the MySQL database server, then click Finish.
Some messages report the status of your MySQL installation.

12 To monitor the MySQL database server, click Start > All Programs, then click MySQL > MySQL
Server 5.1 > MySQL Command Line Client.
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B Third-Party Materials

B.1

¢ Section B.1, “ANTLR 3 License,” on page 197

¢ Section B.2, “Colt License Agreement,” on page 198

¢ Section B.3, “Dom4j License,” on page 198

¢ Section B.4, “iCal4j License,” on page 199

¢ Section B.5, “ICU4] license (ICU4J 1.3.1 and later),” on page 199
¢ Section B.6, “JAXEN License,” on page 200

¢ Section B.7, “Jung,” on page 200

¢ Section B.8, “ASM,” on page 201

¢ Section B.9, “Firebug Lite,” on page 202

ANTLR 3 License

Copyright (c) 2003-2008, Terence Parr
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met

¢ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

¢ Neither the name of the author nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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Colt License Agreement

Packages cern.colt*, cern.jet*, cern.clhep
Copyright (c) 1999 CERN - European Organization for Nuclear Research.

Permission to use, copy, modify, distribute and sell this software and its documentation for any
purpose is hereby granted without fee, provided that the above copyright notice appear in all
copies and that both that copyright notice and this permission notice appear in supporting
documentation. CERN makes no representations about the suitability of this software for any
purpose. It is provided “as is” without expressed or implied warranty.

Packages hep.aida.*

Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or
redistribute this work is granted under the terms of the LGPL License, with the exception that
any usage related to military applications is expressly forbidden. The software and
documentation made available under the terms of this license are provided with no warranty.

Dom4j License

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“Software”), with or without
modification, are permitted provided that the following conditions are met:

1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions
must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. The name “DOM4]” must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact dom4j-info@metastuff.com.

4. The name “DOM4]” must not be used to endorse or promote products derived from this
Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact dom4j-info@metastuff.com.

5. Products derived from this Software may not be called “DOM4]” nor may “DOM4]” appear in
their names without prior written permission of MetaStuff, Ltd. DOM4] is a registered
trademark of MetaStuff, Ltd.

6. Due credit should be given to the DOM4]J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “ASIS”" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL METASTUFEF, LTD. OR ITS CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.
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iCal4j License

Copyright (c) 2008, Ben Fortuna
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

¢ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

¢ Neither the name of Ben Fortuna nor the names of any other contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ICU4J license (ICU4J 1.3.1 and later)

COPYRIGHT AND PERMISSION NOTICE
Copyright (c) 1995-2001 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, provided that the above
copyright notice(s) and this permission notice appear in all copies of the Software and that both the
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS
NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.
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Except as contained in this notice, the name of a copyright holder shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

JAXEN License

Copyright (C) 2000-2002 Bob McWhirter & James Strachan.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions, and the disclaimer that follows these conditions in the documentation and/or other
materials provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products derived from this
software without prior written permission. For written permission, please contact
license@jaxen.org.

4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation
provided with the redistribution and/or in the software itself an acknowledgement equivalent to the
following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
Wwww.jaxen.org.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
Jaxen AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Jaxen
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://www.jaxen.org.

Jung

THE JUNG LICENSE
Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project
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All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

¢ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

¢ Neither the name of the University of California nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1S”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ASM

Copyright (c) 2000-2005, INRIA, France Telecom
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

¢ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

¢ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
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ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.9 Firebug Lite

Copyright (c) 2006-2007, Joe Hewitt
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

¢ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

¢ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1S”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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